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The Guide in a Nutshell 

The following principles are the key to effective use of speech recognition 

technology in medical dictation; consider them as you browse through the guide 

and as you use your software. 

 Dragon-based speech recognition can truly improve documentation, save 

money and get you home sooner … if you use it right. 

 High quality hardware, including the fastest computer you can afford with at 

least 4-8 GB of RAM, will improve both accuracy and speed of operation; a 

high quality microphone will similarly improve your results. 

 Your best accuracy and productivity will result from use of the medical version 

of Dragon. 

 Be sure to select the vocabulary appropriate for your dictation, and add any 

unique words you use regularly to Dragon’s vocabulary; if you switch from 

medical dictation to general dictation, be sure to change your vocabulary. 

 Learn how to correct mistakes so they won’t be repeated; learn how to tell 

the difference between Dragon errors versus sloppy dictation; these should 

be handled differently. 

 Learn how to create and use “text commands” – they will improve your 

documentation and dramatically improve your efficiency. 

 Remember that nothing affects accuracy more than your dictation style; 

enunciate carefully and speak in phrases or complete sentences 

 Manage your microphone to reduce the influence of contaminating 

environmental noise. 
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PART ONE:  General Use of Dragon 

 

Chapter 1:  Introduction 

 
Previously seen only in the realm of science fiction, during the last decade the dream of computerized 

speech recognition has truly been 

realized.  Nowhere has the success of this 

technology more revolutionized work flow 

than in the medical field. It has led to 

dramatic time and cost savings when 

compared with secretarial transcription.  

It has contributed to remarkable 

productivity enhancement when 

compared to hand typing. The latest 

medical version of medical speech 

recognition, Dragon Medical Practice 

Edition 2 (DMPE2) is associated with 

improvements in speed and accuracy.  

Further, it includes a variety of feature enhancements that make it particularly useful to the medical 

practitioner.  

What does speech recognition software accomplish?  In the simplest terms, speech recognition 

software is a means to control your personal computer with your voice.  Following just a few short 

minutes of training, Dragon will effectively do the following:  

1. Turn your spoken word into text in word processing documents  

2. Accomplish a variety of computer actions traditionally done by means of the mouse and 

keyboard with your voice 

3. Through the use of “commands”, allow more complex and sequential tasks to be accomplished 

with your voice 

Why consider Speech Recognition Software?  In today’s changing medical environment, with increasing 

movement to electronic documentation, reduction in reimbursement, and heightened pressure upon 

medical providers to improve productivity, many are looking for ways to optimize efficiency while still 

maintaining the quality of the medical record.  Speech recognition software is the perfect way to do this. 

It provides instantaneous results and with high levels of accuracy.  Further, speech recognition software 

can help your practice or hospital save money compared with traditional transcription.  At my home 

institution, for instance, when Dragon was provided to 47 providers previously using outsourced 

transcription, we calculated an annual saving of nearly $100,000.  It is highly cost effective and with a 

return on investment coming after just 2 to 3 months of use. 
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Perhaps the most remarkable feature of this software is its high level of accuracy.   Out of the box and 

with the basic 5 to 6 minutes of training, Dragon offers accuracy rates in the 95% or higher range. With a 

little more practice and use, typical users are seeing accuracy rates in the 99% range. 

 

 

 

 

The scope of this guide:  In this brief guide I will not walk you through everything Dragon is capable of 

doing in painstaking detail.  You have neither the time nor interest in this.  Rather, I hope to provide you 

with a distilled version of what you really need to know as a medical provider to make speech 

recognition a worthwhile investment and effective documentation tool.   Can you get by without this 

guide?  Yes, of course you can.  You can install Dragon, muddle through the User Guide to figure out 

how it works, and use it reasonably effectively.  This is what I did 15 years ago and it took me a few 

months to get reasonably facile.  With just a small investment in understanding how Dragon works, how 

your dictation style impacts accuracy, how Dragon can learn from its mistakes, and how some of the 

underlying functionality beyond simple speech to text conversion works, you can quickly get up to speed 

and reap all the benefits of this exciting software without having to spend five year getting good at it! 

Will this guide be helpful if you are using the original Medical Practice Edition, or other versions of 

Dragon?  Almost certainly yes.  The majority of the first part of the guide pertains to general principles 

that apply to almost all versions of Dragon.  Whenever possible, when methods of accomplishing some 

tasks have changed with more advanced versions of Dragon, I have also included reference to how this 

is done in earlier versions.  While there are a few functions that are present only in the advanced 

versions of Dragon (Professional, Legal and Medical) and not the Premium version, this tends to be rare.  

Most of the advanced techniques described in Part Two of the guide will be useful for all Dragon users. 

 

 

 

 

Key Point:  Dragon Medical Practice Edition 2 (DMPE2) has become an accurate, 

cost-effective alternative to hand-typing and formal transcription and is 

perfectly poised to assist medical providers in documentation. 

“Will this guide be helpful if you are using the original Medical 

Practice Edition or other versions of Dragon?  Almost certainly yes.” 

 

“[Speech recognition software] provides instantaneous results and 

with high levels of accuracy.  Further, speech recognition software 

can help your practice or hospital save money compared with 

traditional transcription.” 
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Part One of the guide:  The first part of the guide is about the basics.  You will learn how to install the 

software, some recommended set-up tweaks, and the basics of effectively using the software including 

dictating, correcting, and building commands. In addition you will provided with some basic strategies 

for using DMPE2 with your electronic health record. 

Part Two of the guide:  The second half of this guide is a collection of short tutorials on a variety of 

advanced topics.  By virtue of being segregated into the “Special Topics” area, this is a signal that this is 

optional material.  Most is directed to specific accessory products, techniques, and challenges.  You may 

want to scan the chapter headings and consider visiting any of these topics should they apply to your 

use of Dragon in the future.   

Dragon Medical Practice Edition 3?  In July of 2013 Nuance began the release of NaturallySpeaking 13, 

first with the Home and Premium versions and later the Professional and Legal versions.  Version 13 has 

some interesting new features, including: 

 15% increase in accuracy 

 Shorter profile creation time 

 Simplified audio set up process  

 Expanded web browser compatibility 

 Enhanced Windows 8 support 

 New DragonBar behavior, new help menu design and new user interface 

Will a Dragon Medical Practice Edition 3 – based on the version 13 speech engine - be released?  At this 

point we simply don’t know.  At the time of publication there isn’t even talk of a DMPE3.  Typically the 

Healthcare Division at Nuance releases the medical version 6-12 months after non-medical versions 

have been released.  At this point, though, we know that Nuance is working on a new, cloud-based 

medical product termed Dragon Direct (see chapter on Dragon Direct in Part Two) and it would not be 

surprising if Nuance released this subscription product before (and perhaps instead of) DMPE3. 

 

  

“Will a Dragon Medical Practice Edition 3 – based on the version 13 

speech engine - be released?  At this point we simply don’t know.”  



 

7 
Copyright 2015 Speech Recognition Solutions, LLC.  

www.SpeechRecSolutions.com 

Chapter 2:  The Basics:  How it works 

 

Quick Overview 

If the truth be known, you don’t need to know a whole lot about how Dragon works in order to use it 

effectively.  Suffice to say 

over a few decades some 

very smart software 

engineers, statisticians, 

and language experts 

have come together to 

figure out how your 

spoken word can be 

digitized, broken into the 

basic phonemes of 

speech,  have individual 

words recognized, and 

then using complex 

statistical modeling 

accurately string these 

words together into coherent 

sentences.  Obviously there is a huge amount going on below the surface in order to make a lot of quick 

decisions on the fly.  How much of the underlying processes does a medical user need to understand?  

Thankfully, just the basics. 

The Essentials 

What you need to know is the practical implications of how Dragon works.  Here are the key points: 

1. The accuracy of the process depends upon a number of factors, including the version of Dragon 

you are using as it has become more accurate over time, the care with which you dictate, a 

clean signal from your microphone, a lack of competing noise, and some computer factors 

including the amount of RAM and processor speed. 

2. The speed of the process is dependent upon having a good quality computer with a fast 

processor (see hardware recommendation).  In this respect, the fast the better.  Speed is also 

affected by the presence of contaminating noise.  In loud environments Dragon needs to do 

more “thinking” to figure out what is speech and what is noise. 

3. Dragon can learn from its mistakes and get more accurate with time, but only if you take the 

time to formally correct mistakes. 
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4. Of all the factors that impact overall accuracy, it is your dictation style that impacts accuracy 

more than anything.  As you will learn below, enunciating carefully and speaking in phrases or 

complete sentence will lead to the highest levels of accuracy. 

 

 

 

 

 

 

 

5. The software’s decision on any given word is based not only upon the word in question, but also 

the words that come before and after that word.  Combining language model data about word 

frequency and word associations with complex statistical models, Dragon makes a series of 

complex decisions in real time as a user is talking, and generally with an extremely high level of 

accuracy.  Because the process is highly dependent upon the context of any word (the words 

coming before and afterwards), it works best when lots of words are presented.  For this reason, 

better results will occur when a user speaks in long phrases or complete sentences, rather than 

slowly one word at a time.  Learn more about the current speech model, BestMatch V, in the 

Special Topics area. 

6. Having an appropriate set of words (vocabulary) from which Dragon can choose as you dictate is 

an essential determinant of accuracy in that it greatly increases the likelihood of the correct 

word being chosen.  Similarly, having Dragon evaluate some of your own documents to learn 

your writing style and the words you use frequently, will also improve your results. 

  
Key Point:  Dragon doesn’t work the same on every system and for every 

user.  Performance will depend upon the processor speed and RAM of the 

system.  Likewise, it will be impacted by the way in which a user sets up and 

interacts with the software 

 

“Of all the factors that impact overall accuracy, it is your dictation 

style that impacts accuracy more than anything.  As you will learn 

below, enunciating carefully and speaking in phrases or complete 

sentence will lead to the highest levels of accuracy.” 
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Chapter 3:  Prerequisites: Hardware, Software & Microphone 

  

Hardware:  Before you spend money on a medical version of Dragon, be sure your computer is up to 

the task.  As described above in the section on basic principles, a fast computer with plenty of RAM will 

impact both your speed and accuracy while using Dragon.  So how can we advise you on what to buy, or 

whether you current machine is up to the task?  There are really three sets of recommendations to 

consider: 

 

1. The Nuance “minimum” recommendation:  this is the minimum system requirement needed to 

install and run Dragon 

2. The Nuance “recommended” system:  these recommendations will allow you to take advantage 

of all Dragon features and in a brisk and accurate manner. 

3. Aiming for the Stars:  this is our own term.  It represents the recommendations of non-Nuance 

consultants and experts in speech recognition.  These are the recommendations oriented to 

those who don’t mind dropping a few thousand dollars on a computer and who want blistering 

speed and performance with Dragon. 

 
Overview of Recommended Hardware: 
 

 Nuance “Minimum” Nuance “Recommended” “Aiming for the stars” 

CPU 1 GHz Intel Pentium 2.2 GHz Intel Dual Core Intel i-7 dual core 

Processor Cache 512 Kb L2 2MB L2  

Free Hard Drive Space 3.2 Gb 3.2  Gb 3.2 Gb 

RAM 2Gb 2Gb 8 Gb or more 

 
For more detailed hardware recommendations and buying strategies, please see the expanded section 
on Detailed Hardware Recommendations in Part Two of this guide. 
 
 
 
  
 

 
Software:  For use in medical documentation, the vocabulary and functionality of the dedicated 

medical versions of Dragon is highly recommended.   
 
Which Product to Buy:  Depending upon your practice size and IT infrastructure, you may consider one 
of several versions: 
 

 Dragon Medical Practice Edition 2:  This is designed for practices of 24 providers or less and is 
best version for providers in small groups.  It includes more than 90 medical specialty and sub-

Key Point:  For the best speed and accuracy, use a computer with as fast of a 

processor and as much RAM as you can afford. 
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specialty vocabularies.  The current version of DMPE2 is using the Dragon 12 speech engine. 
 

 Dragon Medical 360 │Network Edition:  This version of Dragon is designed for larger practices 
and medical centers, particularly those that are using an electronic medical record implemented 
virtually (typically via Citrix).  Although functionally is nearly identical to the Medical Practice 
Edition from a provider’s perspective, this version involves centralized institutional control of 
licensing, back-up and certain Dragon functions.  The most current Network Edition is using the 
Dragon 12 speech engine. 
 

 Dragon Medical 360 │Direct:  this is a relatively newly released subscription-based product 
which utilizes cloud-based speech recognition, a medical vocabulary and allows institutional 
management of licensing, vocabulary, and commands.  At this time the Dragon Direct product is 
sold only to institutions and is not available for individual users.  Learn more about this product 
in the expanded section on Dragon Direct in Part Two of this guide.  For additional information, 
please visit our website at:  http://www.speechrecsolutions.com/dragondirect.html  

 
 
 
 
 
 
 
Medical Practice Edition 1 versus 2:  If you already own a license for the original version of Medical 
Practice Edition (which uses the Dragon 11 speech engine), you may be wondering if you should spend 
the money to upgrade to DMPE2.  The quick answer is that if you are happy with your current results, 
don’t spend the money to upgrade.  If you find your current level of accuracy less than ideal, then 
definitely consider the upgrade to DMPE2.  These are the main feature differences between the two 
versions: 
 

1. By virtue of use of the new “BestMatch V” speech model, the DMPE2 is about 20% more 
accurate than the original version.  The original DMPE used BestMatch III. 

2. DMPE2 includes an enhanced Dictation Box which can be employed in a hidden manner or with 
variable degrees of transparency.  This is an ideal way to collect information while browsing 
through an electronic health record (HER) for later inclusion in your documentation. 

3. DMPE2 includes more than 90 medical vocabularies rather than 60 in the original version; 
depending upon your specialty, this can contribute to enhanced accuracy 

4. DMPE2 allows improved handling of USB microphones (you can remove the microphone at will 
without leading to an error message; upon reconnecting the user profile will be immediately 
functional again.) 

5. DMPE2 includes the ability to use an iPhone or Android mobile device as a microphone 
 
Can you get by with a non-medical version of Dragon?  Although it isn’t recommended, an occasional 
medical provider can get by with the less expensive Premium or Professional version of Dragon, which 
does not include medical vocabularies and many of the unique functions available in the medical 
version.  You should consider this only in a few situations: 
 

Key Point:  For the majority of medical providers in small practices, Dragon Medical 

Practice Edition 2 is the best product to buy.  If you are part of a large institution, 

you should be talking with your IT department before making a purchase. 

http://www.speechrecsolutions.com/dragondirect.html
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1. You are reluctant to pay the $1600 or so for the full version and want to try the $99 “street 
version” (Premium) as a “proof of concept” (you can transfer the license to your spouse or child 
should you decide to purchase DMPE2.) 

2. You are not working in an electronic medical record. Non-medical versions of Dragon are 
designed in such a way that the microphone is disabled in the presence of a recognized EMR.  
This is a cute trick Nuance developed and has angered a lot of people.  Don’t blame us for this 
one! 

3. Your dictation is not likely to involve a lot of medical terminology 
4. You don’t intend to use a hand-held microphone such as the Dictaphone PowerMic II (Note:  

there are ways to get around this limitation.  Please refer to the section below on Octopus USB 
Controller) 

 
Where to buy Dragon:  If you are part of a practice of more than 24 medical providers, you will need to 
purchase directly from Nuance.  If you are part of a small practice, we strongly hope you will consider 
purchasing from Speech Recognition Solutions, but we will refrain from any further self-promotion.  We 
recommend you consider the following when buying a copy of Medical Practice Edition 2: 
 

1. If you buy from a large on-line seller such as Amazon, CDW, etc., you will be buying software 
with absolutely no user support.  You will not have a phone number to call in order to talk with a 
knowledgeable person to help with installation issues, usage recommendations, or 
troubleshooting should you have a problem.  This is a major disadvantage. 

2. Buying from a “value added reseller” allows you the benefit of experience, often from regular 
users of Dragon, as you get started. 
 

Should you buy Nuance Maintenance?  One year maintenance contracts are available from most 
resellers and offer the user the following: 
 

1. 24/7 telephone support 
2. Official Nuance iSupport (access to online support database) 
3. Upgrade support: if a new version of Dragon medical is released while you have an active 

maintenance plan, you get the upgrade for free. 
 

We believe maintenance is worth considering, but it’s not a “slam-dunk” decision.  If you are an 
experienced user, you will be unlikely to need the support.  Dragon medical tends to be on an 18 -24 
month release cycle and the upgrade typically costs around $600.  With maintenance running about 
$300 a year it’s probably a wash in terms of the upgrade assurance, particularly if you purchase soon 
after a product is released.  On the other hand, if you are purchasing Dragon well into the release cycle, 
it might make sense to get maintenance since it will assure you a free upgrade to the next released 
version. Be aware, though, you can only buy maintenance at the time you purchase the software.  You 
cannot wait and buy maintenance when you anticipate a new release.  When was DMPE2 released?  
During the summer of 2013.  As of March of 2015, we have heard no talk of a DMPE3 and suspect this is 
unlikely to be released any time before the summer of 2015, if at all. 
 

 
 
 
 

Key Point:  Purchasing maintenance only makes sense if you are a true 

“newbie” or if you are purchasing well into the release cycle of Dragon Medical 

since it will buy you a free upgrade when the new version arrives. 
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Microphones & USB Adapters 

Why do microphones matter?  We have 
already suggested that the biggest 
determinant of accuracy is the manner in 
which you dictate, with the key issue being 
enunciating carefully and speaking in 
phrases and sentences.  This is entirely true.  
But this isn’t to say that the choice of 
microphone isn’t an important 
consideration as well.  It is, and for these 
reasons. 
 

 Accuracy:  Not all microphones are the same. The $10 microphone that is bundled with Dragon 
simply will not provide the accuracy of a high quality microphone.  The added accuracy is most 
noticeable in properly differentiating between commonly used pronouns such as “a” and “the” 
which can easily be mistaken for each other. 

 External noise rejection:  most microphones will perform well in a totally quiet environment.  
Where the high quality microphones set themselves apart is in the rejection of contaminating 
noise.  For those using Dragon for “mission critical” purposes and where background noise is a 
fact of life, the noise cancelling qualities of a microphone may be critical. 
 
 
 
 
 
 
 

 Efficiency:  For the user needing to navigate through documents in an electronic health record 
and frequently performing repetitive tasks on the computer, a hand-held microphone with 
programmable buttons may be the best solution. 

 Convenience:  for the user needing both hands free for non-dictation related keyboarding, 
either a headset or desk mounted microphone may be the best solution. 

 Personal factors:  we have seen both men and women who simply don’t want to mess up their 
hair with the constant attachment and removal of a headset microphone.  For those with long 
and perhaps thick hair, reaching the ears is sometimes a challenge. 

 Hygiene:  In certain situations in which multiple users share a computer work-station, it is 
sometimes preferable to avoid use of a shared headset which, to be frank, has a microphone 
element so close to the mouth that it becomes a repository for respiratory secretions.  In this 
type of situation, you may be best with a desktop mounted microphone that will allow use from 
a distance (refer to the section on the SpeechWare TableMike). 

 
Overview of Preferred Microphones:  After selling microphones for nearly 10 years and catering to a 
medical audience, we have developed some general recommendations which are listed below: 
 

“Most microphones will perform well in a totally quiet 

environment.  Where the high quality microphones set 

themselves apart is in the rejection of contaminating noise.” 
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Category First Choice Approx. Cost Alternatives 

Best Wired Microphone Sennheiser ME3 
$195 (includes 
Andrea USB Adapter 
and storage bag) 

SpeechWare FlexyMike Dual 
Ear Cardioid 

Best Wireless Microphone VXI VoxStar UC 
$159 Andrea WNC1500; Sennheiser 

SD Pro-1 and Pro-2, 
Sennheiser MB Pro UC  

Best Hand-Held 
Microphone 

Philips SpeechMike Premium 
$335 

Nuance PowerMic II 

Best Desktop Microphone 
SpeechWare TableMike (3-
in-1, 6-in-1 or 9-in-1) 

$279 (3-in-1) 
Buddy DesktopMic 

Best Portable Notebook 
Microphone 

SpeechWare TravelMike 
$249 

None 

 
For detailed information on the above recommended microphones, please visit the section on Detailed 
Microphone Recommendations in the Part Two of the guide. 
 
 
 
 
 
 
 
 
External USB Sound Adapters:  Although it is possible to use an analog 
microphone by plugging it into your computer’s on-board sound card, 
there are a number of reasons you should consider using a good 
external sound adapter rather than your on-board sound card.  An 
external USB sound adapter substitutes for your on-board sound card 
and has several important advantages: 
 

 Lack of interference:  External USB adapters accomplish the 
analog to digital conversion outside of the electrically “loud” 
environment of your computer’s motherboard (most 
computer sound cards involve circuitry built into the 
motherboard and not a separate dedicated device).  Using an external sound card moves the 
process away from this potential source of interference. 

 Compatibility:  On board sound cards may vary in the amount of voltage provided to an attached 
microphone.  Some are adequate and some are only marginal.  By using an external sound card 
manufactured specifically for use with a computer microphone you are assured proper 
compatibility. 

 Portability:  When you base a user profile on an external sound card, you are, in effect, basing it 
on a sound source that is portable.  If you ever need to move your profile to another computer, 
you can move the sound circuitry as well (the USB sound adapter) and expect very similar 
results.   

 
For all of these reasons we highly recommend that users of analog microphones interface the 
microphone with a high quality external USB sound adapter. 

Key Point:  Microphones matter.  Don’t use the cheap microphone that came 

with Dragon.  Once you know that Dragon will work for you, upgrade to a 

higher quality microphone that matches your needs and workflow. 
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Overview of Available USB Adapters:  A variety of external USB sound adapters are available and all 
work well.  The monaural or “MA” version of the Andrea pure audio USB adapter is a good choice for a 
headset microphone without speakers.  The “SA” version is a great for use with most standard headset 
microphones which include speakers, since it handles both sound in and sound out.  The SpeechWare 
MultiAdapter is unique in including “auto-gain” technology to accommodate varying microphone 
sensitivities and varying user distance from the microphone, and includes some advanced digital 
processing algorithms to remove external noise, but also comes with a very high price tag.  
 

 Andrea Pure Audio USB Adapter (SA Version):  This is a “workhorse” 
adapter which works great with virtually all typical headset microphones.  
It includes digital signal processing circuitry to exclude repetitive external 
noise.   This adapter is used for both the analog-to-digital conversion 
(sound in) and digital-to-analog conversion (sound out).  The outgoing 
signal is stereo. 
 

 Andrea Pure Audio USB Adapter (MA version):  Very similar to the SA version 
of the adapter, this version is intended only for a microphone input signal (it 
handles the incoming analog-to-digital processing) and does not handle 
sound out.  We recommend using this version with headsets that do not 
include a speaker, such as the Sennheiser ME3, SpeechWare FlexyMikes and 
Audio Technica 8HEmW. 
 

 Buddy 7G USB Adapter:  This is another “workhorse” adapter and works very similarly to Andrea 
Pure Audio (SA version) adapter.  The maker of this product line does only direct sales, so you 
will need to purchase this through Amazon. 
 

 SpeechWare SpeechMatic MultiAdapter:  While clearly the 
most expensive of the USB adapters, arguably this is also 
the best.  Based on the same circuitry contained in the 
SpeechWare TableMikes, this adapter includes two unique 
functions: a) more extensive digital sound processing 
algorithms to reduce external noise and b) auto-gain 
technology to flexibly change the microphone input volume as your distance from the 
microphone element changes.  This latter function is optional and a user can toggle between a 
“Normal” or blue mode (no auto-gain) and a “Distant” or green mode which employs the auto-
gain technology. 

 
 

“For all of these reasons we highly recommend that users of 

analog microphones interface the microphone with a high 

quality external USB sound adapter.” 
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Device Function Suggested 
Price 

Comments 

Andrea Pure Audio SA Duplex  $45 Excellent general use adapter 

Andrea Pure Audio MA Monaural $39 Good choice for Sennheiser ME3, SpeechWare 
FlexyMike & Audio Technica 8HEmW 

Buddy 7G Duplex $70 Excellent general use adapter 

SpeechWare 
MultiAdapter 

Duplex $149 Includes auto-gain and advanced digital sound 
processing algorithms 

 
Notes on above table:  Duplex adapters route sound in and out of the computer via USB.  A monaural 
USB adapter only handles microphone input through USB. 
 

 
 
 
 

 

  

Key Point:  When using an analog microphone, it is strongly advised that you 

use a good quality external USB sound adapter.  Good devices are made by 

Andrea, Buddy and SpeechWare.  A USB adapter is NOT needed if your 

microphone attaches to your computer via USB, since it already includes a 

sound adapter. 
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Chapter 4:  Installation and Set-up 

 

Basic Installation  

 
Basic Installation is fairly straight‐forward. If you have a previous version of NaturallySpeaking installed 

on your PC, you can transfer your vocabulary and personalized commands to the new version. I 

recommend that you manually export these from your old version (storing them somewhere on your 

hard drive) before doing the installation of DMPE, rather than simply upgrading your old user profile 

into the new version (see methods of Exporting Commands and Vocabulary below for more information 

on this topic.) Before doing the actual install, the following is recommended:  

 Export your personalized words and commands from your current version 8 or 9 user profile 

(see sections below on exporting words and exporting commands)  

 Close all open applications  

 Turn off or disable antivirus software 

 Insert the installation disk and follow all instructions 

 Unless you have reason to do otherwise, you should choose “Typical/Complete” when asked 

during the installation process  

A few caveats about installation: 

1.  When you get to the early screen 

asking you to select a speech device 

(see image to right), be sure to 

select the radio button appropriate 

for your planned input device 

(attached USB microphone versus 

analog microphone plugged into 

you on-board sound card.)  In the 

example to the right a USB device is 

selected. If you have a PowerMic II plugged in, this will be offered as a choice.   

2. During the two steps in which you are setting the volume and assessing the accuracy of your 

chosen microphone, be sure to position your microphone about ¾ inches away from your 

mouth and speak with a relaxed volume (loudness) and speed while enunciating carefully.  It is 

not necessary to speak loudly or forcefully. 

 

 

 

 

 

“… be sure to position your microphone about ¾ inches away 

from your mouth and speak with a relaxed volume (loudness) 

and speed while enunciating carefully.  It is not necessary to 

speak loudly or forcefully. 
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3. At the step at which you prepare to begin reading to Dragon (see below), do not choose to skip 

training.  Although Dragon will work without formally training it to your voice, it will not work as 

well.  The formal training takes only about 5 minutes and is well worth the time. Note:  in the 

most recent upgrade of DMPE2 you are given the option to skip additional training.  We 

recommend you do the reading. 

4. When you get to the step in which you select the passage you will read, it is strongly suggested 

that you select “What to Expect from Speech Recognition” since this will provide you with 

helpful information in your reading. 

Fine-Tuning Your Installation 
 

Once you have completed your installation, activated your software, and 

optionally registered it, a few basic configuration steps are recommended.  

These can be done at any time, but you’ll find it helpful to have some of 

this done before you start using Dragon.  These configurations are done 

from the “Options” menu, which can be accessed from the Tools menu 

(see image at right). 

Hot-Keys: Assign a few   Dragon allows assignment of keyboard “hot-

keys” to control several functions.  After opening the options menu and 

selecting the “hotkeys” tab, a hotkey is programmed either by double-

clicking on the line associated with the hotkey function or by selecting the 

line and clicking on “Edit” near the bottom of the hot keys tab.  Once in the “edit” mode, a function is 

assigned by simply pressing on a key or key combination on your keyboard.  You may find some keys 

may not be selectable for certain functions and this is because they are already assigned to another 

running application on your computer. 

The only hot-key assignment we consider 

important is assignment of one or more 

hot-keys to control the microphone.  This 

is particularly helpful if using a headset or 

desktop microphone.  There are two 

microphone control options that can be 

assigned to a key, including: 

 Microphone On/Off functionality:  

when a key is programmed to do 

this, one push of the key turns the 

Dragon microphone on and 

another push turns it off.  This is a 

fairly practical function to employ 

if you use a headset microphone 
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and want a means of turning the microphone on and off without having to click on the 

microphone icon.   

 

 Press-to-talk functionality:  although programming which leaves the microphone on or “hot” 

only when a key is depressed is potentially very 

useful, doing this with a keyboard key is a bit 

demanding of your hands.  We recommend 

reserving this type of microphone control during 

use of hand-held microphones and not for use 

on a traditional keyboard.  In this situation, with 

a hand already on the microphone, press-to-talk 

control is quite practical and a great way to keep 

the microphone on only when you are talking.  

For PowerMic II users, Dragon provides a 

separate tab for programming the PowerMIc 

buttons in the Options menu (see section below 

and the more detailed information in “Part Two” 

of the Guide).  For users of other hand-held 

microphones, such as those sold by Philips and 

Olympus, you can use the somewhat complex 

manufacturer’s control program to assign press-

to-talk function to a key.  Or you can use the 

much simpler Octopus USB Controller, which is 

described in detail in Part Two of the Guide. 

Programming a PowerMic II microphone:  Medical versions of Dragon since version 10 have included a 

high level of integration with the PowerMic II microphone.  In fact, if a user profile is based on use of a 

PowerMic II as its sound source, a separate PowerMic tab will show up on the Dragon options menu.  If 

you don’t see the PowerMic Tab, it means you have not formally set the PowerMic as a sound source for 

your user profile.  See the Microphone Set-up and Troubleshooting section of the appendix for further 

information.  Assuming you do have the PowerMic tab, we strongly recommend that you program this 

device before serious use of Dragon with this microphone.  Programming a button is as simple as 

opening the PowerMic II options tab, identifying the button you want to program, and selecting the 

desired programming action from the drop-down menu associated with the button.  For detailed 

information on using and programming a PowerMic II, please refer to the dedicated section on the 

PowerMic II: Use and Programming in Part Two of this guide. 

Fine Tune Your Correction Options:  Over the years we have noticed a few tricks that assist in the 

correction process which is essential to Dragon learning and reducing errors.  The two options we 

particularly like are the following: 
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 Automatic Playback on correction:  this has Dragon play back the word or phrase you are 

correcting so you can decide if the issue was sloppy dictation or a Dragon error.  We will cover 

this in more detail later, but in a nutshell if your dictation was sloppy, you should just re-dictate 

the word or phrase.  If your enunciation was clear and it was a Dragon error, then you should 

continue with the formal correction process.   

 

 Enable double-click to correct:  this option is helpful when you are proof reading a document.  If 

you come across a word which is wrong, simply double-click on it to launch the correction menu. 

Other recommended options:  Consider a few of the following selections from the Options Menu: 

 In the View Tab > Results section, select “Never show” from the drop-down menu.  Showing 

results in a separate window while dictating is a little processor dependent and not really 

necessary. 

 In the Miscellaneous Tab, check “Automatically Save the profile changes” 

 If you always use Dragon when your computer is running, you may want to select “Launch 

Dragon in QuickStart Mode when Windows starts” on the Miscellaneous Tab. 
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Chapter 5:  Basic Use 

 
This section is extremely short because once you have the program installed and preliminary training 
done, there’s not much to using Dragon Medical Practice Edition 2.  

Basic Dictation   

Basic use of Dragon involves nothing more than 
the following:  

1. Opening NaturallySpeaking  
2. Having the cursor in the window of a word 

processing program (EMR, Word, email 
program, etc.)  

3. Making the microphone active by clicking 
on in Dragon toolbar or activating it with your assigned “hotkey”  

4. Talking (enunciating carefully and speak in phrases or sentences, not slowly or one word at a 
time)  

5. Being sure to dictate all punctuation (comma, period, new line, new paragraph, etc.)  

That’s it! 

Selecting Text and Navigating 
 
One of the beauties of use speech 
recognition is that many of the actions you 
would usually accomplish with your mouse 
can be easily and more quickly done with a 
voice command stating your desired action.   
 
See the graphic to the right to see how 
easily you can select specific text, a range of 
words, or change the position of your 
cursor.  In each of these examples the 
“<text>” indicates the actual text in your 
document that is to be included in the 
command. 
 
 

“One of the beauties of use speech recognition is that many of 

the actions you would usually accomplish with your mouse can 

be easily and more quickly done with a voice command stating 

your desired action.” 
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Changing Font Size and Style 
 
Alternatively, if you want to change the 
appearance of text you just dictated or 
modify text earlier in the document, 
you can do this with simple voice 
command.  Like selecting text (shown 
above), you can modify a word, series 
of words, or entire selection depending 
upon your needs.  
 

Undoing Dictation 
 
If you have done some dictation and 
want to undo it, it’s as easy as saying 
“Scratch that” or “Un-do that”.  Both commands can be used repetitively.  If you don’t have specific text 
selected at the time you initiate either of these commands, Dragon will work its way backwards from 
your last utterance.  If you want to delete a word, phrase or more in the meat of a document, simply 
select it by voice (see above) and then say “delete that” or “scratch that”.   
 

 

 

 

 

  

Summary:  Using Dragon is a simple as turning on the microphone 

and talking. Learning the simple process of navigating and selecting 

text by voice will dramatically reduce your need for a mouse. 
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Chapter 6:  Microphone Management 
 

Key to maintaining a high level of 

accuracy is managing your microphone.  

In fact, the ability to control the 

microphone in a “push-to-talk” method 

may be one of the best reasons to 

consider using a hand-held microphone 

with programmable buttons.  The idea is 

that you want the microphone on when 

you are dictating, but not at other times.  

This is key because dragon works on the 

basis of what it receives as a digitized 

signal from your microphone.  If it is 

hearing only your voice, this is good.  If it’s 

hearing a mixture of your voice, the phone 

ringing, and loud conversation from the colleague sharing the dictation room, your speech will not be 

clear and the results not as good. 

 

 

 

 

Microphone Control Methods  

There are several ways to control your microphone (turn it on and off): 

1. Clicking on the microphone icon on the toolbar 

2. Pressing a keyboard “hot key” assigned to 

controlling your microphone 

3. Use of a key on your desktop or hand-held 

microphone programmed to control the 

microphone 

4. Issuing a verbal command to control the 

microphone 

5. Mechanically turning the microphone on and off 

if the microphone includes a mute or on/off switch 

There is no best method of controlling the microphone, although we personally prefer the scenario in 

which a hand-held microphone operates the microphone in a push-to-talk method, since this is the 

easiest way to quickly control the microphone’s input to Dragon.  We consider clicking on the 

microphone icon in the DragonBar or Toolbar the least practical method since it tends to be slow. 

“Key to maintaining a high level of accuracy is managing your 

microphone.” 
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Programming a Keyboard Hot-Key to Control the Microphone  

This is detailed in the “Fine Tuning” section earlier in this guide.  Be aware that you can assign either 

microphone on/off behavior or push-to-talk behavior to a key.  We like to use the former method and 

on a laptop it’s best to pick an easily reachable key on the periphery of the keyboard, such as the right 

arrow key.  We have not found it practical to use a key in a push-to-talk method since it leaves you 

needing to keep a hand on your keyboard which tends to be laborious. 

Voice Control of the Microphone   

Although it’s not my preferred method, for some, using voice is a practical way of controlling the 

microphone.  Here’s what you need to know: 

 You can put the microphone in “Sleep 

mode” by saying “Go to Sleep”.  The 

microphone icon will turn amber and 

wait until you say “Wake Up” before 

turning on. 

 You can turn the microphone off by 

saying “Mic Off”, “Microphone Off” 

or “Stop Listening”.  The microphone 

icon will turn red and will not turn on 

unless you click on the microphone or 

activate it by another means (saying 

“wake up” will not work when the mic 

icon is red) 

Controlling the Dragon Microphone with a Hand-Held Microphone  

Virtually all hand-held USB microphones work well with Dragon and include buttons which can be 

programmed to control a variety of Dragon functions, including the microphone.  Below are the options 

you can employ for using a hand-held microphone to control the Dragon microphone.  For more 

information, please refer to the expanded sections on Octopus USB Controller and recommended 

microphones in the Appendix. 

 Octopus USB Controller (OUC):  this is a third-party utility which you should know about if you 

plan to use a hand-held microphone with Dragon.  OUC facilitates the 

programming of buttons on virtually all commonly sold hand-held USB 

microphones (and other USB HID devices) and which, in our opinion 

works better than any other method.  It works with all of our 

recommended microphones, including the SpeechMike Premium, 

PowerMic II, and Olympus hand-held microphones. OUC will also allow 

you to program buttons on a portable USB keyboard to control the 
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microphone and other Dragon functions.  OUC runs about $69 and you can read more about it 

in the dedicated section in Part 2 of this guide.   

 

 SpeechMike Premium:  this is our favorite hand-held microphone and the one we use on a daily 

basis.   It includes a track ball and uses a suspended microphone element to reduce transmission 

of button clicking noise.  Although you can use the Philips Device Control Software to program 

the buttons, we have found this software to be very un-intuitive and difficult to use.  Strongly 

consider OUC as a means of programming this microphone. 

 

  PowerMic II:  this is a favored microphone for many Dragon Medical users since it is recognized 

by Dragon and when a user profile has been set up with the PowerMic II as the sound source, 

Dragon will present a separate tab on the Options menu for programming the buttons on the 

PowerMic.  It’s hard to beat this convenience.  This is the best hand-held microphone to use if 

your institution is using the newly released Dragon Medical 360 Direct cloud-based application.  

Although this product is a bit old (and awaiting an update from Nuance) it works quite well in 

terms of accuracy and external noise rejection.   

 

 

 

 

 

  

Summary:  Controlling the microphone is key to maintaining a high 

level of accuracy, particularly in situations with intermittent 

contaminating noise.  An advantage to hand-held microphones is the 

ability to program a button to control the microphone in a push-to-

talk manner. 
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Chapter 7:  Punctuation and Built in Commands 
 

Unlike secretarial transcription in which a human being on the other side knows when your sentences 

start and end and know where to put the punctuation, Dragon only transcribes what you say.  If you 

want punctuation, you need to say it.  Likewise, if you want to start a new paragraph (equivalent of 

depressing the enter key), you need to say it.  Inserting punctuation is a simple as saying it.  For 

example, to get “His cardiac exam revealed no murmurs, rubs or gallops.” You would say “his cardiac 

exam revealed no murmurs comma rubs comma or gallops period.”  It’s a simple as that.  Unlike most 

other commands, including personally created commands, you don’t need to slow down or pause when 

stating punctuation – just dictate full speed, including any needed punctuation, and Dragon will put the 

punctuation where you speak it. 

 

 

 

 

 

 

Basic Punctuation  

In the table to the right are 

the basic punctuation 

elements that you are likely 

to use frequently and which 

are used by stating the name 

of the punctuation element.  

Unlike other “commands” 

there is almost no need for a 

delay before and after 

stating a command.  If you 

aren’t accustomed to dictating 

punctuation, there is typically a bit of a “learning curve” with this,  But if you stick with Dragon you will 

eventually find it becomes second nature and you won’t give it a thought.  And unlike human 

transcription, the punctuation will go where you want it. 

 

 

 

“Unlike secretarial transcription in which a human being on 

the other side knows when your sentences start and end and 

know where to put the punctuation, Dragon only transcribes 

what you say.  If you want punctuation, you need to say it.” 
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Advanced Punctuation and Commands   

We have put together a fairly extensive 

collection of built in Dragon commands 

which is presented in the Overview of 

Built in Dragon Commands in Part Two of 

this guide.  Particularly for new users, you 

might consider printing these pages and 

having this available to you during your 

first weeks or months of Dragon use. 

 

 

  

Summary:  You must dictate all punctuation.  At the beginning you 

might benefit from the extensive overview of built in punctuation 

and other commands found in the Appendix.  Consider printing this 

and keeping it handy when you start using Dragon. 
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Chapter 8:  Helping Dragon Learn From Its Mistakes 

 
While Dragon is amazingly good right out of the box and following the mandatory 5 minutes or so of 

training, it will make mistakes.  Why does this happen?   Keep in mind the following: 

1. Dragon does not understand content.  It simply 

does the best it can with what it hears, the 

loaded vocabulary, and the statistical models it 

employs.  Sometimes the nuances of your 

clinical dictation are just too unique and won’t 

be recognized accurately. 

2. You may not have enunciated clearly and 

Dragon just didn’t hear the words you were 

intending to speak.  If you’ve ever seen a 

transcriptionist struggling to understand a phrase 

you can imagine how Dragon can face the same challenge. 

3. As the day goes on, your voice may change a bit and become coarser; similarly, if you have a 

cold or laryngitis, Dragon won’t be hearing the same voice it was trained to recognize. 

The important point is that recognition errors will occur – some of your making and some of 

Dragon’s. You can put up with these occasional errors if you want, and hopefully catch these on a 

proof read of your document.  Or, you can formally correct errors when they occur and dramatically 

reduce the likelihood of repeat offences.   

 

 

 

 

 

 

Basics of correction 

Correction of a word or phrase is accomplished by means of initiating a formal correction process which 

brings up the Correction Window and which may be initiated by one of three methods: 

1. Correcting the word or phrase by saying “Correct <word>” or “correct <phrase>”, speaking the 

word or phrase in the form displayed by Dragon. 

2. Selecting the word or phrase by voice (or manually) and saying “correct that” 

3. Double-clicking on the word (assuming the “double click to correct” option has been selected in 

the Correction tab of the Option menu.) 

 

Dragon’s accuracy will 

improve and errors will be 

less likely to recur if you 

take the time to correct 

errors when they happen. 

“… recognition errors will occur – some of your making and 

some of Dragon’s … you can formally correct errors when they 

occur and dramatically reduce the likelihood of repeat offences.   
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If you initiate a correction by voice, it is helpful to say the incorrectly word or phrase as Dragon has 

written it and not as you intended it so as to make it most likely Dragon will understand what you are 

attempting to correct.   

 

 

 

 

 

However you initiate the process, one you do so, the 

Correction Window will show up and the word or phrase 

in question will be front and center.  The example to the 

right occurred when dictating the term “Wyeth Road” 

using a medical vocabulary and it incorrectly transcribed 

“Y throat”. 

1. If the correct selection is shown among the 

choices, say “choose” followed by the number 

corresponding to the correct choice.  The 

corrections window will close and the correct 

text will replace the incorrect word or phrase in 

your document. 

2. If the correct choice is not present, then say 

“Spell that” to bring up the spelling into in which 

you can spell the correct choice and, optionally 

select “Train” in order to train the word or phrase. 

In the example to the right, I 

dictated the name of a 

colleague named “Andrew 

Gettinger” and Dragon got 

this wrong by printing 

“Andrew get in chair”.  The 

correct choice was not 

provided in the Correction 

Window, so I said “spell 

that” and manually typed 

his name in the window 

before clicking OK. 

“If you initiate a correction by voice, it is helpful to say the 

incorrectly word or phrase as Dragon has written it and not as 

you intended it so as to make it most likely Dragon will 

understand what you are attempting to correct.” 
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Your mistake or Dragon’s? 

As alluded to earlier in this guide, it’s important to 

differentiate between mistakes made by Dragon 

legitimately misrecognizing your speech and a mistake 

resulting from your sloppy dictation.  One of quirks of 

the correction process is that when you formally correct 

text, the pronunciation you used when saying the phrase is saved by Dragon and incorporated into the 

user profile.  As a result, if you pronounce something poorly, correct it with formal correction 

techniques, this may actually contribute to worsening your speech profile over time.  Therefore 

correction should truly be 

reserved for the Dragon 

mistakes and not your 

mumbled dictation.  How 

can you determine whether the error was yours or Dragons?  Under the Correction tab in the Options 

menu, select “Automatic Playback on Correction (see image above).  When correcting an error, listen to 

the playback of your text and handle it as follows: 

 If the pronunciation 

was good (Dragon 

mistake), continue 

with formal correction 

 If the pronunciation 

was poor (your 

mistake), simply re-

dictate the text from 

where you are.  Upon 

your re-dictation, the 

newly dictated text will be placed in the document and the correction menu will go away. 

 

 

 

Correct phrases rather than single words 

Although it may occasionally be fine to correct just the misrecognized word, in many cases it will be 

better if you correct it in the context of other associated words, especially if the word misrecognized 

typically occurs with other words.  If a misrecognized word typically occurs as part of a larger phrase, it is 

best to correct the entire phrase rather than just a single misrecognized word. 

Key Point:  If the mistake was Dragon’s, you should formally correct it.  If the 

mistake was a consequence of sloppy dictation, you should simply re-dictate it 

“…. correction should truly be reserved for the 

Dragon mistakes and not your mumbled dictation.” 
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 Example 1:  If you dictated the condition “atrial fibrillation” and Dragon interpreted it as “actual 

fibrillation”, it would be better to correct the entire term – atrial fibrillation – and not just the  

atrial/actual misrecognition, since it is the entire phrase that you want Dragon to get right the 

next time. By correcting both words together you are giving Dragon important added context. 

 Example 2:  It hasn’t happened in years, but in older versions of Dragon the term “peripheral 

vascular disease” would somewhat comically show up as “peripheral bastard disease”.  Again 

rather than correcting just the “bastard”, it makes more sense to correct the entire “peripheral 

vascular disease” phrase. 

 

 

 

 

  

Summary:  Consider whether recognition errors are from sloppy 

dictation or Dragon’s mistake.  When Dragon is at fault, formally 

correcting errors will dramatically lessen the likelihood of repeat 

errors and will improve accuracy. 

“If a misrecognized word typically occurs as part of a larger 

phrase, it is best to correct the entire phrase rather than just a 

single misrecognized word.” 
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Chapter 9:  Managing Your Vocabulary and Words 
 

The vocabulary is the underlying set of words from which Dragon chooses when making its decisions. It 

is critical that you match the active vocabulary with the type of dictation you are doing.  By this we 

mean that if you are an endocrinologist, you should have selected the endocrinology vocabulary.  

Likewise, if you are moving from medical dictation to dictating some non-medical material, you should 

switch to a general non-medical vocabulary.   

 

 

 

Vocabulary in Action 

The importance of using the right vocabulary is easily demonstrated in this true example shown below, 

with the first paragraph dictated using a general (non-medical) vocabulary and the second using a 

medical (cardiology) vocabulary.  Recognition errors are highlighted in yellow. 

Non-Medical Vocabulary Medical (Cardiology) Vocabulary 

This elderly woman comes for brief follow-up 

visit regarding her coronary artery disease. 

She presented with a non-stemming about a 

month ago, underwent heart catheterization 

which showed a subtotal excluded modality 

and was treated with a promise struggle that 

extent. 

This elderly woman comes for a brief follow-

up visit regarding her coronary artery 

disease.  She presented with a non-STEMI 

about a month ago, underwent heart 

catheterization which showed a subtotally 

occluded LAD, and was treated with a 

Promus drug-eluting stent. 

 

The opposite results might be seen if the dictation was general in nature, and not medical, i.e. the 

general vocabulary would have been more accurate. 

Changing your base vocabulary 

Although DMPE2 will allow you to have only one active vocabulary loaded at one time, you can have 

several included in your user profile and switch quickly (relatively quickly)  from one to another as 

needed.  This type of strategy might be helpful if, for instance, 

you practice Internal Medicine part of the time and Infectious 

Disease part-time.  Likewise, you may want to use Dragon for 

non-medical dictation some of the time, perhaps for personal 

communication, and a medical vocabulary at other times.  

“It is critical that you match the active vocabulary with the type 

of dictation you are doing.”   
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Adding a new vocabulary: 

1. Open the “Manage Vocabulary” editor (you will see your 

current vocabulary or vocabularies when opening it – see 

image above) 

2. Click on “New…” to launch the “New Vocabulary” window 

(shown to the right) 

3. Give your new vocabulary a name (anything you choose) 

4. From the “Based on:” scroll down menu, select the 

vocabulary you desire to add to your profile and then click 

OK 

5. Be patient while the new vocabulary is added to your user 

profile. 

6. Select the vocabulary you wish to have open at this time (highlight it) and then click “Open” 

Switching Vocabulary:  Once you have added an additional vocabulary to your user profile, you will now 

have the choice of switching between vocabularies (view image below), simply by scrolling to the “Open 

Recent Vocabulary” selection on the 

Vocabulary menu.   

Hint:  you can streamline the process of 

opening an alternate vocabulary by simply 

saying “Open recent vocabulary”.  

Regardless of how many vocabularies you 

have created, it will always open the last one 

you used.  

Adding Words 

The base vocabulary you loaded when creating your profile provides you with a large standard 

vocabulary for your chosen specialty or subspecialty.  Although highly comprehensive, there may be 

words you want to add to the vocabulary.  In fact, we highly recommend you add words to the 

vocabulary if they are not already there.  Specific words you may want to add include the following: 

 New drugs that are not in the base vocabulary 

 Names of referring doctors or practices you dictate frequently 

“Although DMPE2 will allow you to have only one active vocabulary 

loaded at one time, you can have several included in your user 

profile and switch quickly…  from one to another as needed.”  
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 Names of places within your practice on institution  

 Word combinations which had 2 vocabulary proper names 

Adding simple words:  this can be 

done in a number of ways 

including 1) saying “add new 

word” or 2) navigating to 

Vocabulary > Add new word or 

phrases ..  Either way it opens the 

Add Word or Phrase Editor as 

shown to the right.   

Written Form vs. Spoken Form:   

If a word is somewhat unique and the pronunciation doesn’t necessarily follow from its spelling, you 

may want to give Dragon a hint about what to listen for.  In the example above, for instance, the Post 

Anesthesia Care Unit at our institution is nick-named the PACU (pronounced like pack-you).  By 

providing the separate written and spoken form of the word as shown above it will transcribe it the way 

you want.  You can use this same principle to do some tricky things as well.  Consider some of the 

following examples, in which you say one thing and Dragon transcribe another: 

Written Form Spoken Form 

Jon Wahrenberger My name 

Richard Belliveu Richard bella view 

The Man from U.N.C.L.E. The man from Uncle 

 

Importing words in bulk:  An extremely useful function is to import a list of unique words which you 

want added to your vocabulary.  We have found this useful to add, 

in bulk, a list of regional hospitals, fellows or residents in the 

training program, names of other providers with which you work, 

and common institutional places.  Here’s how it’s done: 

1. Create your list of words in a text document with one 

word per line 

2. It’s ok to have several words comprising a phrase if this is 

your intension (see the example written forms above. 

3. If your works need to have a separate written form and 

spoken form (see above), add these using the following format written form\\spoken form 

4. Add the following text to the top of your list:  @Version=Plato-UTF8 

5. Save your document in a text (.txt) format 
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6. Import your word list by navigating to Vocabulary > Import list of words or phrases; follow the 

subsequent instructions. 

Exporting Words 

Exporting words is useful both for archiving your collection of 

custom words and also for sharing with a colleague.  Doing so 

is extremely simple and involves the following steps: 

1. Navigate to Vocabulary > Export custom words and 

phrases list.   

2. Save the text file wherever you want on your hard 

drive. 

Although it’s not mandatory, it is considered good practice to 

periodically export your custom words once in a while so you will have a good back up in case your user 

profile is ever corrupted. 

Note:  For reasons which are sometimes hard to tie down, you will find that many unintended words will 

get into your collection of custom words.  

Before doing the export as described above, 

it’s a good idea to look at your custom and 

delete any that are not there for a good 

reason.  This is done as follows: 

1. Navigate to Vocabulary > Open 

Vocabulary Editor 

2. From the “Display” drop-down on the 

bottom of the Vocabulary Editor, 

select “Custom Words Only: 

3. Review the list of words 

4. If there are any words you want to 

delete, select them and click on 

“delete” 

 

 
 

 

  

Summary:  Since your active vocabulary and collection of words is 

the set from which Dragon selects as you dictate, having the right 

vocabulary and adding custom words is key to high levels of 

accuracy when using speech recognition. 
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Chapter 10:  Achieving High Levels of Accuracy 

 
Although achieving high levels of accuracy is possible by almost anyone using Dragon, it doesn’t happen 

by luck.  Dragon has the potential to be highly accurate, but it needs a bit of help on your part.  Any 

mistake in a medical document has the potential for being, at a minimum, an embarrassing mistake.  In 

the worst of cases in could lead to an error in communication with potential legal ramifications. What 

can you do to reach nearly 100% accuracy? Speaking clearly and dictating in complete phrases and 

sentences is the biggest determinant of accuracy when using Dragon.  

Optimize Your Dictation Style 

 
Despite our tendency to seek technical ways to improve recognition accuracy, far and away the most 
important key to optimizing accuracy with voice recognition software is the manner in which you 
dictate.  

 Enunciate clearly – the importance of this cannot be overemphasized. 

 Speak in a smooth manner, neither overly slowly or excessively rapidly. Speak in either 

sentences or phrases. Recognition is worst when speaking one word at a time.  

 Maintain a relatively consistent pitch and tone when dictating  

If you forget to turn off your microphone while you are engaging in normal conversational speech you 

will see the results in the form of awful accuracy.  Over time you will develop the dictation style that will 

provide you with optimal results. 

 

 

 
 
 

Optimize Your Hardware  

While you might not have any choice in regard to your hardware, don’t underestimate the value of 

optimizing certain aspects of your system. 

 Don't run unnecessary programs (will compete with available RAM)  

 Run disk defragmenter periodically (programs > accessories > system tools > disk defragmenter). 

This can be somewhat time‐consuming, so don't start it in the middle of the day!  

 Be sure your computer has adequate RAM; although 2 GB is considered the minimum, 8 GB or 

more may be optimal. Get as much as you can.   

 Increase the paging file size, so that your system has enough virtual memory available to handle 

the tasks you'll be asking of it.  This is probably not necessary if your PC has a solid state hard 

drive (SSHD).  For an easy tutorial on increasing paging file size, visit:  http://www.online-tech-

tips.com/computer-tips/simple-ways-to-increase-your-computers-performace-configuring-the-

paging-file/  

“Speaking clearly and dictating in complete phrases and sentences 

is the biggest determinant of accuracy when using Dragon.” 

http://www.online-tech-tips.com/computer-tips/simple-ways-to-increase-your-computers-performace-configuring-the-paging-file/
http://www.online-tech-tips.com/computer-tips/simple-ways-to-increase-your-computers-performace-configuring-the-paging-file/
http://www.online-tech-tips.com/computer-tips/simple-ways-to-increase-your-computers-performace-configuring-the-paging-file/
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 Change your Windows performance settings to disable advanced visual effects. This means 

selecting the "Adjust for best performance" radio button found as follows:  Control Panel > 

System > Advanced System Settings > Advanced Tab > Performance Section > Settings. 

 If you notice recognition accuracy deteriorate during the day, consider restarting your computer 

to clear your RAM.  This is rarely necessary. 

 Use the best microphone you can afford. See the section on Detailed Microphone 

Recommendation in Part Two of this guide. 

 If you are using a laptop computer and are not getting great accuracy, consider bypassing your 

on-board sound card by using a "USB sound adapter". This is a device into which you plug your 

microphone and which in turn is plugged into a USB port on your computer. The USB pod 

digitalizes the analog signal from your microphone and bypasses the internal sound card on your 

computer.  

 

 

 

 

 

 
Optimize Your Software  
 
Many aspects of the way Dragon is configured and how you use your software will significantly impact 
the accuracy you observe.  Here are some suggestions: 

 Be sure you have loaded the appropriate vocabulary for the type of dictation you are doing.  

This means the correct specialty or subspecialty vocabulary if doing medical dictation, and 

perhaps a general, non-medical vocabulary if doing non-medical dictation. 

 Run the "audio set‐up wizard" (navigate to Audio > Check Microphone or simply say “check 

audio”) when making a major change in dictating environment or when you notice a 

deterioration in recognition accuracy.  

 Let Dragon learn from its mistakes by employing formal correction methods when Dragon 

makes a mistake 

 Before training Dragon to fix an apparent "error" you should listen to the dictation either by 

setting Dragon for "automatic playback on correction" (under the tools > options > correction 

menu) or by choosing "Play that Back" from the correction menu.  

 

o If your enunciation was clear, you can reasonably correct the dictation.  

o If your enunciation was not clear, you should simply re‐dictate the wrong word or 

phrase; otherwise the poor enunciation will be stored with your correction and acoustic 

model degraded.  

 

“If you are using a laptop computer and are not getting great 

accuracy, consider bypassing your on-board sound card by using a 

‘USB sound adapter’.” 
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 Periodically run Dragon’s “Acoustic and Language Model Optimizer”.  This is accessed by 

navigating to Audio > Launch Accuracy Tuning.  The process, shown below, leads to a 5-10 

minute process during which all of your recent corrections are formally incorporated into your 

speech model and can dramatically increase your recognition accuracy. We recommend running 

this every few weeks. 

 
Note on running the Acoustic and 

Language Model Optimizer:  running 

this optimizer is fairly processor 

dependent and may take 5-10 

minutes to complete depending upon 

how long it’s been since you ran it.  So 

launch this when you do not need to 

do anything active on your computer. 

 

 After establishing a good working 

user profile (typically after a week or 

so or regular dictation and corrections), consider no longer saving your user files regularly. 

Rather, save user file only after making major corrections or additions to your vocabulary.  

 
 
 
 
 

  

Summary:  Achieving and maintaining a high level of accuracy 

depends upon a combination of factors related to your dictation 

style, the software and your computer. 
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Chapter 11:  Dragon Templates as Navigation Aids 
 

Overview   

The ability to navigate through a document by voice is a function that has been present ever since the 

first version of Dragon Medical Practice Edition.  The concept is that a letter, office note, consult etc. can 

be built in advance in a simple form with pre-placed markers or navigation fields and serve as a template 

into which you can sequentially move from field to field and add personalized information at each 

stopping point. In practice, these navigation points or “variable regions” are defined by Dragon with a 

left and right square bracket, with or without intervening text. The brackets themselves are termed 

“variable delimiters” and if you prefer to use something other than squared brackets for this function, 

you can change this in the Dragon Options menu.  

Keep in mind that any character, word, sentence or longer segment of text placed between the defined 

delimiters becomes part of such a variable region. The beauty of these variable fields is two‐fold:  

1. They can be used as navigation markers since Dragon has the ability to navigate, upon your 

command, sequentially from one to another throughout a document.  Doing so requires only that 

you say “next field” or “previous field” to move forward or backward through these variable regions.  

Alternatively these commands can be assigned to a key on a hand-held microphone. 

2. They can contain text which you can choose to accept or reject as you go through a document  

 

The term “template” comes from the fact that use of this function requires that these “variable regions” 

are constructed into a note template in advance of the time that it is actually used. These can be added 

to a note template in your electronic health record or added to the text within a text command you 

intend to initiate.  

 

 

 

 

Template Examples   

Shown below are examples of two common uses of Dragon Templates: 

1.  Simple use of Dragon Templates as a means of navigation:  The most basic example if the basic 

“SOAP note” template in which an office notes is broken down to subjective, objective, 

Key Point:  You can quickly navigate through pre-defined “navigation fields” 

within a document defined by voice, a hot-key, or a button on a hand-held 

microphone 
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assessment and plan regions.  If this the basic structure 

of your note, you might construct a template that looks 

like the text to the right:  

In this scenario, you would navigate through this note 

template by saying “next field” or “previous field” or by 

programming a button on your PowerMic or other 

hand-held microphone to emulate the same function, 

and dictate appropriate text at each stopping point.   

2. Using Dragon Templates as a means of handling 

variable content 

In some situations you may 

want to pre-populate a 

document with a number of 

pieces of variable 

information, with the 

intension of keeping some 

and deleting others.  We 

have found it helpful, for 

instance to populate a 

normal Review of Systems 

and toggle through it using 

the “next field” 

functionality on a hand-held microphone 

Clearing variable field delimiters  

If you are using fields only as a means of navigating, each field (including brackets) will be selected and 

dictated over as you navigate through the note.  In this scenario the field brackets will disappear as you 

go.  In the event that you are using Dragon templates as a means of actually handling variable content, 

you may be deleting some and leaving some.  In this case some of the brackets may remain when you 

have gone through the document.  All of the extra brackets can be removed with a simple Dragon 

command of “Accept Defaults” 

 

 

 

 

General:  [No weight loss, fatigue, anorexia, insomnia, or fever.] 
Eyes:  [No visual loss, double vision, drainage, eye pain, or dry eyes.] 
ENT:  [No sore throat or dry mouth.] 
Pulmonary:  [No shortness of breath, cough, or hemoptysis.] 
Hem/Lymph:  [No swollen glands, fever, or bleeding.] 
GI: [No abdominal pain, change in bowel habits, melena, nausea, 
vomiting or dysphagia.] 
GU:  [No urethral discharge, dysuria, frequency, or nocturia.] 
Endocrine:  [No hot spells, cold spells.] 
Musculoskeletal:  [No limb pain, joint pain, or joint swelling.] 
Neuro:  [No focal weakness, ataxia, confusion, paresthesias or 
headache.] 
Skin:  [No rashes or dry skin.] 
Psych:  [No depression, anxiety, suicidal ideation.] 
Cardiac:  See HPI 

Summary:  Use of Dragon templates or navigation fields can be a 

huge productivity enhancer by facilitating rapid movement 

throughout a document. 
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Chapter 12:  Commands to Enhance Efficiency 

 

Overview of Command Use 

Although the basic voice-to-text functionality of Dragon is a huge time saver, one of the often 

unappreciated capabilities of Dragon is the use of commands or macros.  If you do anything repetitive 

on your computer, whether dictating or typing the same text, opening a document/folder/program with 

frequency, or completing a series of repetitive actions on your computer, you could save huge amounts 

of time through the use of commands. 

 

 

 

 

 

 

What are commands?  In essence “commands” are a means by which Dragon allows you to accomplish 

something on your computer with a voice request.  What kind of “somethings” are we talking about?  

The list is fairly endless, but includes the following: 

 Insertion of chunks of text (anything from single words, phrases, or a series of paragraphs) 

 Insertion of images 

 Typing of specific keys or key combinations that may control another application 

 Opening of documents, folders or applications 

 Typing of key combinations that affect function in an electronic health records, such as those 

that insert a note template or insert specific structured information 

 Creation of complex, multi-sequence commands  

 Lots, lots more 

Are commands hard to create?  There are four different types of commands which can be created with 

Dragon, including Text and Image commands, Step-by-step commands, Macro-recording commands, 

and Advanced Scripting commands.  The first two types of commands are simple enough for your 

grandmother to figure out and are also the most useful.  Advanced Scripting commands require a bit of 

programming knowledge so are probably not practical for the average user. 

Overview of Command Types   

Here’s a quick run-down of the types of commands: 

“If you do anything repetitive on your computer, whether dictating or 

typing the same text, opening a document/folder/program with 

frequency, or completing a series of repetitive actions on your computer, 

you could save huge amounts of time through the use of commands.” 
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 Text and Graphics Commands:  these are probably the most useful for medical providers and 

also the simplest to create.  The idea is you issue a verbal command such as “insert my 

signature” and a graphic version of your signature is inserted in your document.  Or you say 

“brief male exam” and a boilerplate male exam is inserted into your document.  Since a lot of 

medical documentation involves a use of repetitive text, this type of text is perfect to turn into a 

text command.  Text commands save time almost instantly and are a snap to create. 

 

 Step-by-Step Commands:  These are almost as easy to create as Text and Graphics commands, 

but typically involve a sequential action.  In the Epic EMR, for instance, insertion of a “smart-

phrase” or “dot phrase” is initiated by typing a period, some specific text, and then the Enter or 

Tab key.  The two steps required for insertion of a specific dot phrase, perhaps the one you use 

to open a note template, can be emulated by a step-by-step command which is initiated by a 

verbal command of your choosing.  It takes about a minute to create one of these and over the 

ensuing months you will accumulate hours of saved time. 

 

 Advanced Scripting Commands:  these types of commands are clearly a bit trickier and require 

you to delve just a bit into the world of Visual Basic programming.  Once mastered, these types 

of commands can do amazing things and lead to huge efficiencies.  The only issue is whether 

you have the time to learn how to build these.  For most of you – probably not!  But check out 

the examples below. 

 

 Macro Recorder Commands:  this type of command is for the processes or actions that are hard 

to nail down with any of the other categories.  In essence, you allow Dragon to record some 

specific action or series of actions you take on the computer and it will remember these and 

launch this series upon your command in the future.   

Text and Graphics Commands 

These are so simple and so useful that you absolutely have to browse this section and learn how to 

make these.  These are designed to insert text or graphics into your word-processing document with a 

verbal command and take only a few seconds to create.  Text commands are huge time-savers for 

insertion chunks of text you use repetitively in medical documentation such as aspects of the physical 

exam, procedural consents, and documentation of counseling discussions.   

 

“Text commands are huge time-savers for insertion chunks of text 

you use repetitively in medical documentation such as aspects of 

the physical exam, procedural consents, and documentation of 

counseling discussions.” 
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Basic steps in creating a Text Command 

Creating a text command takes only a few seconds and 

will save you massive amounts of time.  Here are the few 

simple steps: 

1.  From the Tools menu, select Add New 

Command  (or with Dragon open say “add new 

command”) 

2. In the MyCommands Editor which appears 

(image at right), enter the following:  1) a name 

for the command (this is the term you speak to 

launch the command and 2) the content of the 

command (add text or graphic to the “content” 

area either manually or by pasting.) 

3. Optionally click on the “Plain Text” box (see 

below) 

4. Click “Save”.   

Suggested Use of Text and Graphics Commands 

 

Text commands are particularly useful in the documentation of the following: 

1. Physical exam (full exam or individual parts of exam) 

2. Common discussions, i.e. risk factor counseling, side effect warnings 

3. Procedural consents 

4. Overview of treatment plans 

5. Listing differential diagnosis of common symptoms, lab abnormalities, etc. 

6. Creation of note templates 

Caveats on using Text and Graphics Commands 

1. Plain Text Option:  If you want the text inserted with this kind of command to assume the 

behavior (font size, style, etc.) of the text in the document into which it is being inserted, be 

sure to check the “Plain Text” box.  Plain text infers that it will not carry any specific formatting 

behavior when inserted.  On the other hand, if you want the font size, style and other 

characteristics of the text you use in this type of command to be maintained, leave the Plain 

Text box unchecked.  This is appropriate if you text command is for an overall note template and 

you want, for instance, the heading to be in a bold font. 

 

 “If you want the text inserted with this kind of command to 

assume the behavior of the text in the document into which it is 

being inserted, be sure to check the “Plain Text” box.”  
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2. Quick Text Command Creation:  If you have already created the text which you would like to 

make into a text command for future use, all you need to do is select (highlight) the text and 

then say “Make that a 

Command”.  Dragon will 

open the New Command 

Editor and automatically add 

the selected text into the 

content area.  You will 

simply need to give it a 

name and save it. 

Step-by-Step Commands 

Step-by-Step commands are commands in which one or a series of sequential actions of your choosing 

are carried out upon your verbal initiation.  There are 8 potential categories of steps: 

1. Keystrokes:  send any keystrokes (useful for sending key combinations using the control, alt, 

shift and other similar keys, combined with letters) 

2. Open Application (open any application or document) 

3. Wait (do nothing for a specified period of time – this is useful when waiting for an application to 

open or something to happen before moving to next step) 

4. Type Text (types specific text, similar to “Text and Graphics” commands described above, but 

these are intended for shorter chunks of text and will not allowing formatting of text) 

5. Send Keys (this is a somewhat more elaborate way of sending keys and key combinations. Alpha 

numeric keys are entered just as they are on the keyboard.  Other functions are inserted by 

placing appropriate verbiage between curly braces { }.   

6. Stop Listening (puts Dragon in sleep mode) 

7. Microphone On (turns microphone on) 

8. Microphone Off (turns microphone off) 

 

While there are only 8 categories of steps, all but the last three listed above have almost endless 

possibilities.  Consider the following: 

 

 The simplest thing you can do with a step-by-step command is to open a document or 

application (Open application step).   

 If you want to print a document you can have Dragon submit the key combination Control + P 

(Key stroke category).   

 If you want to open a document and then print it, you could combine these steps into a single 

step-by-step command and perhaps use a “wait” step to give time for the application of 

document to open before printing it (wait step).   

 If you have a long series of steps and want to be sure the microphone is turned off as steps are 

being completed, you can add microphone off and microphone on steps at the beginning and 
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end of command sequence.   

 

Step-by-step commands are particularly helpful for initiating built-in commands in an EMR which require 

the use of certain keystrokes.  In Epic, for instance, vital signs can be inserted into a note in progress by 

typing a period followed by the letters “vs” and then hitting either the tab or enter key to complete the 

“dot phrase” and insert the last set of vitals.  This is a perfect thing to do with a step-by-step command.  

See the example to the right. 

 

 

 

 

 

 

Building a Step-by-Step Command   

 

Follow these simple steps to create a step-by-step command. 

1. Open the MyCommands editor by saying 

“add new command” or navigating to 

Tool > Add new command” 

2. Name the command (you can do this 

later if you want, but you must do so 

before saving) 

3. Select “Step-by-Step” from the Command 

type drop-down menu 

4. Select the function of the first step by 

choosing from the “New Step” drop-

down menu 

5. Click on “insert” to initiate the first step 

6. If the step is simple, such as the 

microphone being turned off or on, the 

step will be inserted; for each of the 

other step types, another dialog box will 

show up into which you enter the text or 

keystroke required for the step. 

7. If needed, change the order of the steps using the “Move Up” and “Move Down” selectors at 

the right of the MyCommands editor. 

8. Click “Save” to complete the command. 

 

If your command is very similar to a previously built command, consider copying the other command, 

renaming it, and changing just the unique step in the new command.  A command is copied by clicking 

on the “Create New” button at the bottom of the MyCommands window. 

“Step-by-step commands are particularly helpful for initiating built-in 

commands in an EMR which require the use of certain keystrokes.” 
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Macro Recorder Commands 

These types of commands are used for the “last resort” tasks that you can’t think of any other way to 

make. Building this type of command involves having Dragon record a series of steps you take on the 

computer and saving them for recreation upon initiation of the command. Most users never use this 

type of command. If you build such a command, you can review all the steps and delete all but the key 

events in order to simplify and speed the command. 

 

 

Advanced Scripting Commands 

These are extremely powerful commands that use a variant of a simple programming language called 

Visual Basic and can accomplish a variety of functions ranging from simple to complex. Teaching you 

how to build this type of command is clearly beyond the scope of this document. For further 

information, you might consider the following:  

 

 Scripting for NaturallySpeaking: this is truly the “bible” of constructing commands. It’s written 

by Larry Allen of Softnet Systems, Inc. and can be purchased either directly from Larry (see 

www.pcspeak.com) or from Speech Recognition Solutions (www.SpeechRecSolutions.com).  

 NaturallySpeaking QuickMacros: This is a short and helpful 52 page book on creating custom 

commands. You can learn more about it or purchase it at: http://www.speak‐

it.com/quickmacros.htm  

 Speech Recognition Solutions offers some very brief instructions on building Advanced Scripting 

commands on its website.  Please see:  SRS Command Building Guide. 

(http://www.speechrecsolutions.com/BuildingCommands/buildingcommands.htm ) This is an 

old guide, based on somewhat older versions of Dragon, but it might provide you with some 

ideas. 

 

 

  

Summary:  Use of commands, particularly “text and graphics 

commands” is a simple way of saving time with repetitive tasks. 

“If your command is very similar to a previously built command, 

consider copying the other command, renaming it, and changing just 

the unique step in the new command.”   

http://www.speechrecsolutions.com/BuildingCommands/buildingcommands.htm
http://www.speechrecsolutions.com/BuildingCommands/buildingcommands.htm
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Chapter 13:  Dragon with an Electronic Health Record 
 

To be worth its cost, Dragon must be able to help you efficiently and accurately document in an 

electronic medical record.  For most providers and with most EMRs, this is entirely feasible.  But there 

are a few things to keep in mind. 

Key considerations: 

 Take note of how your EMR is implemented.  Is the application installed on your computer or is 

it being presented virtually by means of Citrix or a similar technology.  Be aware that DMPE2 

works well only when both Dragon and the target window for text or action are on your local 

machine.  If the EMR is running on your machine, you can expect fairly good results if the EMR is 

using Dragon compatible text entry windows.  On the other hand, when an EMR is presented via 

Citrix, which is increasingly common these days since it is dramatically easier for your practice or 

institution to administer, you’re likely to have problems.  When presented via Citrix, your EMR is 

actually located on a server somewhere else and you (and Dragon) are seeing only a visual 

representation of the EMR on your local machine.  In this situation, you can expect issues with 

using Dragon and you may need to adopt those suggestions described elsewhere in this Guide 

related to using Dragon in non-compatible applications.  If you are having serious issues because 

of Citrix related issues, you should explore with your IT personnel the possibility of switching to 

either the Network Edition of Dragon or a network installed version of Dragon Direct. 

 

 Remember that not all text entry windows are the same.  Dragon works beautifully in Microsoft 

Word, WordPad, Dragon Pad, and most other word processing or text entry environments (see 

Part Two of this guide for a list of compatible applications).  But there are many text entry 

environments within an EMR and they vary in compatibility with Dragon. As a result, Dragon will 

not necessarily perform identically in every window in your EMR.  You can learn more about 

general EMR compatibility with Dragon from Nuance’s Dragon EMR Compatibility Page in Part 2 

of this guide.  If you have questions about how Dragon works with a specific EMR, we 

recommend you reach out to the EMR vendor or existing users. 

What can you do with Dragon in your EMR? 

  Keep in mind that different providers use Dragon differently.  Some use it for everything and some use 

it for text entry only.  Here are some of the functions you might accomplish with Dragon in your EMR: 

 Opening EMR and entering your logon password 

“Be aware that DMPE2 works well only when both Dragon and 

the target window for text or action are on your local machine.”  
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 Navigating from section to section within the EMR 

 Selecting and opening note templates 

 Text entry in notes, and other windows including problem lists - MOST HELPFUL! 

 Inserting structured data into a note on the fly, including lab data, vitals, etc. 

 Clicking buttons 

 

Dragon with your EMR: Practical Strategies 

With every EMR being different and with great variability in how EMRs are implemented, you may need 

to do a bit of digging to optimize your use.  Here are some things to think about 

 Find out if there are ready made Dragon “commands” or macros prepared for your EMR or your 

specific institutional implementation of your EMR.  These may be available from your institution 

or from your EMR vendor.  Epic Systems, for instance, offers a set of Dragon commands on their 

“User Web” portal.  If you can get such a set, do so and use them.  Modify them if you desire. 

 Inquire of your colleagues and any institutional Dragon “champions” to see if they have 

commands or practical strategies they can share. 

 Since most EMRs have assigned keyboard “hot-keys” to navigate and do other things, ask for a 

list of keyboard shortcuts.  These are useful for creation of Dragon commands. 

 Know when to use Dragon and when to use your mouse or keyboard.  Just because you CAN do 

something by voice does not mean it’s necessary or practical to do it by voice.  Because Dragon’s 

integration with most EMR’s is not all that tight, many users limit use of Dragon to text creation 

in notes and use the mouse and keyboard for all the navigation and other functions within the 

EMR.  See what works best for you. 

  
“Know when to use Dragon and when to use your mouse or 

keyboard.  Just because you CAN do something by voice does not 

mean it’s necessary or practical to do it by voice.” 
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Chapter 14:  Strategies for the High Noise Environment 
 

Previously, the importance of a clean signal for your voice has been stressed.  Further, the benefit of 

using Dragon in an environment free of contaminating noise has been reviewed.  As important as this is, 

we have found that some users simply can’t get away from the noise and must, somehow, dictate in this 

environment.  A few days ago I was contacted by a physician struggling to use Dragon in a dialysis unit.  

In my own practice, I find the craziness of busy inpatient ward to be the biggest challenge.  Sometimes, 

though, it is just the loud voice of a colleague sharing a dictation room in clinic. 

So the question is, how can you deal with this type of noise?  Are there options to mitigate the effects of 

this unwanted sound?   

 

Practical Strategies to Deal with a noisy environment 

Here are a few things to consider in minimizing the consequences of a loud environment, shy of locking 

yourself in a soundproof booth: 

 A simple trick that sometimes makes Dragon a little less susceptible to contaminating noise is to 

run the Audio Setup wizard and during the first step, talk somewhat louder than you ordinary 

do.  This will cause Dragon to crank down the mic input volume.  When you're done, Dragon will 

be operating with the input volume lower and theoretically less likely to be affected by the 

noise.  I've seen this help. 

 Think about how noise is affecting your dictation style.  In the course of some fairly intense 

microphone testing we have developed a protocol in which dictation is done with a recorded 

voice rather than live, spontaneous speech.  Somewhat surprisingly, the impact of noise in this 

testing environment is quite minimal, even during the phase of testing in which the noise is loud 

and fairly random. With almost every microphone tested, accuracy drops by less than 1% during 

the loud noise exposure stage.  The implication is that one of the reasons external noise impacts 

accuracy in real-life situations is that it leads the user to pause, talk louder, or otherwise change 

his/her dictation style.  When you can’t make it go away, simply do your best in ignoring noise 

and continuing your dictation. 

 Consider the use of the most noise tolerant hardware. This includes both the microphone and 

your USB sound adapter. 

 

“… one of the reasons external noise impacts accuracy in real-life 

situations is that it leads the user to pause, talk louder, or otherwise 

change his/her dictation style.  When you can’t make it go away, 

simply do your best in ignoring noise and continuing your dictation.” 
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o In terms of microphones, if you are not already using one, consider switching to the 

Sennheiser ME3 or SpeechWare FlexyMike Dual Ear.  These are the two moist externally 

noise rejecting headsets on the market 

o Consider using the SpeechWare 

“SpeechMatic MultiAdapter” instead of 

your on-board sound card or current 

external USB sound adapter.  While 

expensive compared to others, this 

device uses very intense digital signal processing and handles external noise rejection 

better than anything else we’ve seen. 

 

 Finally, if you can deal with the logistics of the 

device, consider switching to the type of mask 

microphone used by court reporters using 

speech recognition.  These are typically called 

“speech masks” or “steno masks” and the 

process termed "voice writing".  They have a 

microphone contained within the mask and the 

entire set-up serves both to prevent your speech 

from being heard by others and preventing 

external noise from being picked up by your 

microphone.  Learn more about this type of technology by doing the following: 

 

 Search the term “steno mask” or “speech mask” online 

 Visit http://talktech.com 

 

1.   Summary:  Dealing with the high-noise environment may require a 

number of modifications in your equipment and technique, but 

don’t underestimate the potential benefit of simply ignoring the 

noise and continuing your dictation. 

http://talktech.com/
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Chapter 15:  Dragon in Non-Standard Applications 
 

Assessing Dragon Compatibility 

While Dragon works in an amazing breadth of applications and electronic health records, occasionally 

you will be in a situation in which full functionality isn’t present.  If you are working with an electronic 

health record that is implemented via Citrix or are using an EMR which uses non-standard text entry 

windows, you may have problems.   

How can you tell if Dragon isn’t fully compatible with your application?  There are two major ways: 

1. On the top of the DragonBar you will see a green check 

mark if full “text control” is present within your active 

application.  In some older versions of Dragon, this will be 

a green circle and not check-mark.  If text control is not 

present, this check mark or circle will be gray. 

2. Dragon will not behave normally.  You will notice the 

following “symptoms”: 

a. You are unable to navigate by voice and unable to 

select or correct text by voice 

b. Text will not necessarily format correctly.  Capitalization may not happen at the 

beginning of a sentence and you may see double letters appear. 

Dealing with lack of full compatibility:  Options 

Whenever possible, you should try to correct the underlying issue if possible.  If your EMR is 

implemented via Citrix and you are using DMPE2 and NOT the Network Edition of Dragon, see if your 

institution has the Network Edition available and get it.  If this isn’t an option, inquire about whether it is 

an option to get a full version of your EMR installed on your computer, rather accessing it virtually via 

Citrix.   

Assuming you are not able to swing either of the above, here are your basic options: 

1. Do your dictation in a compatible program such as DragonPad, WordPad or Microsoft Office 

Word and simply paste completed dictation into your EMR.  Although this adds the step of 

launching the extra application and copy/pasting the dictation, when you do this regularly, it’s 

not a big deal. 

2. Use the “Dictation Box”.  This is a built in “mini word processing window” that can be launched 

via voice and from which text can be easily moved back to your EMR.  See below for more 

details on the Dictation Box. 
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Dictation Box:  Essentials of Use 

 
The Dictation Box has been a part of Dragon for many years and has 

been enhanced in DMPE2.  In addition to providing a fully 

functioning environment to complete dictation if your application is 

not fully compatible, the Dictation Box can also serve as a 

repository of (dictated) information as you browse a medical 

record.  Let’s briefly look at each of these functions. 

The Dictation Box is launched simply by saying “show dictation 

box”.  Once launched and active, you can dictate using Dragon and 

can use all normal commands within the Dictation Box, including all 

punctuation, Dragon templates, etc.   

The dictation box can be used in two different modes: 

1. Anchored:  When “Anchored”, the Dictation Box is linked with the application and place from which 

it was launched.  When done with the Dictation Box you 

can either click on the “Transfer” button or say “Transfer 

Text” and the contents of the dictation box will be sent 

directly to the spot you were in when launching the 

Dictation Box.  We find this the most practical way to use 

the Dictation Box when dealing with a non-standard EMR. 

 

2. Unanchored:  In this mode, the Dictation Box is not 

anchored to a particular application or window.  In this 

mode, the only way to move contents from the Dictation 

Box to the application is to move to the place to which 

you want the contents moved and then say “Transfer 

Text”.   

 

When dictation is completed, text is transferred to where you 

want it, either by clicking “Transfer” or saying “transfer text” 

while the Dictation box is open (Anchored Mode) or by navigating to where you want the text 

transferred and then saying “transfer text” (unanchored). 

For more information on using the Dictation Box, please see the dedicated section on Promoting 

Efficiency with the Dictation Box in Part Two of this guide.  
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Chapter 16:  Controlling Your Computer with Dragon 
 

We have already shown you ways that commands can be built to accomplish some time-saving actions 

on your computer.  What you may not realize is that built into Dragon is a wealth of computer command 

and control actions that are initiated with a single voice command.  Below is a basic chart showing some 

of the basic functions built into Dragon.  For more of this, please refer to the overview of built-in 

commands in the Part Two of this guide. 

 

Function Method Example 

Verbally press any 

keyboard key or 

combination 

Say “press <key name>”,  “Press escape” 

“Press alt tab” 

Open  any Program in 

start menu or desktop 

Say Open <program name> or “Start 

<program name>” 

“Open Internet Explorer” 

Open any Document on 

Desktop 

Say “Open <document name> or “start 

<document name>” 

“Open inpatient consult 

template” 

Navigate through menus 

on any program 

Say name of menu, or menu item 

(“File”, Edit”, etc.) 

“File”, “Print”, “Okay” 

Conduct web searches 

on Google, PubMed, 

UpToDate 

Say “Search <site name> for <topic 

name>” 

“Search PubMed for pulmonary 

hypertension” 

Send Email Say “Send email to <recipient name” “Send email to George Smith” 

 

 

  
Key Point:  Dragon can do far more that create text.  When you have time, 

explore some of the computer controlling functions.  These can be great time 

savers. 
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Chapter 17:  Proofreading – is 95-99% Good Enough? 

 

The Problem 

 Why a chapter devoted to proofreading?  It’s time for a little brutal truth, and one that every Dragon 

user knows perfectly well.  For all it is an amazing technology and for all it has dramatically improved in 

performance over the years, it still isn’t perfect.  Dragon doesn’t understand content and will 

occasionally make errors.  While 99% accuracy may be the best you will achieve, in the real-life 

environment of a dictation room or hospital ward and in the context of the somewhat rushed technique 

we developed in the days when a thinking human being would put together the pieces, actual accuracy 

may be in the 95-99% range.  So this means up to 5 words out of a hundred may be wrong.  The 

question is, which words?  And will these errors meaningfully impact the intent of the dictation and the 

quality of the medical communication?   

Suggestions 

 Here are some of my own thoughts, having used Dragon for medical documentation for more than 10 

years: 

1. Proof-reading truly needs to be done, either by you or by support personnel. 

2. Although you can watch your dictation as it appears on the screen (“proofing on the fly”), this 

turns out not to be a reliable way of proof-reading unless you truly pause and read before you 

continue dictation. 

3. Proof-reading content created by speech recognition is more challenging than proofing typed 

content.  With the exception of words you have manually entered into the Dragon vocabulary, 

your text will not contain spelling errors.  Rather, the use of speech recognition technology will 

create perfectly spelled recognition errors.  Since our usual quick proofreading technique tends 

to visually scan for words that appear wrong (typically misspelled), this quick scanning technique 

will not pick up recognition errors.  The best technique for proofreading Dragon-created content 

is to truly read the text in your head, even if quickly.  Only then will you find words that are out 

of place. 

4. If you proof-read a document hours or days after you complete a dictation, you may find a 

recognition error that is so out of place and bewildering that it might not be obvious what you 

were trying to say.  The trick is to play with the sound and flow of the word or words placed in 

error by Dragon and hoping your brain will reconnect with what they should have been. 

5. Although it is tempting to simply retype misrecognitions, Dragon won’t learn anything when you 

do this and is likely to repeat the error.  Formally correct errors when you spot them.   

6. If you have a misrecognition that occurs repeatedly despite having formally corrected the error 

in the past, you have a few choices: 
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 As best you can, use extra care when enunciated the word or phrase that you tend to 

get wrong.  I find that in 90% of the cases this will solve the issue.  It’s often just sloppy 

dictation that leads to the misrecognition. 

 Create a Written form/Spoken form for the word or phrase within Dragon 

 Consider the use of a third party program such as SpeechWare’s SmarTypist, which will 

allow you to create automatic substitutions, somewhat similar to using a Spoken 

Form/Written Form within Dragon.  SmarTypist follows along as you dictate and makes 

the substitutions in real time.  In addition, it will make substitutions automatically as you 

hand-type. 

 

Below is the main window from SmarTypist, showing how the transcribed and 

oral/written forms are listed within the applications. 

 

 
 

For more information on SmarTypist, please visit our site and view Products > 

SpeechWare (http://store.speechrecsolutions.com/speechware-c39.aspx ) 

 

 

 

 

Key Point: As good as it is, Dragon is not perfect and mistakes (recognition errors) 

will happen.  Save yourself some embarrassment by having your documents 

proofread, ideally before they are immortalized in your EMR! 

 

http://store.speechrecsolutions.com/speechware-c39.aspx
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PART TWO:  Special Topics 

 
We provide this expanded section of “Special Topics”  with the hope of providing more detailed 

information about topics which may be a bit too detailed to be placed in the body of this guide and 

which are not necessarily important for most users of Dragon.   

Chapter 18:  Detailed Hardware Recommendations 
 
For the user wanting to buy the best system for use with Dragon, please review these detailed 

guidelines from Tony Fiset, our resident computer and technical expert: 

 

 Dragon is one of the few programs that can tax a modern CPU, and Nuance's system 

requirements and recommendations are woefully inadequate in our opinion. The bare minimum 

specs they list are so bad that we've seen systems that were unable to even manage the user 

adaptation process, which arguably is a core part of the software. 

 Without going into too much detail on the CPU side of things, we recommend an Intel Core i5 as 

the minimum; if an i7 is in your budget, the larger L2 cache will be beneficial. All of these will be 

dual-core models, which should be fine as long as you aren't doing much multi-tasking - Dragon 

can only use two cores anyway, so a quad-core CPU only helps if there are other programs using 

those cores. 

 Intel is currently on their third generation Core-series product, so all of the parts will have 

names with the following conventions: i7-3xxxyM, where the first part indicates the overall 

performance classification, the "3" denotes third generation (known as "Ivy Bridge"), and "M" 

signifies that it is a mobile, or laptop, CPU, versus one intended for a desktop. The "y" is an 

optional modifier, either a Q for quad-core or a U for Ultra Low Voltage (parts that sacrifice 

some performance for longer battery life). The "xxx" is the specific part, and usually indicates 

the clock frequency. But maybe that was too much detail... 

 While 4GB of RAM is the minimum you'll want, RAM is relatively cheap right now, so we 

recommend getting at least 8GB. If you're at all technically inclined, you can usually upgrade to 

8GB or 16GB for much less than it costs from the manufacturer. 

 Another nice upgrade is a solid state drive, or SSD. This won't really have much impact on 

Dragon, but will dramatically boost the overall performance and responsiveness of your system. 

 We generally recommend going with a "business class" laptop, such as a Dell Latitude, Lenovo 

ThinkPad, or HP ProBook; they tend to have fewer issues, last longer, and you often get better 

support. 
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Chapter 19:  Purchasing Microphones for Medical Providers:  Practical 

Strategies 
 

Over the years and through both our sales experience and direct observations during testing in the 

hospital and clinic environment, we have developed a good sense of what will work for your medical 

providers. We believe that the principles listed below should guide you in your hardware selection: 

 

 Most medical providers prefer not to wear their microphone. Already straddled with a 

stethoscope and a pocket-filled white coat, and needing to transition frequently between 

examination rooms and places of documentation, the last thing a doctor wants to do is 

constantly adorn his/her head with a headset microphone. While the headset tends to be the 

most inexpensive option and this makes such 

microphones attractive to those making 

purchasing decisions, they will quickly 

disappear, break, and require replacement. We 

strongly recommend that once you have 

become convinced that speech recognition will 

work for you or your institution that you 

transition away from the usual headset 

microphone and consider either a hand-held or 

desk mounted microphone. The two best 

hand-held microphones are the Nuance PowerMic II and the Philips SpeechMike Premium 

(LFH3500). 

 

 With the exception of the rare provider doing dictation in the confines of an office with a closed 

door, most medical documentation occurs in areas with a high degree of environmental noise. 

In addition to adding stress to the provider, this has the potential to negatively impact speech 

recognition accuracy. For this reason we put an emphasis on microphones with strong external 

noise rejecting characteristics. For the loudest of environments we recommend breaking our 

"no headset" rule and considering the uniquely external noise rejecting headset – either the 

Sennheiser ME3 or the SpeechWare FlexyMike Dual Ear Cardioid. 

 

 Keep in mind that these recommendations are being typed by a physician. In general, doctors 

tend to focus on their clinical responsibilities and are a little less sensitive when it comes to 

handling equipment. This is probably not news to you. So if you are buying a microphone for a 

documentation strategy which you hope will be sustained at your institution, we believe there 

will be a strong ROI on the purchase of a durably constructed product. Don't expect the $5 

microphone that came with your software to be durable and when it falls apart don't replace it 

with a similarly poorly constructed product. 
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 While convinced of the importance of medical communication, most medical providers tend to 

consider aspects of the documentation an unfortunate distraction from the more important 

face-to-face interaction with the patient and the clinical decision making. For this reason, many 

providers will not put much time into editing and correcting documentation once created. So 

unless your workflow allows for proof-reading by support staff, we strongly urge you to orient 

your speech recognition program such that it will optimize accuracy of the documentation at the 

time at which it is first created. In addition to providing the training to your providers in the 

method of dictation that is most associated with accurate results, you must provide them with 

the hardware which will facilitate this as well. 

 

 Finally, medical providers are feeling a lot of pain in the transition from paper to an electronic 

record and for this and a number of other reasons, job satisfaction isn't exactly at a high level 

these days. If you accompany your transition to speech recognition with a well thought out 

implementation strategy, organized training which includes follow-up sessions, and equip your 

providers with comfortable and well-performing equipment you will greatly improve provider 

satisfaction ... and results. 
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Chapter 20:  Detailed Microphone Recommendations: 

 
Please forgive the shameless links to products on our on-line store, but we have bills to pay, payroll to 

fund, and hopes of actually turning Speech Recognition Solutions into a viable retirement business.  Your 

business will be greatly appreciated!  What follows is the “down and dirty” on our most popular 

products and those – in our opinion – which are best suited for a medical provider. 

Philips SpeechMike Premium (LFH3500)   

Replacing the PowerMic as our 

favorite hand-held microphone and 

setting the standard in terms of 

comfort and functionality, the 

LFH3500 or “SpeechMike Premium” 

represents a huge leap in technology 

by Philips. Made for the demanding 

workflows and requirement of the 

professional, this product combines 

the best of design, ergonomics, and 

functionality. Unique to this 

microphone is a suspended electret condenser microphone element which is "decoupled" from the 

housing to offer both unprecedented accuracy and immunity from background noise, touch, and click 

noises. 

Key Features: 

 USB interface (microphone does analog to digital conversion) 

 11 programmable buttons 

 Suspended electret microphone element with high level of accuracy and external noise rejection 

 Includes Control software for both Mac and Windows users (also works beautifully with our 

generic “Octopus USB Controller” for simple integration with Dragon) 

Comments:  Although the SpeechMike Premium comes with control software to program the buttons on 

this microphone, we have found this software to be fairly difficult to use.  We prefer to control this 

microphone with Octopus USB Controller which is described in detail elsewhere in this guide.  We find 

this microphone to be highly accurate and sufficiently noise cancelling to allow use in a busy hospital 

ward. 

Approximate Price:  $335  

For more information, please visit:  http://store.speechrecsolutions.com/philips-speechmike-premium-

p101.aspx  

 

http://store.speechrecsolutions.com/philips-speechmike-premium-p101.aspx
http://store.speechrecsolutions.com/philips-speechmike-premium-p101.aspx
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Nuance PowerMic II 

Historically the PowerMic II has been considered the “doctor’s choice” when it comes to microphones.  

In addition to being highly accurate and rejecting of external noise, the PowerMic II includes 9 

programmable buttons and 

enjoys a high level of integration 

with medical versions of Dragon.  

Buttons can be programmed to 

emulate almost any Dragon 

function, to navigate through a 

note template, and to initiate 

any Dragon “command” 

including both integrated and 

user-created commands.  This is 

our best-selling hand-held 

microphone.  For additional functionality, program the keys on this microphone with Octopus USB 

Controller (see below.) 

Key Features: 

 High accuracy and excellent noise canceling properties 

 Programmable buttons with high level of integration with Dragon medical versions 

 USB interface with PC  

 No need for drivers and compatible with Windows XP, Vista, 7 and 8 

 Optionally works well with Octopus USB Controller (generic control software) to work with any 

PC and all versions of Dragon 

Comments:  Over the years we have truly enjoyed this microphone, although for our personal use 

switched to the Philips SpeechMike Premium (see above) for reasons of ergonomics.  Either of these 

two microphones are great choices.  Both are most easily eased and programmed with Octopus USB 

Controller.  The one downside of the PowerMic II is the very long cord.  Realistically it needs to be 

coiled up to keep it out of the way.  We have heard quiet talk about a “PowerMic III” with an optional 

short cord, but at this point only in the form of rumors. 

Price:  $424  

 

For more information, please visit http://store.speechrecsolutions.com/dictaphone-c104.aspx   

 

SpeechWare TableMike 

 
For the medical provider doing the majority of dictation at a fixed location and preferring not to wear or 

hold a microphone, any one of the TableMikes from SpeechWare is an excellent choice.  Differing in 

http://store.speechrecsolutions.com/dictaphone-c104.aspx
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some peripheral characteristics such as boom length, presence of speaker, and availability of accessory 

ports, all share the same highly accurate microphone element and unique circuitry which allows 

operation in two modes.  In the green or distant mode, this microphone can be used at distances from 

10 to 20 inches with automatic adjustment in the 

microphone gain as distances change.  This flexibility 

in terms of dictation distance makes them 

particularly convenient and appreciated by medical 

providers.  In the near or blue mode, this product is 

intended for close range (3-4 inches) and provides 

exceptional accuracy.   

These are our biggest sellers to hospitals and 

medical providers. They are particularly popular 

among pathologists.  Because this product is used 

with a significant distance between the user’s mouth 

and microphone boom, they are easily shared 

without concern about hygiene.  Several accessories 

for this series of products are available, including a 

foot pedal, extra length booms, bracket for wall-

mounting, and spare foam windscreens.  Each of the 

TableMikes includes free access to a version of 

Octopus USB Controller (“TableMike Configuration 

Utility”) to allow programming of the volume 

up/down buttons to activate a variety of Windows and Dragon functions. 

Features common to all TableMikes: 

 Extremely high quality microphone element which contributes to high levels of accuracy during 

use with Dragon NaturallySpeaking 

 Equalizer (auto-gain) technology to allow practical use between 10-20 inches from the 

microphone element (only when in “Green Mode”) 

 Advanced digital signal processing (DSP) to reject external noise 

 Mute switch 

 Ability to choose between  “Normal” (highest accuracy) and “Distance” (highest distance 

flexibility) modes 

 Availability of free “TableMike Config” software that allows programming of the volume up and 

volume down buttons for a variety of functions 

 Durable construction 

 1-year warranty which is extended to 2-years with product registration 
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3-in-1 TableMike 6-in-1 TableMike 9-in-1 TableMike 

    

 
Features: 

 All the features listed 
above 

 15 inch boom 
 

 
All features of 3-in-1 plus: 

 Speaker included in 

base  
 Longer (21 Inch) boom 

with two points of 
articulation  

 Jack for optional foot 

pedal  
 Accessory USB port  

 
All features of 3-in-1 & 6-in-1  

 Longest boom in 
industry (telescopes 

between 21 and 25.5 
inch)  

 Two accessory USB 

ports  

 Card reader  

 

Price:  $279 Price: $329 Price: $379 

 

Comments:  These are clearly the best desktop microphones available for use with Dragon and are 

notably more accurate than similar products manufactured by Buddy and Audix.  We recommend use of 

a desktop microphone in situations in which you neither want to hold or wear your microphone.  Each of 

the three models in this microphone series employ the same microphone element and circuitry, so you 

can expect the same results with each.  The differences in the three microphones pertain to the length 

of the boom, the presence of a speaker, and additional functionalities as detailed in the table above.  

We do not propose that this has quite the accuracy or noise rejection of closely worn headset 

microphone, but it is unique in allow dictation from distances of 10-20 inches from the microphone 

element and does so with remarkable accuracy 

For more information on the TableMike series please visit 

http://store.speechrecsolutions.com/speechware-c39.aspx   

http://store.speechrecsolutions.com/speechware-c39.aspx
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SpeechWare TravelMike 

 

The latest release from our partner in Brussels, SpeechWare, this is an exciting new product which 

includes all of the unique functionality of the larger TableMike series of microphones, but in a small 

form that allows portability.  This is an ideal solution for the 

medical provider that is mobile, either moving and working 

throughout the hospital, or going from office to office.  This 

microphone was released in September of 2013 and has been 

selling as fast as we can get them.   It plugs directly into a side USB 

port and can be used with an optional base if desired.  It includes 

the ability to toggle between a short-range mode which emphasizes 

external noise rejection, or a long-range mode which allows use 

from 10-20 inches from the tip of the microphone boom and which 

provides maximum flexibility for users. 

Key Features: 

 High level of accuracy and external noise rejection when 

used with Dragon 

 Working range of 10 to 20 inches from microphone 

element 

 USB interface 

 Highly convenient since neither held nor worn 

Comments:  this is a truly unique product and designed for the notebook computer user that doesn’t 

want to hold or wear a microphone.  It enjoys essentially identical circuitry used in the full size 

TableMikes described above.  As with the TableMikes, we do not propose that this has quite the 

accuracy or noise rejection of closely worn headset microphone, but it is unique in allow dictation from 

distances of 10-20 inches from the microphone element. 

Average Price:  $259  

 

For more information please visit http://store.speechrecsolutions.com/speechware-travelmike-

p144.aspx  

 

Sennheiser ME3 

For the serious speech recognition user and especially the medical provider working in a loud 

environment, the ME3 truly sets the standard when it comes to accuracy and external noise rejection.  

http://store.speechrecsolutions.com/speechware-travelmike-p144.aspx
http://store.speechrecsolutions.com/speechware-travelmike-p144.aspx
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This is Speech Recognition Solutions’ best-selling headset and is truly the microphone to which others 

are compared when 

considering performance.  

Rather than mounting over the 

head, the headband on this 

microphone wraps around the 

back of the user’s head and 

includes no speakers.  Absent 

the speakers, it allows for full 

situational awareness and easy 

use of the phone when needed.  We bundle this product with a small external USB adapter (Andrea Pure 

Audio MA) because it is incompatible with an occasional computer sound card and the USB adapter 

assures predictably great operation.  This is the favorite of the Emergency Department physician and 

hospitalist working in particularly loud environments. 

Features: 

 The most accurate and external noise rejecting microphones for speech recognition users 

 Highly durable and with 2-year Sennheiser warranty 

 Bundled with Andrea Pure Audio USB adapter so has USB interface 

Comments:  The ME has long been considered the best microphone for use with Dragon, both due to its 

accuracy and extraordinary external noise rejection.  The Sennheiser ME3 shown above and sold 

through Speech Recognition Solutions (both on our own website and through Amazon) is not the same 

version of the ME3 sold through large music resellers  We have this model manufactured for us by 

Sennheiser and it includes two important differences when compared to the ME3 sold elsewhere:  1) it 

includes a standard 3.5 mm plug rather than the plug with a locking ring (which prevents full insertion 

into sound cards) and 2) it comes with an 8 ft. cord rather than the 5 ft. cord in units sold elsewhere. 

One final point:  while this product is bundled with a “head strap” which attaches with Velcro, this strap 

really serves no function and should be scrapped. 

 

Unit Price:  $198 (includes ME3, Andrea Pure Audio USB adapter, and nylon storage bag) 

For more information, please visit: http://store.speechrecsolutions.com/sennheiser-c48.aspx  

 

SpeechWare FlexyMike Dual Ear Cardioid (FMKDEC) 

This is the latest in a series of “FlexyMikes” from SpeechWare and is unique in including a full size, high 

quality and directional microphone element.  While the previous (non-directional) FlexyMikes provided 

good performance, this unit provides truly exceptional performance, every bit on par with our long-term 

favorite, the Sennheiser ME3. 

http://store.speechrecsolutions.com/sennheiser-c48.aspx
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Features:   

 Highly unidirectional microphone element for effective external noise rejection 

 Extremely lightweight (25 gm) 

stainless steel construction 

 Includes both 40 inch and 80 inch 

cables for both laptop and desktop 

users 

 Includes both cable clip and storage 

case 

Note:  a new version of this microphone is 

shipping in March of 2015 and includes the 

addition of an “ear bud” to allow provision 

of sound the to the user.  We consider this a 

nice addition and provides a bit of functionality not seen in the Sennheiser ME3. 

Price: $189 (Consider buying combination with either SpeechWare MultiAdapter or Andrea Pure Audio 

MA USB adapter.) 

For more information, please visit:  http://store.speechrecsolutions.com/speechware-flexymike-de-

cardioid-microphone-p213.aspx  

 

SpeechWare FlexyMike Single Ear Cardioid 

Although this microphone is being released just as this 

guide is preparing for publication, we have seen 

enough of it to know it is a serious product and 

worthy of some attention.  Similar in some respects to 

the “FlexyMike Dual Ear Cardioid” described above, 

this new product combines a unique, highly sensitive 

and directional microphone element and a lightweight 

single-ear mounting system that makes it a perfect 

choice for the user wanting something extremely 

lightweight and low profile and yet still needing the 

high quality results when using it with Dragon.   

Features Include: 

 Newly designed highly directional cardioid microphone capsule 

 “S-shape” ear hook design with silicon protector for more stability and working comfort 

 Lightest and most comfy single-ear for many hours of dictation 

http://store.speechrecsolutions.com/speechware-flexymike-de-cardioid-microphone-p213.aspx
http://store.speechrecsolutions.com/speechware-flexymike-de-cardioid-microphone-p213.aspx
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 Very flexible boom 

 Short 1.5 m fixed cable for Notebook 

 Long 2.5 m cable extension 

 Plastic box for easy storage and transport 

 Spare windshield 

Price: $149  

For more information, please see this product on our site at:  

http://store.speechrecsolutions.com/speechware-flexymike-single-ear-cardioid-microphone-p261.aspx  

 

Sennheiser MB Pro 1 UC and Pro 2 UC 

 

This new release from Sennheiser fills a 

wonderful niche:   a high-quality wireless 

headset microphone which is accurate with 

Dragon, simple to use, comfortable and 

durable.  Unlike any other wireless 

microphone this product really does it all for 

the user preferring a headset and wanting to 

be untethered.  Specific features which will 

be of interest to you: 

 Ultra noise cancelling microphone 

element at end of full length boom 

 Large, comfortable leatherette ear 

cushion(s) 

 One and two speaker varieties (single 

speaker version shown here) 

 15 hour talk time (all day use) 

 25 meter (82 ft.) range 

 Works with both pre-paired nano-dongle and will connect to Bluetooth phone 

 Multi connectivity - to seamlessly manage PC and mobile phone calls from a single headset for 

maximum call-handling flexibility 

Price:  $189 (Pro 1 UC) and $199 (Pro 2 UC) 

For more information, please visit these links: 

http://store.speechrecsolutions.com/sennheiser-mb-pro-1-uc-p252.aspx 

http://store.speechrecsolutions.com/sennheiser-mb-pro-2-uc-p253.aspx  

http://store.speechrecsolutions.com/speechware-flexymike-single-ear-cardioid-microphone-p261.aspx
http://store.speechrecsolutions.com/sennheiser-mb-pro-1-uc-p252.aspx
http://store.speechrecsolutions.com/sennheiser-mb-pro-2-uc-p253.aspx
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VXI TalkPro VoxStar UC 

For the user wanting a wireless microphone, we highly recommend that you consider the VXI VoxStar 

UC.  This is a wireless microphone which uses Bluetooth frequencies but which does not require 

interaction with the Bluetooth drivers on your PC.  It is pre-pared with a tiny USB dongle which works in 

a “plug and play” manner.  Aside from the simplicity in setting up and using this microphone, it works 

beautifully with Dragon on your Mac or Window machine and will also work with your cell phone or 

internet phone application. 

Features: 

 Advanced noise-canceling and Xtreme Noise Suppression 
technologies block ringing of phone and other environmental 
noise contamination 

 High-quality audio receiver with a wide volume adjustment range 
provides crystal-clear conversations even in the noisiest 
environments 

 Bluetooth technology provides wireless connectivity with a 
functional range of up to 66 feet 

 128-bit encryption offers safe, secure and private conversations. 
 Multipoint Connection allows you to easily connect to and switch 

between two Bluetooth devices (such as another mobile phone 
or laptop computer) 

 One-touch multifunction button for power on/off, call 
answer/end, voice dial, call waiting and pairing commands 

 Comes with multiple wearing styles in each package: over-the-
ear, over-the-head and behind-the-neck 

 One-year warranty 
 
Comments:  Although the picture shows only the ear mounting method 
for this microphone, keep in mind that it actually comes with three 
mounting styles: 1) ear mounting 2) around the back of the head 
mounting, and 3) traditional over-the-head mounting.  Of the three, we 
consider the traditional headset mounting as the most comfortable.  The ear mounting method is a bit 
flimsy and the behind the head method fairly stiff. 
 
Price:  $159 
 
For more information, please visit:  http://store.speechrecsolutions.com/vxi-voxstar-uc-bluetooth-

microphone-p189.aspx  

  

http://store.speechrecsolutions.com/vxi-voxstar-uc-bluetooth-microphone-p189.aspx
http://store.speechrecsolutions.com/vxi-voxstar-uc-bluetooth-microphone-p189.aspx
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Chapter 21:  Octopus USB Controller 

 
We believe that Octopus USB Controller is a sufficiently essential adjunct 

for users of speech recognition technology (and for all Windows computer 

users) that it warrants special attention in this guide.  It is, in our opinion, a 

remarkable software utility.  For both the hand-held microphone user and 

user of any USB Human Interface Devices (HID), this Windows-based 

controlling utility can program any button, key or lever on most devices to 

perform a variety of actions, including: 

 Inserting boilerplate text 

 Emulating keystrokes or keystroke combinations 

 Initiating Dragon commands 

 Emulating Dragon hotkeys 

 Launching applications, documents,  folders and web sites 

 Initiating a number of Windows functions 

 Combining any of the above into sequential scripts 

 Advanced functions which allow setting separate behavior for a key or button depression and 

release 

In addition to the above, OUC adds three entirely new features to Dragon, including the following: 

1.  Addition of a large “microphone 

status indicator” which can be placed 

anywhere on the screen, sized 

variably and set to a variety of 

transparency levels. 

2. Addition of “field navigation” 

behavior to non-medical versions of 

Dragon (ability to move sequentially 

through fields defined by square 

braces ([ ]) ) 

3. The ability to play a system beep 

when the microphone is activated or 

put to sleep. 

 

From an institutional perspective, the beauty of this software utility is the ability to interface with 

virtually any commonly sold USB HID hardware (including hand-held microphones, keypads, and foot-

pedals), simple sharing of device configuration profiles, and the ability to simultaneously control 

multiple devices.  
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Overview of Features 

 Compatible with all recent Windows operating systems 

 Works with a long list of existing hand-held microphones, USB foot pedals and external keypads; 

configurable with most other USB devices on the fly 

 Simultaneous control of multiple devices 

 Easily exportable and transferrable device configuration profiles 

A few key screenshots: 

Main Programming windows showing variety of available categories of commands 

 

Sample PowerMic II programming Sampe USB Keypad Programming 

  
 

Price:  $69.99 for single copy (may be installed on two computers and includes updates and support for 

2 years) 

For more information, please visit:  http://store.speechrecsolutions.com/octopus-usb-controller-

p164.aspx   

  

http://store.speechrecsolutions.com/octopus-usb-controller-p164.aspx
http://store.speechrecsolutions.com/octopus-usb-controller-p164.aspx
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Chapter 22:  Microphone Set-up and Troubleshooting Guide 
 

Contents: 

 Setting Up a New Microphone 

 Troubleshooting a microphone associated with poor accuracy 

 Troubleshooting a Microphone not working at all 

Setting up a New Microphone 

Overview:   

Before setting up a new microphone it is critical to understand a few basic requirements in order for 

your microphone to work properly with Dragon: 

1. The microphone must be attached and un-muted 

2. The sound system to which your microphone is attached (either the on-board sound card or a 

separate external USB sound adapter) must be recognized by your computer operating system. 

3. Dragon must be set up to look for sound from the sound device to which your microphone is 

attached. 

4. Dragon must undergo the necessary microphone sound adjustment (audio set-up wizard)  

With the above principles in mind, it is not always possible and generally not recommended that you 

simply replace one microphone with another, with the one exception of replacing your old microphone 

with a new version of the exact same microphone. Remember that microphones differ in their 

sensitivity, acoustic properties, and means of integrating with your computer.  Also keep in mind that 

Dragon will always start-up looking for sound from the last sound source it used (either the on-board 

sound card or a sound device attached via USB or Bluetooth).  

There are certain principles that should be followed when changing microphones: 

1. If you were previously using an analog microphone plugged into your computer microphone 

input jack and are now switching to a USB microphone, microphone attaching using an external 

USB sound adapter, or a Bluetooth microphone, you will always need to formally direct Dragon 

to this new sound device, either by adding a new “source” (see below) or creating a new user 

profile. 

2. If you are maintaining the same sound source - either on-board sound card or external USB 

sound adapter – you don’t necessarily have to create a new source or new user profile, but do 

need to recalibrate the audio within Dragon using the “Audio set-up wizard” or “check audio” 

functionality. 
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Running the Audio Set-up Wizard:  This method should be employed only if you are switching from one 

analog microphone to another and you are NOT switching sound sources or switching to a USB or 

Bluetooth interfacing microphone.  In this scenario you simply plug in the microphone, start Dragon, and 

then run the audio set-up wizard.   

How do you run the audio set-up wizard?  If the microphone is attached and Dragon running, the 

simplest way is simply to say “Check Audio”.  Alternatively, on the Dragon toolbar, go to Tools > 

Accuracy Center > Check My Audio Settings and follow the instructions.  The advantage of this is 

simplicity.  When moving from one wired microphone to another (especially when moving to a more 

accurate microphone) this is often adequate.   If you are changing the type of microphone (i.e. moving 

from a wired to a wireless microphone or vice versa, switching from a simple microphone [3.5 mm 

plugs] to a USB microphone, or switching to or from a Bluetooth microphone) this simple method is not 

advisable.   

Adding a New “Source” to an Existing User Profile:  This method is advised if you are switching from use 

of an analog microphone plugged into your on-board sound card to any other microphone interfacing 

method (USB microphone, microphone plugged into a new external USB adapter, or a Bluetooth mic).  

Adding a new “source” to an existing user profile has the effect of maintaining the entirety of your old 

profile (with the exception of your microphone settings), including all of your customized training, 

acoustic information, customized words and commands, and yet tailoring it to the new microphone.  In 

order to complete this process you must do the mandatory 5-6 minutes of reading (exception:  Dragon 

13).  In essence it simply spends some time listening to how you sound with the new microphone 

source.  After creating this added source, you will have the choice of using this new source or your old 

source to use each time you open Dragon.   

The beauty of this method is that you can have multiple “sources” on the same user profile.  You might 

for instance, sometimes use a Bluetooth microphone, sometimes a hand-held USB microphone, and 

sometimes a file from a digital recorder.  When having multiple sources for the same user profile if you 

add words, commands or make other changes to the profile, these will be retained when you open the 

user profile with any of the sound sources. 

How do you add a new source?  Simply follow this procedure from the Dragon toolbar: 

Dragon 13: 

1.  Go to Profile > Manage Dictation Sources 

2. From the “Manage Dictation Sources” window select your new audio source 

Key Point:  When upgrading to a new microphone you should NEVER expect to 

simply substitute the new mic for the old one.  Dragon needs to be informed of 

the new source and ideally undergoing a bit of training with the new microphone. 
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3. Click “Add New Dictation Source” 

4. Follow ensuing steps 

Dragon 12 (DMPE2) or Equivalent 

1. Go to the Profile menu and select “Add dictation source 

to the current User Profile …” 

2. On the next screen select the appropriate type of sound 

source from the drop-down menu 

3. On the next screen select the actual sound source 

4. Follow all subsequent instructions 

Dragon 11 and earlier 

1.  If the sound source Dragon was expecting is not available upon opening, you will be presented 

with the “Open User” profile. 

2. If Dragon is already open, Select Profile  > Open User Profile … 

3. On the far right of the Open User dialog, 

click on “Source” and then “New” (Don’t 

click on the separate “New …” button 

shown on the image to the right. 

4. Select the new source from those listed 

and following the usual steps to complete 

the training for the new source. 

5. If you want to delete your old source 

(doing so will prevent it from showing up 

for potential selection each time you 

open Dragon), simply go to Dragon > 

Open User and select the old profile.  Then click on “Source” and then “Delete”. 

Creating an Entirely New User Profile:  Although there is nothing wrong with creating an new profile for 

a new microphone, we consider this the least preferred method, since the new profile will not take 

advantage of personalized words and commands in your old profile (without manually moving them 

over.) We recommend this only if you have an existing profile which is either extremely new (you 

haven’t invested much in the way of words or commands into it) or extremely old (AND suspected to be 

somewhat corrupted).   

 

Here are instructions for creating a new user profile from scratch. 

1.  Export any words and commands from your old profile so you can import them into your new 

profile once created. 
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a. Export your old words from the Dragon toolbar by going to Words > Export.  Save your 

words to a location that you will 

remember. 

b. Export you commands by opening the 

Command Browser (Tools > 

Command Browser).  Under the 

Mode menu, select “Manage”.  Click 

the box next to the command 

category you want to export and then 

click on Export on the left menu 

2. From the Dragon toolbar select Dragon and 

Manage User (In Dragon 12 you will select 

“Manage User Profiles and will see the same window shown above). 

3. Select New (see image above) 

4. Follow the subsequent steps, being sure to select the new microphone or device as your audio 

source. 

Troubleshooting a Working Microphone with Loss of Accuracy 

Less than ideal results is a common scenario and may or may not be the result of a dysfunctional 

microphone.  Keep in mind that accuracy is dependent upon many factors and the most important of 

these is your dictation style.  In this situation we recommend a sequential approach, as follows: 

1. First, rule out obvious audio issues by listening to a recording of your speech.  There are many 

ways to do this but simplest method is to dictate some text and then use Dragon’s playback 

functionality to hear your speech.  This is done by selecting some or all of the text you dictated 

and then issuing the command “Play that”.  You will hear your dictation replayed, in your own 

voice, and get a sense of the audio quality. Listen to the recording to be sure it sounds clear and 

that there are no word cut-outs, static or other interfering sounds.  If so, you likely have a 

mechanical problem related to the microphone, sound card or, in the case of a wireless 

microphone, your wireless connection.  If the sound seems clean, then proceed to the next step. 

2.  Run the audio set-up wizard.  This takes just a couple of minutes and resets your microphone 

gain and also provides a crude check of your system integrity by means of providing a speech to 

noise ratio.  The audio set-up wizard can be access either by saying “check audio” or manually 

by going to Tools > Accuracy Center > Check My Audio Settings.  Depending upon which version 

of Dragon you are using, you may simply get a “check mark” if the audio was acceptable (Dragon 

13), a “Pass” indication (Dragon 11 and 12), or a specific speech to noise ratio indication (Dragon 

10 and earlier - anything between 15 and 25 indicates your system is probably OK.)   

3. If you are using a laptop computer, it likely has an on-board microphone.  If you are using a 

microphone plugged into the sound/microphone jacks, it is possible that Dragon is using the on-

board microphone and not the one you have plugged in.  You should manually disable the on-

board microphone and this will likely resolve your issue.  Alternatively, use a USB interface for 



 

73 
Copyright 2015 Speech Recognition Solutions, LLC.  

www.SpeechRecSolutions.com 

your microphone (external USB sound adapter).  These are inexpensive devices that substitute 

for your on-board sound card. 

4. If the above did not help, we suggest that you devote extra attention to your dictation style.  

Keys to optimal dictation are the following: 

 Enunciate clearly  

 Speak in a smooth manner, neither overly slowly or excessively rapidly. Speak in either 
sentences or phrases. Recognition is worst when speaking one word at a time.  

 Maintain a relatively consistent pitch and tone when dictating  

5.  Consider switching to a USB microphone or use your current microphone with an external USB 

adapter.  This may be particularly helpful if you are using a laptop computer.  The external USB 

adapter substitutes for your internal sound card and offers the possibility of removing internal 

electrical interference which may be negatively impacting your accuracy. 

 

6. Consider upgrading to a higher quality microphone.  Be aware that the microphone that came 

with your version of Dragon cost Nuance about $10 or less.  There are many better microphones 

that offer better accuracy and rejection of external noise. 

Troubleshooting a Microphone Not Working at All 

This is a rare situation, but one which leads to great frustration.  Keep in mind that Dragon will only use 

a microphone that is being recognized by the operating system and one that is using a sound source you 

have directed Dragon to use.  So after visually inspecting the microphone to rule out obvious mechanical 

issues, you should take steps to assure that the operating system and Dragon are recognizing the 

microphone.  If your microphone is not working at all and it is a new microphone, the problem likely 

relates to the fact that you did not tell Dragon to use the new microphone (especially when switching 

from an analog to digital USB microphone). 

 

 

 

Here is our basic protocol: 

1.  Visually inspect the microphone and cord (and external sound device if being used) to be sure 

there is no evidence of damage to the wire. 

2. Be sure your microphone doesn’t have a mute switch.  If so, be sure that the muting function is 

not activated 

3. If you are using a USB adapter, be sure that it doesn’t have a mute switch, and if it does, be sure 

the sound is not being muted. 

Key Point:  When a new microphone isn’t working at all, it’s most likely a result of 

Dragon looking for sound in the wrong place.  In this situation, follow the 

instructions on setting up a new microphone earlier in this guide. 
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4. If possible, use the microphone with another application, either on your current computer or 

another to assess its integrity in another environment.  For instance, try your microphone with 

Skype or another audio application which uses a microphone. 

5. Confirm that your operating system is sensing the microphone: 

 Windows 8:  Go to Control Panel > Sound > Recording tab.  You should see you microphone 

and when talking, you see green deflections in the sound magnitude scale.  If you search 

“sound recorder” on Windows 8 it will launch a sound recorder which can be used to record 

a sample recording for use in assessing microphone sound quality. 

 Windows 7 & Vista:   Go to your Control Panel > Hardware and Sound > Sound, and click on 

the recording tab.   You should see your microphone.  When talking, you should see 

deflections in the green sound magnitude scale. 

 Windows XP:  Confirming a microphone is more difficult in XP than in 7.  Often, the simplest 

method is to try a sample sound recording.  This is done as follows: 

i. Click on Start > All Programs > Accessories > Entertainment > Sound Recorder 

ii. On the sound recorder Edit menu, select Audio Properties 

iii. Under the Sound Recording section, 

be sure your sound device is 

correctly chosen (select your on-

board sound card if using a 

microphone plugged into the mic 

and sound jacks; if using a USB 

microphone or device, select the 

name corresponding to the device – many USB sound adapters show up as 

AK5370 in windows XP) 

iv. Make a sample recording by clicking on the record button.  If audio is being 

recorded you will see deviations in the green signal line in the center of the 

recording. 

v. Hit the rewind button to bring you back to the beginning of the recording 

vi. Hit the play button and listen to the recording 

 

6. If you are using a laptop and have a microphone plugged into the sound-out and microphone 

jacks, it should be disabling the on-board microphone, but there are many examples of this not 

being the case.  It is possible that Dragon is taking the sound signal from the on-board 

microphone and not the microphone you have plugged in.  In this case you should attempt 

manually disable the on-board microphone.  This method varies from machine to machine and 

may not be possible.  As a last resort (but nonetheless an excellent solution), get yourself an 

external USB sound adapter and do away with the problem.  Dragon will be directed to take it 

sound signal from the USB device into which you microphone is plugged and the on-board 
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microphone will no longer harass you! 

 

7. If you are plugging your microphone into the sound and microphone jacks on your computer, 

confirm that you have these properly selected.  In general the sound jack is marked in green and 

the microphone jack in pink or red.  If you have more than one set of jacks (front and rear), try 

plugging the microphone into the other set.  If you know your microphone is otherwise working 

but not with your PC, consider the route of using an external USB sound adapter.  

  

Summary:  Adding a new microphone, particularly when it uses a 

new sound source (USB or Bluetooth) requires that you properly 

configure Dragon for this new source.  Troubleshooting a poorly or 

non-functioning microphone requires a sequential approach. 
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Chapter 23:  SpeechMike Premium: Use and Programming 
 

Introduction 

The SpeechMike premium is our best-selling hand-held microphone 

and truly sets the standard in terms of comfort and functionality.  It 

also represents a huge leap in technology by Philips. Made for the 

demanding workflows and requirement of the professional, this 

product combines the best of design, ergonomics, and functionality. 

Unique to this microphone is a suspended electret condenser 

microphone element which is "decoupled" from the housing to offer 

both unprecedented accuracy and immunity from background noise, 

touch, and click noises. 

Key Features: 

 USB interface (microphone does analog to digital conversion) 

 11 programmable buttons 

 Suspended electret microphone element with high level of 

accuracy and external noise rejection 

 Includes Control software for both Mac and Windows users 

(also works beautifully with our generic “Octopus USB Controller” for simple integration with 

Dragon) 

 

Installing the “Device Control Center” Software 

Before attempting to use the SpeechMike Premium, you should install the “Device Control Center” 

software.  This software utility allows you to control the behavior of the SpeechMike, program the 

buttons, and is also the means by which device firmware upgrades are accomplished.  Later in this guide 

you will see screen shots and learn more about using the device control software.  The software is 

included on the disk which comes with the microphone. 

Below we detail the set-up process when using the SpeechMike premium on a Windows-based 

computer: 

1. Plug the USB end into any available USB port on your computer. If you are using a desktop 

computer, be sure to use a rear USB ports.  We recommend against using a USB splitter or 

powered hub.  Once inserted, drivers will be automatically installed by your operating system. 

2. Insert the Philips CD included with the microphone into the CD/DVD drive. If the Philips Device 

Control Center install doesn’t appear, browse the CD and launch the installer by double clicking 

on the icon called PhilipsDeviceControlCenter. 
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3. Follow all remaining installation steps (all very intuitive). 

 

Completing Initial Set-up with Dragon 

If you are new to Dragon and using the SpeechMike Premium as your first microphone when setting up 

your first user profile, there is nothing for you to do but select “USB microphone” as your sound source 

when creating your user profile and then “SpeechMike Premium” in the next step.  You can skip the rest 

of this section.   

For those switching from another microphone to the SpeechMike Premium, it is essential that you 

follow a few keys steps to assure that Dragon knows you have switched to the SpeechMike Premium 

and uses it as the preferred sound source.  There are three ways you can integrate this microphone and 

we recommend the first of these three methods: 

1. Add the SpeechMike Premium as a new sound “source” to your existing Dragon user profile 

(recommended) The advantage of this method is that it creates a separate version of your old 

profile, based on the sound characteristic of the new microphone, but with all of the 

personalized words and commands shared between the two (or more) versions of your profile. 

2. Run the audio set-up wizard and, in effect, simply substitute the SpeechMike premium for your 

old microphone 

3. Create a new user profile based on the SpeechMike  

The manner in which any of the above methods is accomplished depends upon the version of Dragon 

you are using.  Below we show the method employed in Dragon 13 and 12 when setting up the 

SpeechMike Premium as a new sound source on your existing profile.   

 

Add the SpeechMike Premium as a new “Source” to an Existing User Profile 

Dragon 13 Dragon 12 

1. Go to Profile > Manage Dictation 

Sources 

2. From the Manage Dictation Sources 

window select your new audio source 

(SpeechMike Premium) 

3. Click “Add New Dictation Source” 

4. Follow subsequent steps 

 

1. Go to the Profile menu and select “Add 

dictation source to the current User 

Profile …” 

2. On the next screen select the 

appropriate type of sound source from 

the drop-down menu 

3. On the next screen select the actual 

sound source 

4. Follow all subsequent instructions 

 

 



 

78 
Copyright 2015 Speech Recognition Solutions, LLC.  

www.SpeechRecSolutions.com 

Button Programming:  Two Options 

The Philips SpeechMike Premium (and other Philips mics) can be programmed to control functions 

within Dragon and other applications using two methods:  1) using the Philips “Device Control” software 

that comes with the microphone and 2) using the SpeechWare Octopus USB Controller software which 

must be purchased separately.   

 Philips Device Control software:  The advantage of the Philips Device Control software is that it 

comes with your hardware and is available at no additional cost.  The disadvantage 

is that it is fairly cumbersome, unintuitive, and somewhat slower in controlling 

Dragon functions.  Even if you decide to use Octopus USB Controller to program 

your SpeechMike, you’ll want to launch the Device Control software once in a 

while to upgrade the firmware or make changes in the device configuration. 

 

 Octopus USB Controller (OUC):  OUC costs $69.99 but is dramatically simpler and intuitive to 

use.  We have found that button release functions – such as turning the 

microphone off with a button release – work with significantly less delay 

using OUC.  This is our preferred method of controlling the SpeechMike.  Be 

aware that you can download a fully functioning version of OUC and use it 5 

times before needing to purchase an activation code.  The only downside of 

OUC is that it does not provide the means to upgrade the firmware on the 

SpeechMike Premium.  For this you will need to use the Device Control 

Software. 

This guide focuses entirely on using the Philips Device Control software.  For more information on 

Octopus USB Controller, please visit:  http://store.speechrecsolutions.com/octopus-usb-controller-

p164.aspx  To download a fully functioning version of Octopus USB Controller to try, please visit:  

http://speechware.be/downloads/OctopusUSBController1_42InstallerSpeechRecSolutions.zip  

 

Customizing SpeechMike Keys and Settings 

A variety of basic and advanced features of the SpeechMike Premium can be programmed using the 

Device Control Center.  Once opened, you will see that general properties of the device are programmed 

from the “Device” tab and that you will have both Basic and Advanced 

options which can be set.  For more information on these functions, 

please refer to the help menu available directly from the Philips Device 

Control Center by clicking on the “?” icon (shown on image to the right).  

The key steps in programming the device are as simple as this: 

1. Alter the parameter you wish to change on either the Basic or Advanced tab 

2. Click on the “Upload” button to transfer these changes to the device 
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For more information on these functions, please refer to the help menu available directly from the 

Philips Device Control Center by clicking on the “?” icon. 

 

Key Programming:  General Options 

Using the Philips OEM software it is possible to program a variety of functions to a key depression, 

release, or device key combination, including the following.   

 Hotkey:  Sends a specified hotkey with the optional modifier (Shift, Control, Alt) to the target 

application with one single button event to execute the needed actions (for example, to reach a 

menu item or change the screen resolution). 

 Text: Sends a specified text to the target application by pressing the selected button on the 

active device. 

 Start Application: Starts the target application with one single button event after specifying the 

executable file of the application and its start mode, which can be one of the following: Normal 

(normal window size), minimized (application is started as a taskbar button) and maximized 

(application is started in a maximized window) 

 Mouse button: Sends mouse button pressed events to the target application with just one 

mouse click. 
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 Dragon NaturallySpeaking command: Executes the selected Dragon NaturallySpeaking 

command by clicking the specified button on the active device. Here you are also enabled to 

specify your own commands by selecting User command and entering the command into the 

text field. 

 Delay: Suspends the execution of a command for the specified time.  Note: The specified time 

must be between 10 and 30000 milliseconds. 

In addition to each of the individual options listed above, it is possible to assign a series of steps into a 

script which includes several steps in sequence and which is initiated with a single button push. 

Regardless of your intended use, the key steps in programming a button on the SpeechMike are these: 

1. From the Application Control tab, select the Target Application Profile (usually “default ..”) 
2. In the list of buttons, navigate as needed to the button you wish to program 
3. Click on the gray box to the right of either the pressed or released section for your desired 

button – the Edit Operation window will appear 
4. Delete any unwanted behavior by selecting it and clicking on the “delete” button 
5. Click on the “Add” button to assign a new behavior to the button event 
6. Select the desired behavior  
7. If necessary add any specifics 
8. Upload the settings to the active device by clicking the Upload menu item. 

Programming Keys for Interaction with Dragon NaturallySpeaking 

Specific Dragon-related functions, hot-keys or commands which can be programmed to any button are 

listed below.  When “User Command” is selected you are given the subsequent option of adding the text 

used to verbally initiate your command 

 Microphone on 

 Toggle Microphone 

 Microphone off and stop 

 Play from cursor 

 Playback toggle 

 Create new command 

 New word 

 Train word 

 Move cursor backward 

 Move cursor forward 

 Select words backward 

 Select words forward 

 Show collection menu or dialog 

 Show Dictation Box 

 

 Capitalize that 

 Compound words 

 Transcribe recording 

 Transfer 

 Tab forward 

 Next field 

 Previous field 

 Clear delimiting characters 

 Switch to normal mode 

 Switch to dictation mode 

 Switch to command mode 

 Switch to number mode 

 Switch to spell mode 

 User Command 
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Refer to the diagram below and steps which follow in order to assign a Dragon NaturallySpeaking 

function to a button push or button release on a Philips SpeechMike.  A similar process is used for 

assigning non-Dragon functions to a key. 

 

 

Detailed Key Programming steps (use with Dragon) 

1. Be sure your USB microphone is attached to your computer and the Philips Device Control 

software installed. 

2. Open the Philips Device Control Center software 

3. Be sure your device is listed and selected in the area at top named “Active Device” (see image 

below) 

 

 
 

4. Select the “Application Control” tab 
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5. For most instances, under “Target Application” you want to select “Default – all other 

applications”.  

6. Notice that in the main section of the application you will see columns termed “Name”, 

“Pressed” and “Released” and after the pressed and released areas you will see a small square 

box with three periods “…”. 

 

 
 

 The name column shows the name of the button to be programmed 

 The Pressed column shows the behavior associated with a push of the button 

 The “Released” column shows the behavior associated with the Release of a button. 

 The box with the “…” is what you need to select in order to change the programming for 

the function of the button event. 

 

7. Program a button as follows: 

a. Select the “…” box associated with the event (press or release) for the button you want 

to program 

[Note:  if you are unsure where to find  the section used to program a desired button, 

click on that button on the diagram of the microphone and you will see the associated 

line become highlighted 

on the Device Control 

application.  This is where 

you program the press or 

release function for that 

specific button] 

b. If there is an existing 

command associated with 

the button/event and you 

don’t want it, select it and 

then click on the “Delete” 

button 

c. Click on the “Add” button 

d. In order to add a Dragon related functionality to the button/event, click on the radio 

button associated with “Dragon NaturallySpeaking Command” (see below)  
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e. Click “Next” 

f. From the drop-down menu which appears on the next screen, choose the specific 

Dragon command you want associated with the button/event.  You will need to scroll 

through the drop down to see all possible choices. 

 
g. Click “Finish” 

h. Important caveat:  be aware of the consequences of both the push and the release of a 

button and associated programming.  In some situations you may want a separate event 

to be associated with a push and release.   For instance in order to use a button to act in 

a “Push to Talk” manner, you can program the push to cause a “microphone on” and the 

release to cause a “microphone off and stop” 

i. Follow the above steps for other events/buttons as needed. 

j. IMPORTANT POINT:  your device has not been programmed with the changes you made 

above until you click on the “Apply” button as shown below 
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One final note:  it is necessary for you to close the active Device 

Control window in order to start using your newly created 

programming.  Just click on the “X” on the top right of the 

application. 

Importing and Exporting Device Configurations 

There are many situations in which you may want to share the way a SpeechMike has been configured, 

particularly in situations in which you are part of a larger group of SpeechMike users.  Described below 

are the methods used to import or export a device configuration. 

 

Importing a Device Configuration:  If someone has already created a device configuration which they 

wish to share with you, simply store this file somewhere on your hard drive or a removable drive, click 

on the “Import” button on the Application Control tab of the Philips Device Control Center and then 

navigate to the saved file and select “open”.  See image above. 

Exporting a Device Configuration:  If you wish to share a device configuration you have created, simply 

click on the “Export” symbol on the Application Control tab.  You will be asked if you wish to export just 

the selected profile or the full device configuration.  See image above. 

 

Firmware Upgrade 

Your SpeechMike Premium is controlled by internal software which is termed “firmware” and which is 

periodically updated by Philips.  This internal software can be updated by means of the Device Control 

Software and is done as follows: 

1. Check to see what your current firmware version is by 

opening the Device Tab and then clicking on the 

Firmware upgrade tab.  You will see the currently 

installed firmware in the central window as shown 

here.  

2. To download the current firmware version go to 

www.philips.com/dictation then go to the Suport tab, 

and choose Product Support.  Scroll down to select 

the SpeechMike premium and you will see a variety of 

downloads pertaining to your device.  Notice that in 
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addition to a variety of guides pertaining to your device, there are downloadable upgrades to 

both the firmware and the Device Control application (listed as “speech control”) 

 
3. Download the firmware 

4. Decompress (unzip) the download 

5. Open the Device Control Center 

6. Click on the Device tab and then the Firmware Upgrade sub-tab 

7. Click on the Import button and navigate to 

the folder in which you saved the 

downloaded firmware file 

8. Be sure the new upgrade is selected and 

then click the Upgrade button  (it will take 

about 30 seconds to complete the 

firmware upgrade) 

 

Using the SpeechMike Premium with a Mac 

Until this point, the entirety of this guide has been oriented to Windows users.  The microphone itself is 

compatible with a Mac and basic drivers will be installed when you attach the microphone to your Mac.  

In order to program the device behavior or button functions, it is necessary for you to download the 

“Speech Control for Mac” application which is shown at the Philips download site in the graphic above.  

The Mac version of the control software can accomplish almost everything described earlier in this guide 

for Windows users.  It integrates with Mac Dictate versions 2.5, 3, and 4. 

For more information, please take advantage of the following resources: 

Device Control for Mac User Guide:  

http://www.speechrecsolutions.com/assets/speechcontrol4mac_ifu_3.1.04_en.pdf  

Download Speech Control for Mac:  https://www.dictation.philips.com/no_cache/us/popups/software-

popup/?softwareId=2584&prodId=410   

https://www.dictation.philips.com/no_cache/us/popups/software-popup/?softwareId=2584&prodId=410
https://www.dictation.philips.com/no_cache/us/popups/software-popup/?softwareId=2584&prodId=410
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Chapter 24:  PowerMic II:  Use and Programming 

 

Overview:  The Dictaphone PowerMic II handheld microphone is a high quality 

microphone which works extremely well with speech recognition software.  In addition 

to being very accurate, the microphone element in the PowerMic II is somewhat buried 

in the housing and, as a result, this turns out to be a very noise rejecting microphone.  

In addition, when used with the following versions of Dragon there is a high level of 

integration between the PowerMic II and the software:  

• Dragon 10 Medical  

• Dragon Medical Practice Edition (DMPE) and DMPE2  

• Dragon Medical 360: Network Edition  

• Dragon Medical 360:  Direct (cloud-based)  

Unfortunately, the PowerMIc, as supplied by Nuance, does not on its own integrate 

particularly well with non-medical versions of Dragon and with Mac computers.  There 

are, however, some simple work-arounds to allow the PowerMic to works in these 

situations and they are described in detail below.  

Drivers and button integration:  the microphone does not come with any drivers.  All 

needed drivers will be installed automatically when using the PowerMic II with appropriate software.  

The exception is Dragon Medical 360:  Direct, with which it will work without drivers when run locally, 

but if run over Citrix you will need to obtain Citrix PowerMic II drivers from your IT administrator.  For 

more information, please refer to the chart at the end of this guide.  

PowerMic II Set-up and Use with Dragon Medical  

 When used with any of the medical versions of Dragon from version 9.5 and onward, a high level of 

integration takes place between Dragon and the PowerMic II – so much so that there is even a dedicated 

tab on the Dragon “Options” window for programming of the buttons on the PowerMic II (see graphic at 

right).  

 

 

 

 

 

 

 

 

 

Key Point:  When using the PowerMic II with any medical versions of Dragon it is 

necessary to formally select the PowerMic II as the sound source for a user 

profile in order to have the added tab on the options menu for advanced 

programming of the buttons on the PowerMic II.  If you don’t see the tab on your 

medical version of Dragon, it means the PowerMic wasn’t properly added.  See 

instructions below.  
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Adding the PowerMic II to Dragon Medical: 

New Dragon User:  if you are setting up Dragon for the first time, you should follow this simple 

procedure: 

1. First, plug in the PowerMIc II and allow all drivers to 

automatically installed 

2. Insert the Dragon disk and install Dragon 

3. Once installed and setting up your first user profile, 

select the PowerMic as your sound source 

Existing Dragon Users:  Adding the PowerMic II can be done 

using one of two methods:  

1. Add as new source:  The advantage of this method is 

that it makes a copy of your existing profile, retaining 

all words and commands in your original profile).  

From within an existing user, change the dictation 

source by going to Profile > Add dictation source to 

current user profile. You will be presented with a 

window from which you can choose “PowerMic II Microphone” as your new source.  You can 

thereafter choose whether to perform training or not.  Selecting a “short” training is ideal but 

not absolutely necessary.  

 

[Note:  in older versions of Dragon Medical a new source is added using a slightly different 

method.  Navigate to Profile > Open User Profile and then selecting Source > New on the right 

of the Open User screen.  From there select the PowerMic II as the sound source and follow 

subsequent instructions.] 

  

2. Create a New User Profile:   We consider this a less preferable method in so much as it’s more 

time consuming and causes you to lose the words and commands you may have added to your 

original profile .   

Here are the basic steps:   

a. From within your existing profile, navigate to Profile > Manage User Profiles > New 

b. Select the “PowerMic II Microphone” as the dictation source.  Train the new user as 

usual.  

Programming PowerMic Buttons (Dragon medical versions only)  

Assigning functions in appropriate medical versions of Dragon is the same as programming keyboard 

hotkeys.  Program buttons in medical versions of Dragon as follows:  
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1. Open the PowerMic II tab in the options menu 

by clicking on Tools > Options > PowerMic II 

tab.  You will see the Options tab shown 

above.   

2. On your PowerMic II microphone, push on the 

button you want to program.  You will notice 

that the corresponding button on the 

PowerMic II picture will turn green and the 

associated drop-down menu to the right will 

be highlighted   

3. From the drop down menu, select the function you want to assign to the selected button.   

4. If you want to program a button to cause a command to be initiated, go the “User Commands” 

selection on the drop-down.  This will then 

reveal the last 5 commands you used and 

any of these can be selected.  If necessary, 

therefore, in advance of programming a 

button, be sure to use any commands you 

plan to assign to a PowerMic II button.  

5. If you plan to program a button to advance 

sequentially through variable fields in a 

document, make the appropriate selection from the navigation category of the drop-down 

menu (see image at right).  

 

PowerMic Set-up with Non-Medical Versions of Dragon  

 As mentioned above, full programmability of the buttons on PowerMic II is 

allowed only with the medical versions of Dragon.  For all other versions, the 

microphone and speaker will work, as will the pointer stick and left and right 

click buttons.  But nothing more.  

 

Fortunately, there is an option to allow programming of the PowerMic II for 

non-medical versions of Dragon and for other Windows applications – the use 

of Octopus USB Controller (OUC).  Octopus USB Controller is a third-party 

software utility that allows you to assign functionality to the buttons or levers 

on any USB Human Interface Device, including the PowerMIc II.   Among the functions you can program 

are the following:  

• Insert boilerplate text (text of your choosing)  

• Initiate any of a series of Windows activities, such as moving forward and backward through 

open applications, opening the Task Manager, and other common Windows functions/activities  

• Open any application, document, web-page, or folder  

• Emulate any key or key-combination  

• For Dragon users, initiate any Dragon Hotkey or command (including user created commands)  
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• Combine an unlimited number of the above functions into a single "script" initiated with a single 

button, key or lever push  

A fully functioning version of OUC is available for free download and can be used 5 times before 

purchasing an activation code.  For more information on Octopus USB controller, please visit the 

product page on our site at:  

http://store.speechrecsolutions.com/octopus-usb-controller-p164.aspx   

  

PowerMic II Set-up and Use for Mac Users  

  

Mac Limitations  

Although Dragon Dictate shares the same speech engine as its Windows-based cousin (Dragon  

NaturallySpeaking) and provides high levels of accuracy when dictating, it lacks some of the functionality 

seen in the Windows version.  As relates to the PowerMIc II, limitations include:  

1. The inability to program any of the keys on the PowerMic II microphone to control the 

microphone with Dragon Dictate  

2. The inability to use any microphone (PowerMic II and others) in a “push-to-talk” manner.  

3. The lack of drivers and functionality to allow programming of additional functions to the 

PowerMic II buttons   

 

Prerequisites for the Mac User  

Thankfully, there is a simple way to get around these limitations, although it requires purchase of two 

(relatively inexpensive) third-party applications.  One application allows programming of PowerMic keys 

in a Mac environment (including emulation of keystrokes.)  The other allows keystrokes to control the 

default Mac microphone in a push-to-talk manner.  Here’s what you need:  

1. USB Overdrive:  this is a software utility that detects 

the buttons on most USB devices, including the 

PowerMic and allows you to program a variety of 

functions to a button depression.  This application is “shareware” and can be used for free, 

but you will be forced to live through a short count-down every time you launch it.  We 

suggest you buy it for $20 and support the programmer.  It can be seen and downloaded from 

www.usboverdrive.com  .  Once downloaded and installed, USB Overdrive will show up as a 

system utility and is accessed through the Finder at Applications > Utilities.  If the only thing 

you want is to control Dragon Dictate with a PowerMic in a push-on/push-off method, USB 

Overdrive is all you need.  You will see that USB overdrive allows programming of lots of 

functions to the keys on a PowerMic.  

http://store.speechrecsolutions.com/octopus-usb-controller-p164.aspx
http://store.speechrecsolutions.com/octopus-usb-controller-p164.aspx
http://store.speechrecsolutions.com/octopus-usb-controller-p164.aspx
http://store.speechrecsolutions.com/octopus-usb-controller-p164.aspx
http://store.speechrecsolutions.com/octopus-usb-controller-p164.aspx
http://store.speechrecsolutions.com/octopus-usb-controller-p164.aspx
http://store.speechrecsolutions.com/octopus-usb-controller-p164.aspx
http://store.speechrecsolutions.com/octopus-usb-controller-p164.aspx
http://www.usboverdrive.com/
http://www.usboverdrive.com/
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2. Push to Talk:  this is a very inexpensive ($.99) application that is available 

from the Mac App Store and which will allow you to assign any key 

combination to control the assigned system default microphone in a push 

to talk method.  To be clear, Push to Talk does not interact with Dragon or 

any other program but, rather, controls the default microphone at the 

system level, activating it while a key or key combination is depressed and inactivating it when 

the key or key-combination is released. If the default microphone is the PowerMic, then it can 

be controlled in a push to talk method.    

  

Find “Push to Talk” by searching on the Mac App Store.  Once installed, Push to Talk is seen as a 

small microphone icon on the top of your screen.  It provides a visual indication of whether 

your microphone is active or not and by clicking on the icon you can open its simple menu.  

You’ll need push to talk if you want to control the Dragon Dictate microphone in a push-to-talk 

manner.    

  

Overview of the Setup for a Mac:   

 

We recommend a strategy using the general flow shown in the figure above and programming USB 

Overdrive and Push to Talk as follows:  

1. Program one key on the PowerMic to issue the key combination needed by Dragon Dictate to 

control the microphone in an on/off method (press once to turn on and again to turn off) – we 

like to assign this to the transcribe key, but any key will work.  

2. Program one key on the PowerMic to issue the key or key combination used by “push to talk” to 

operate the default microphone input (PowerMic II) in a push-to-talk manner.  

Practically speaking you will use the first button to turn on the microphone, and then use the second 

button to actually activate the microphone input in a push-to-talk method.  
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Detailed Set-up Instructions:  

1. Download/Install USB Overdrive  

2. Download/Install Push to Talk  

3. In order to have Push to Talk control the 

PowerMic II it is necessary to select the 

PowerMic as your default microphone from 

the Mac sound control panel (see image at 

right).   

4. Open the Push to Talk Preferences menu as shown below (if it isn’t obvious, the application is 

viewable and accessed from the small microphone icon at the top of your screen)  

5. On the Microphone control drop-down be sure “Hold down hotkey to activate mic” is selected.  

6. Assign your desired hotkey by clicking in the clear area near 

the bottom of the Preferences window and select your key 

combination (shown above is the combination of 

Ctrl+Shift+P.)  

7. Open USB overdrive and program the button on your mic 

to the key to you want to assign push-to-talk behavior (the 

same key or key-combination assigned to the Press to Talk application.)  Shown below the 

“button 3” on a PowerMic II (the central record button) is assigned the same key combination 

assigned by the Press to Talk application to control the 

microphone.    

8. If you want to be slick, use USB Overdrive to program 

one button to correspond with the key combination 

assigned in Push to Talk, and another button to 

emulate the key combination set in the Dragon Dictate 

preferences menu to cycle the microphone on and off.  

In this scenario, you can use one button (the 

“transcribe” button) to turn on the microphone in 

Dragon Dictate, and then another button (the “Record” 

button”) to control the microphone in the operating 

system in a push-to-talk method.  

 

 

 

 

 

 

 

 

Key Point:  the “Push to talk” application actually controls whether the microphone is 

providing input to Dragon Dictate (or any application) on your Mac.  Even if Dragon Dictate 

shows the microphone as green and “On” the signal won’t be getting through to Dragon 

until you have activated the key combination (either on the keyboard or via the PowerMic 

through USB Overdrive) required by Push to Talk.  To use the two effectively, you will need 

to turn on the Dragon Dictate microphone with one key and then actually control the 

microphone input using another key via Push to Talk. 
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Caveats on using the PowerMic II with a Mac:    

1. This exact set-up can also work with other USB microphones.  Unfortunately the Philips 

microphones do not work with a Mac except in the context of the Philips Control Application.  If 

you program the record button on a Philips mic to emulate a key combination, rather than 

directly control the Dragon Dictate microphone, you can use this button in a push-to-talk 

method as described above.  

2. If you are using the cloud-based speech recognition program built into your Mac, this same 

system (Press to Talk, with or without USB Overdrive) will work just as easily.  Simply apply the 

same key or key-combination to activate speech recognition in both the speech recognition 

software and in Push to Talk.  

 

Overview of PowerMic II Software Compatibility  

  
Software 

Environment  

Use of 

Microphone  

Use of 

Speaker  

Use of  

Track-Point  

Stick  

Use of left 

and right 

mouse 

buttons  

Basic  

Programming 

of accessory 

buttons (1)  

Advanced  

Programming 

of accessory 

buttons (2)  

Audio 

programs in  

Windows  

XP, 7 & 8  

Yes  Yes  Yes  No  No  

 

 

No 

Audio 

programs on 

Intel Mac  
Yes  Yes  Yes  No  No  

 

No  

Dragon  

Medical 10,  

DMPE, &  

DMPE2  

Yes  Yes  Yes  Yes  Yes  

 

 

Yes  

Dragon  

Direct (3)  Yes  Yes  Yes  Yes  Yes  
Yes  

  
(1) “Basic Programming” of the 10 accessory buttons means that standard functions which can be assigned to keys on the pc 

keyboard can also be assigned to any of the 10 programmable buttons on the PowerMic II using the “hotkeys” tab on the 

NaturallySpeaking Options window.  

(2) Advanced Programming of the 10 accessory buttons means that a tab specific to the PowerMic II will be present in the 

Dragon Options window and that keys can be assigned to affect a number of higher level functions within dragon, 

including initiation of commands.  

(3) When the local version of Dragon direct is run, Dragon direct will allow programming of 3 buttons at this time (Nuance is 

gradually rolling out more button programming).  When using the Citrix based version of Dragon Direct, it is necessary to 

install dedicated Citrix drivers to allow functionality of the PowerMic on the Citrix-based application.   
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Chapter 25:  Installing Dragon from a USB Thumb Drive or by Download 

 

If you are using Dragon on a tablet or other Windows device which does not include an optical (DVD) 

drive, you can install Dragon on this device using one of three methods: 

1. Find an online version of Dragon and download this directly to your device (problem:  these are 

hard to find and are huge files which take forever to download.  Remember, you will still need 

an activation code to actually run the software if you download it) 

2. Purchase or borrow an external DVD drive and install Dragon using this device. 

3. Install by means of a portable thumb drive.  In this method, you will use a computer with a DVD 

to copy all the files from the Dragon DVD onto the thumb drive and then install onto your other 

computer using the thumb drive. 

Installing Dragon with Thumb Drive 

Assuming your purchased DMPE2 and have an installation disk but no optical drive, this is the method 

by which you can install the software on a machine without an optical (DVD) drive. 

Step 1:  Put the Dragon Installation Files on a Thumb Drive 

1. Using any computer with a DVD drive, insert 

your Dragon installation disc into the optical 

drive. 

2. Since the Dragon DVD includes an “auto 

install” capability you will likely see the initial 

installation window (shown to the right) 

which you should close. 

3. Insert your USB Flash Drive.  Your drive must 

have at least 4 GB of free storage. 

4. Use Windows Explorer to open the Dragon 

DVD by clicking on the Windows Start and 

selecting “Computer”, “My Computer”, or “My Device” depending upon your operating system. 

5. Right mouse click on the Dragon DVD (usually drive D or E) and choose Copy from the drop 

down menu. Note that you may have to wait a 

few seconds or more for Windows to buffer the 

files. 

6. Double Mouse click or right click and select 

Open to explore the USB Flash drive  

7. Create a new folder on the flash drive, name it 

something easily recognizable like Dragon 

Install and open the folder. 



 

94 
Copyright 2015 Speech Recognition Solutions, LLC.  

www.SpeechRecSolutions.com 

8. Mouse click into the any region of the empty folder and press Ctrl + V to paste a copy of the 

contents of the Dragon installation disc. You can optionally mouse right-click and select Paste. 

Note that this process can take as long as 20 minutes depending upon the speed of your 

computer and type of USB connection.  

 

Step 2:  Install Dragon on your device without the DVD Drive 

 After the Windows copying process Window disappears, take your flash drive to the computer 

that doesn’t have an optical DVD drive. If you are using a USB 3 flash drive and a USB 3 port on 

your 2nd computer (typically colored blue), you can 

open the Dragon Install folder on your Flash drive and 

mouse double click the “Setup.exe” icon with a green 

flame and following the remaining step-by-step 

instructions. 

 If you are using a USB 2 flash drive or USB 2 ports on your second computer, be aware that the 

installation will be very slow.  We recommend that you speed up the process by copying the files 

on the thumb drive to any folder to your Windows desktop and installing from this location.  

Whether from the thumb drive or folder on your computer, install NaturallySpeaking from by 

double-clicking the “Setup.exe” icon with a green flame and follow the remaining step-by-step 

instructions. 

 If you have installed after moving the files to your hard-drive, once the installation is complete 

you can feel free to delete the files from your hard-drive, but if you have the space, having them 

available will be helpful if you need to repair or re-install Dragon at some point in the future. 

 

Installing Dragon by Direct Download 

The makers of Dragon, Nuance Communications, Inc. allows some versions of 

Dragon to be installed by direct download.  In fact some of versions of Dragon, 

including the recently released Premium 13, is sold by Nuance as a direct 

download product. 

Downloading your version of Dragon is potentially helpful in several situations, 

including: 

1. You are purchasing Dragon and don’t want to wait for the disk to be delivered.  

2. You have lost your disk but still have your activation code (or can get the activation code from 

your reseller. 

These downloads are slow and depend upon a good internet connection to be practical.  Links to these 

downloadable products are provided to end-users at the time of purchase.  Be aware that you still need 

to enter an activation code (obtained at the time of purchase) to actually complete the installation and 

activate the software  
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Chapter 26:  Using a Digital Recorder with Dragon NaturallySpeaking 

 
For those desiring to record dictation “on the go” and later have it transcribed by Dragon, the use of a 

portable digital dictating device is a perfect solution.  When choosing a digital recorder, keep in mind 

that Dragon is fairly flexible about recorders and the only real issue is being sure your recorder saves the 

file in a format compatible with Dragon transcription. 

Creating a New User Profile or Source for Use with a Portable Digital Recorder 

 

Note:  although the method shown below which has you create a separate user profile for your digital 

recorder is recommended by Nuance, in practice we have frequently skipped this step and simply 

transcribed the recording from within an existing user 

profile and it seems to work fine.  But for the record, 

here is the formal method of creating a user profile for a 

digital recorder: 

1. Go to Dragon > Open Profile > Source > new 

2. From the pull-down on the “New Dictation Source” 

window, select “Digital recorder using sound files … 

(see image at right) 

3. Click OK 

4. Select the new source and click “Open” (see below) 

5. You will be presented with a message that “Recorder 

Training has not yet been successfully completed …” 

Click OK. 

6. On the following “New User Wizard” screen, click next. 

7. On the next screen you will be presented with several 

readings, one of which you must select and read into 

your portable recorder before proceeding with the 

next step.  Select the reading and either print it or read it (into your portable recorder) 

 

WARNING:  you need to read for about 15 minutes, so 

time yourself.  There is no reason to read beyond 15 

minutes. 

 

8. Click next in order to see the screen shown below, and 

then click the “Browse” button and browse to the file 

containing your 15 minutes of reading.  Be sure to select 

the type of file appropriate for your recorder (either 

.mp3, .wav or .wma) 
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Importing and Transcribing Sound Files 

 

There are several ways you can import a file for transcription with Dragon.  We will describe both a fully 

manual method (which is actually quite quick and simple) and a more automated way.  Keep in mind 

that some of the expensive recorders come with proprietary software that can streamline some of this 

process. 

 

Manual Method: 

 

1. Dock or otherwise attach your 

portable digital recorder to your 

computer 

2. With Dragon running and opened to 

your digital recorder profile, 

navigate to Tools  > Transcribe 

Recording.  This will open up the 

window shown below. 

a. When choosing 

“destination” if you choose 

“DragonPad window”, it means that when you ask Dragon to transcribe a recording, it 

will automatically open DragonPad and enter the recording into the DragonPad window; 

if you choose “A selected window” it will enter the recording into the last window in 

which you placed the cursor. 

b. Under the command category, decide if you want commands to be carried out when the 

recording is transcribed.  We have found it to be a little hit or miss as to whether 

commands will actually work under this setting, but you can experiment with it. 

c. With these advanced settings determined (you will only need to do this once, unless you 

decide to change these settings by once again clicking on the “Advanced” tab), click OK 

to go back to the last window. 

 

3. Click on the “Next” tab to bring up 

the next screen.  Click on the 

“Browse to locate file” button and 

navigate to the file on your digital 

recorder or the location you saved 

the file.  The next time you do this 

it will default to the same location. 

4. Once the file is selected, click on 

the “transcribe” button to start the 

transcription. 

5. That’s it! 
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Drag and Drop Transcription 

Once you’ve created a profile for 

your digital recorder (or even if 

you haven’t), another method of 

initiating the transcription of a 

file from your digital recorder is 

to simply drag the file from your 

digital recorder (as viewed from 

your computer desktop - see 

image at right) to the Dragon 

Bar.  As soon as you let go of it, 

the transcription window will come up your recording will be automatically transcribing using the 

protocol you specified previously.  See image below. 

 

Auto Transcribe Folder Agent Method:   

Dragon offers yet one more way of transcribing dictation 

from a digital recorder and in this case it is done in the 

background with Dragon turned off (application closed).  

This method is a bit tricky to set-up, but when properly 

configured has the effect of automatically detecting a 

suitable sound file in one location (a file in your digital 

recorder docked or connected to your computer) and 

transcribing it in the background and placing it as a text 

file in a designated target folder.  

 The nice thing about this method is that it places both 

the completed dictation and associated audio file in the 

destination folder, so if the file is being proof-read by 

another and if there are questions, the original audio can 

be reviewed directly from the folder.  This method works 

with the advanced versions of Dragon (Professional, 

Legal, and Medical) and will allow use of any of the 

following sound file types:  

 WAV 

 WMA 

 MP3 
 

 DSS  

 DS2.   
 

 

The supported output file formats are Plain Text (.TXT), Rich Text Format (.RTF), and Word Document 

(.DOC). 
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Setting up Auto-Transcribe  

Here’s the basic process: 

1. From the Start Menu (or equivalent on your PC) navigate to All Programs >Dragon Medical 

Practice Edition > Dragon Medical Practice Edition Tools > Auto Transcribe Folder Agent.   Once 

you find this application it’s a good idea to drag it to your taskbar or desktop so it will be easy to 

open in the future. 

2. Once you’ve opened the Auto Transcribe Folder Agent application you will see the window 

shown below: 

 

3. Click on the “+” sign to create a new task (automated process).  You will see the window below: 

a. Click on the small box with “…” to the right of the Input directory area and Output 

directory area to assign the fold to be monitored.  The input directly folder is ideally a 

folder on your digital device, so you’ll 

need to have your device docked in 

order to navigate to this.   

b. The Output directory folder is the 

folder in which you want the 

completed transcription to be 

placed.  You may want to create a 

folder for this purpose in advance 

and then set it as the destination 

folder now.    

c. The User Location will generally be 

selected by default. 

d.  Under dictation source, be sure you 

pick the source which was set up and 

prepared for your digital recorder.  If 

you didn’t set up a user profile 

specifically for the digital recorder, 

it’s OK to select any valid user profile. 
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Details on the AutoTranscribe Agent Fields 

 

Field Description 

Input Directory Selects the directory which the AutoTranscribe 

Folder Agent will monitor for new files to 

transcribe 

Output Directory Selects the directory where the transcribed file 

will be placed 

Location Specifies the location of Dragon user files 

Name  Select the User name for user for whom the 

transcription will take place 

Vocabulary If multiple vocabularies are present for a user, 

this specifies the vocabulary to be used. 

Dictation Source Select the dictation source for the user 

 

Initiating Auto-Transcription 

The only requirements are: 

1. You must have configured the Auto-Transcribe Agent Folder as shown above 

2. The Dragon program must be turned OFF – closed – when using the AutoTranscribe process 

(seems counter-intuitive, but this is a background process and depends upon Dragon being 

turned off) 

3. The AutoTranscribe Folder Agent must be launched and running.  You can keep this running in 

the background as long as you want and it will be sitting in “idle” waiting for a new file to show 

up in the input directory (folder). 

Here’s the basic workflow:  You plug in your digital recorder, the Auto-Transcribe agent is on the lookout 

for any change in the folder on your digital recorder and see the file, the audio file is transcribed, and 

both the audio file and transcription are put in your designated destination folder.  The cool thing about 

the process is that it’s all automated – in other words a minute or so after docking your digital recorder 

the transcribed file or files show up in your destination folder – all complete.  Complete doesn’t mean 

you should read the docs and do any needed proof-reading! 
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Chapter 27:  Using an iPhone with NaturallySpeaking 

 
With mobile devices being so ubiquitous these days it shouldn’t be surprising that these can be used in 

conjunction with your computer and with Dragon.  There are two ways your mobile phone can integrate 

with Dragon.  Both are potentially very helpful.  

1. Wireless Microphone:  You iPhone can be used as a portable microphone and provide a signal 

directly to Dragon by means of your wireless network … and in real time. 

2. Digital Recorder:  Your iPhone can be used much like a portable digital recorder and capture 

your dictation for subsequent processing by Dragon 

iPhone as a Remote Microphone 

Setting up an iPhone as a remote microphone takes only a few 

minutes, will cost you nothing, has few requirements, and works 

fairly well.  Although you can create a brand new profile using an 

iPhone as the sound source, it’s probably more practical to add it as 

a new “source” to an existing user profile.  By adding it as a source, 

you reap all of the advantages of your existing profile (custom 

words, commands, etc.) and simply have the option of opening 

either your iPhone based profile or usual profile each time you start 

up Dragon. 

Is there a special advantage of using the iPhone as a wireless microphone?  In our opinion, not really.  

But it’s simple to set-up, works fairly well, and is an alternative to buying a wireless microphone if you 

want to be untethered to your computer.  Are there downsides?  There are few. First, the signal passes 

from your phone to Dragon by means of your Wi-Fi network and is a bit slow.  It’s certainly slower than a 

dedicated wireless microphone that connects via Bluetooth.  Second, while the iPhone has a reasonably 

good microphone, it’s not terribly rejecting of external noise, so it might not be practical in a loud 

environment.  Finally, in the opinion of some, it’s a little awkward to hold the iPhone while dictating.  

But assuming you want to try this, here’s what’s involved. 

Basic Requirements: 

 Dragon NaturallySpeaking V11.5 or higher (works fine with DMPE2) 

 iPhone 

 “Dragon Remote Microphone” application installed on your iPhone 

 A Wi-Fi network to which both your computer and iPhone are connected 

 The presence of Bonjour on your Windows or Apple computer.  If you aren’t sure if you have it, 

you can assess this from http://www.apple.com/support/bonjour 
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Set-up Process:  iPhone as a Remote Microphone 

Here is the basic process: 

1. If you haven’t done so already, download the Dragon 

Remote Microphone application from the Apple App Store 

and install it on your iPhone.  Here’s the direct link if you 

want to learn more about it:  

https://itunes.apple.com/app/dragon-remote-

microphone/id436624808?mt=8   But searching for it from 

your iPhone is the only practical way to get the app. 

2. Open Dragon and add the Dragon Remote Microphone as a 

new “source” to your existing profile in DMPE2.  This is done 

by navigating to Profile > Add Dictation source to existing 

user Profile.  From the “New Dictation Source” window that 

opens, select “Dragon Remote Microphone Application”. 

3. Select the check box labeled 

“Open the new dictation source 

now” 

4. Click “OK” and your new source 

will be added and you will see 

the “Prepare Communication” 

window as shown to the right.  

As this point you have several 

options for establishing a 

communication between NaturallySpeaking on your PC and the Dragon Remote Microphone on 

your iPhone. 

 If you have Bonjour on your computer, you can simply open you Dragon Remote 

Microphone on your 

iPhone, click on the small 

gears icon on the bottom 

right, and the application 

should automatically detect 

the computer on which you 

are running Dragon.  It will 

show all of your profiles on 

Dragon.  Simply select the 

profile you created with the 

iPhone as a sound source. 

 Alternatively, you can set 

up the connection manually. Click on the button “Enter information manually” (see 

image above) to start this process.  At this point another window will show up and will 

https://itunes.apple.com/app/dragon-remote-microphone/id436624808?mt=8
https://itunes.apple.com/app/dragon-remote-microphone/id436624808?mt=8
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contain all the information (profile name, IP address and port number) you will need to 

enter into the Dragon Remote Microphone application. 

 Finally, you can use you the “barcode” method to link you iPhone and PC.  From your 

Dragon Remote Microphone application click on the gears icon, click on “manual entry” 

and then click on “Use a barcode”.  Your phone will open your camera.  Simple point 

your camera to the barcode image on your computer (shown above) and the connection 

information will be entered seamlessly. 

5. When you are done making the connection or entering the correct connection information as 

described above, click the “Next” 

button on the “Prepare 

Communication” window on your 

computer 

6. You will next be asked to 

“calibrate” your microphone.  

Click on the Nuance icon in the 

center of your Microphone 

application and it will change 

from Red to Green, indicating an 

active connection and live 

microphone.  Follow the 

instructions on your computer. 

Using the iPhone as a remote microphone 

Actual use of the set-up is simple and involves the obvious: 

1. Open Dragon, selecting the Profile/Source created for your mobile device 

2. Open the remote microphone application on your iPhone 

3. Toggle the microphone off and on by touching the Nuance flame insignia on your iPhone 

Microphone Off  Microphone On 
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iPhone as a Portable Digital Recorder 

Many speech recognition users find it efficient to capture dictation in a portable recorder and later 

transfer the resulting digital file to Dragon for transcription.  Although you can do this with a dedicated 

digital recorder, it is also feasible to do this with your iPhone or Android mobile device.  The main 

advantage of this work-flow is that you can capture dictation any time you want (assuming you are 

carrying your iPhone) and there is no need to purchase or carry another device.  The downside is that 

the process is a bit more awkward compared with using a digital recorder.  Most high-end digital 

recorders include a very convenient and ergonomic slide switch which is used to initiate record, play, 

rewind, etc. 

Basic Requirements: 

The process can be accomplished with any digital recording software on your mobile device, including 

those offered by Nuance, Andrea and others.  The only requirement is that the application can capture 

your audio in an acceptable format for Dragon (WAV, WMA, MP3, DSS or DS2) and somehow transfer it 

to your computer for transcription by Dragon.  The rest of this tutorial will take you through the process 

using the Dragon Recorder app. 

To be explicit, here are the requirements: 

 iPhone 

 Dragon Recorder application from the iOs App Store (free download) 

 Any recent version of Dragon NaturallySpeaking 

Set-up Process:  Dragon as a digital recorder 

Here is the basic process you need to follow in order to set-up you iPhone as a digital recorder for use 

with Dragon. 

1.  Although you can transcribe a recording made with an iPhone or other digital recorder from any 

Dragon user profile, you will get better results if you create a new “source” on your current user 

profile.  The following steps show you how to do this. 

2. Navigate to Profile > Add Dictation Source to current user profile 

3. From the pull-down on the “New 

Dictation Source” window, select 

“Handheld or smartphone with 

recording applications” 

4. Click OK 

5. Follow instructions provided 

hereafter.  You will need to do 

about 15 minutes of reading into 

your portable device and later have Dragon process this in order to adjust to your voice and the 

acoustics of your portable device. 
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Creating a Recording 

1. Assuming you have already downloaded the Dragon Recorder app from the App Store, simply 

launch it and create a new recording: 

   
 

2. A few notes on controlling the recording: 

a. Tap the central button to begin a recording.  

b. Tap it again sequentially to pause and resume recording.   

c. Double tap the button to complete a recording 

d. Once a recording is done, you can add to it by selecting it, dragging the slider bar to the 

far right and again touching the record button. 

Transferring Recording to Computer & Dragon 

There are two ways to transfer your file to your computer:  1) wirelessly via Wi-Fi and 2) using your sync 

cable with iTunes. 

Wireless (Wi-Fi) Transfer:   

1. From within the Dragon Recorder application click on the “Options” button on the bottom left.  

Turn on “Wi-Fi Sharing” and you will see an assigned URL. 

2. Launch a browser on your computer (both the computer and iPhone must be on the same 

wireless network) and enter in the URL shown on your iPhone.  This will open a page as shown 

below which provides a list of the recordings on your iPhone 
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3. Right click on the recording you want to transfer and select “Save Target As”.  Save the file to a 

place on your hard drive that you will remember.  You will later point dragon to this file in order 

to transcribe the recording. 

Wired Transfer Using iTunes: 

1. Connect your iPhone to 

your computer using the 

sync cable. 

2. If it doesn’t open 

automatically, open 

iTunes 

3. Within iTunes, follow 

the steps shown in the 

diagram below to 

identify and save your 

file or files to any 

memorable location on 

your hard drive. 

 

 

Transcribing a Digital Recording  

 

Once you have created a digital recording and saved it to your hard drive using either of the methods 

shown above, follow these simple steps to transcribe your recording: 

1. Open Dragon (If you have created a separate source for digital recordings you should open this 

profile; otherwise just open your basic user profile.   

2. From the “Tools” menu, select “Transcribe Recording” 

3. On the dialog box that opens, first click on the browse button 

and navigate to the file you saved from your iPhone, then click 

on the “transcribe” button.  If you don’t see the file, be sure 

that “wav file” is selected as the file type (for digital recorders 

other than the iPhone you may need to choose MP3 File or WMA File as the file type). 
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4. Note:  By default, Dragon will transcribe your 

recording into “DragonPad”, a simple word-

processing window from which you can copy your 

text and paste into the electronic health record or 

other text window.  If you prefer to transfer text 

directly into a specific window, you show open the 

advanced tab shown in the dialog box above.  You 

will see the following options window which will 

allow you to change this behavior and also 

determine whether or not you want Dragon to 

process voice commands as it transcribes your 

recording.  See the help menu on this screen for 

further information about this. 

 

More information 

Nuance Dragon Recorder web page:  http://www.nuance.com/dragon/recorder-app/index.htm 

Dragon Recorder User Guide:  http://dragoncontent.nuance.com/recorder-

app/help/enx/dragon_recorder_app.htm  

View demonstration of Dragon Recorder from Nuance:  

http://www.nuance.com/videoplayer/videoplayer.asp?w=640&n=Dragon_Recorder_App_000&h=390&

p=naturallySpeaking/dragonrecorderapp/&fileType=MP4&autoPlay=false&videoPage=true  
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Chapter 28:  Moving Commands from One User Profile to Another 
 

Moving commands from one user profile to 

another is a fairly simple process with any of 

the Dragon versions above the Premium 

(works for Professional, Legal and Medical).  

The process involves exporting the commands 

from one profile and importing them to 

another. 

Exporting Commands 

Here’s the basic process, in this case 

illustrated with version 10 Medical, but similar 

in version 11 and 12 and DMPE2: 

1.  Open the Command Browser (either 

issue command “Open Command 

Browser” or navigate to Tools > 

Command Browser 

2. Be sure the Command Browser is 

expanded to show 3 full columns; if it 

isn’t, click on the “task pain” to expand 

it. 

3. Put the Command Browser into the 

“Manage” mode, either by clicking on 

the “Manage” area in the left column or 

navigating to Mode > Manage.  You should see something looking like the image below, but with 

your own commands.  Follow the listed steps. 

 

Note:  If you want to move ALL of your 

commands from one user profile to 

another, rather than selecting a single 

group from the “group” selection, 

select the “All” category.  See below 

 

4. Save the command group with any 

name you want and to any location you 

desire. 
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Importing Commands   

This is basically the reverse of the exportation process and goes as follows: 

1. Switch to the user profile 

into which you want to 

import the commands 

2.  Open the Command 

Browser (Tools > 

Command Browser) 

3. Open the “Manage” area. 

4. Click on “Import” button 

and follow instructions 

shown below: 

 On the Import 

Commands 

window that appears confirm the commands you want to  import (uncheck any you 

don’t want to import) 

 Click the import button.  They will be instantly imported into you active profile. 
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Chapter 29:  Promoting Efficiency with the Dictation Box 

 

Overview 

If you haven’t made use of the Dragon’s “Dictation Box”, you might find this to be a very helpful tool.  In 

essence, the dictation box is a small word-processing 

window which can be launched quickly with the 

command “show dictation box” (or a keyboard 

command) and which can be used as a place to dictate 

with Dragon and from which you can later transfer 

(paste) material somewhere else.  How might this be 

helpful?  Consider two scenarios: 

1.  You are working in one of the rare programs in 

which Dragon doesn’t have full functionality 

(perhaps your Citrix based EMR) and you know 

that Dragon simply doesn’t work well in this 

application.  You can do the dictation into the dictation box, where Dragon has full functionality 

and then paste it where you want when finished. 

2. You are trolling through your EMR for information which you eventually plan to place into your 

note – perhaps lab reports, radiology reports, old notes, etc. – and you’d like a place to 

conveniently “Park” some information as you travel through the EMR.  Simply launch the 

Dictation Box and dictate anything you want into the box as you troll the record.  When done, 

modify this information as you desire and paste it into your note. 

For both of these scenarios, the dictation box can be a lifesaver.  Dragon Medical Practice Edition 2 

(DMPE2) goes one step farther – it allows you to open the dictation box in a semi-transparent state so 

that you can see it and dictate information into it, but also see through it, so as not to block your view of 

the underlying documents you are reviewing. 

Dictation Box:  Basic Use 

In the simplest terms, using the dictation box involves nothing more than this: 

1.  Open it by saying the command “show dictation box” (it will open in the manner specified by 

your selections in the “Dictation box” tab in the options menu) 

2. Dictate using your microphone (any dictation done while the dictation box is open will go to the 

dictation box and NOT other open windows. 

3. When ready to move the data from the Dictation box, insert you cursor where you want the text 

transferred and then issue the command “transfer text” 
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Anchored Mode  

The basic options window for the Dictation Box is accessed 

by means of Tools > Options and then clicking on the 

Dictation Box tab.  Shown to the right are the default 

options.  A few things should be explained. 

Clicking on the “Anchor Dictation Box to Application” will 

cause the dictation box to be anchored to the program 

which was active when launched and will give you no 

choice but to transfer the dictation box content to the 

place you had the cursor active at the time you launched 

it.  If you are using the dictation box as you work your way 

through a clinical note in a non-standard program, this is a 

perfectly fine way to use it.  Simply navigate to one place 

on your note for narrative, launch the Dictation Box, 

create the dictation and then return the dictation by 

either saying “transfer text” or clicking on the transfer 

button. 

 

Hidden Mode:  Dictation Box as a Storage Place 

If you don’t need the Dictation Box anchored and prefer to use it as a storage place for information you 

dictate while moving about an electronic health record, this is an ideal time to use it in the hidden or 

transparent mode.  In order to do so, you 

need to set the Dictation Box options 

menu such that you have unchecked the 

“Anchor Dictation Box to Application” 

button and then lower in the options 

menu select the degree of transparency 

you desire.  Keep in mind that “O” means 

fully opaque (visible) and 100% means 

fully transparent (invisible). 

Shown below is the appearance of the 

Dictation Box in the “Hidden Mode” with the transparency set to 50% and superimposed of some 

medical text in an EHR.   
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When using the Dictation box in the manner shown above, it will follow you wherever you go and any 

dictation will go into the Dictation Box and not the EHR.  Keep in mind that if you have space, you do not 

need to superimpose the Dictation Box over your background text and you can move it to the side.  In 

fact at any time if you click on the Dictation Box it will become full visible.  It will become transparent 

again if you click outside of the dictation box as you move through other records in the EHR or other 

places on your computer desktop. 

Caveat Regarding Dictation Box 

1. Depending upon your program, you may need to play with the default method of transferring 

text from the Dictation Box to the receiving window/program. By default, the Dictation Box uses 

the standard command ctrl + V to paste material 

to the receiving application.  As far as we can tell 

the “Use Windows Paste Command” does the 

exact same thing.  Some programs may disable 

the Windows clipboard, in which case you can 

choose the final option “Simulate keystrokes” to 

make the transfer. 

 

2. Changing the font:  If for any reason you aren’t 

happy with the default font that the Dictation 

Box uses (Plain Ariel, 10) you can change this to 

match your destination font size and style by clicking on the “Change Font” button on the top of 

the Option box. 

 

3. Remember that you can use common commands when dictating into the Dictation Box.  You can 

insert a note template with navigation fields and navigate throughout the template in the 

Dictation Box.  You can select, correct, and perform other normal voice commands within the 

Dictation Box. 

 

4. Finally, the Dictation Box can be opened in several ways, including: 

 

 Say “Show Dictation box” or “Open dictation box” 

 Navigate to Tools > Dictation Box 

 Use hotkey combination ctrl + shift + D 
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Chapter 30:  Overview of Built in Dragon Commands 
 

Control the microphone 
 
SAY: TO: 
 
Go to Sleep  Make the microphone stop 

listening temporarily. 
Stop Listening 

 
Wake Up Reactivate the microphone 

when it is asleep. 
Listen to me 

 
Microphone Off Turn the microphone off. 
 
 
Create new paragraphs, lines, and spaces 
 
SAY: TO: 
 
New Paragraph Press the Enter key twice. 

 
New Line Press the Enter key once. 

 
Tab Press the Tab key. 

 
Space Press the space bar. 
 
 
Move around in a document 
 
SAY: TO: 
 
Go to Bottom Move the cursor to the end of 

your document. 
 

Go to Top Move the cursor to the 
beginning of your document. 

 
Press Home Move the cursor to the start of 

the current line. 
 

Press End Move the cursor to the end of 
the current line. 

 
Insert After (text) Place the cursor after a specific 

word or words (must be visible 
on screen). 

 
Insert Before (text) Place the cursor before a 

specific word or words (must be 
visible on screen). 

 
 
Navigation Fields (Dragon Templates) – Dragon 

10 Medical Version Only 
 

(Variable regions are defined by “field delimiters” 
which be default are right and 
left brackets ([ and ]) 

 
Next Variable Move to and highlight next 

variable region 
 

Next Field Move to and highlight next 
variable region 

 

Previous variable Move to and select previous 
variable region 

 
Previous field Move to and select previous  

variable region 
 
 
 
Delete text and undo actions 
 
SAY: TO: 
 
Scratch That Erase the last thing you said.  

You can say "Scratch That" 
more than once to keep erasing 
previous words or phrases. 

 

Delete That Delete selected text. 

Undo That Undo the last action (useful for 
undoing commands). 

 
Backspace Press the Backspace key.  To 

press it more than once, say 
Backspace 2, Backspace 3, and 
so forth (up to 20). 

 
 
Correct and Edit Text 
 
SAY: TO: 
 
Correct That Correct either the last thing you 

said or selected text. 
 

Correct [text] Correct a specific word or words 
(must be visible on screen). 

 
Select [text] Select a specific word or words 

(must be visible on screen).  
Used to dictate substitute words 
or phrases. 

 
Select Again Select the same text again but 

in a different place (must be 
visible on screen). 

 
 
Capitalize text 
 
SAY: TO: 
 
Cap That Capitalize either the last thing 

you said or selected text. 
 

All Caps That Make either the last thing you 
said or selected text all capitals. 

 
No Caps That Make either the last thing you 

said or selected text all 
lowercase. 

 
Cap [word] All Caps On Turn all capitals 

on (like pressing the CAPS 
LOCK key). 
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All Caps Off Turn all capitals off. 

 
No Caps On Turn all lowercase on. 

 
No Caps Off Turn all lowercase off. 

 
No Space [word] Type the next word without a 

space before it.  Example: "cap 
john no space cap paul" = 
JohnPaul. 

 
 
Apply formatting 
 
SAY: TO: 
 
Bold That Apply bold to either the last 

thing you said or selected text. 
 

Italicize That Apply italics to either the last 
thing you said or selected text. 

 
Underline That Apply underlining to either the 

last thing you said or selected 
text. 

 
Restore That Remove formatting from 

selected text. 
 
 
Copy, Cut, and Paste Text 
 
SAY: TO: 
 
Copy That Copy selected text. 

 
Cut That Cut selected text. 

 
Paste That Paste cut or copied text. 
 
 
Quick Voice Editing and formatting (New to 

version 10) 
 
SAY: TO: 
 
Delete <text> Delete the 

specified text or 
range of text 

Delete from <text> to <text>  
Delete <text> through <text> 

 
Cut <text> Cut the specified 

text or range of 
text 

Cut from <text> to <text> 
Cut <text> through <text> 

 
Copy <text> Copy the 
specified text or range of text 
Copy from <text> to <text> 
Copy <text> through <text> 

 
Bold <text> Bold the 
specified text or range of text 
Bold from <text> to <text> 
Bold <text> through <text> 

 
Italicize <text> Italicize text or 
specified range of text.  

Italicize from <text> to <text> 
Italicize <text> through <text> 

 
Underline <text> Underline text or 
specified range of text 
Underline from <text> to <text> 
Underline <text> through <text> 

Select <text> Select the 
specified text or range of text 
Select <text> through <text> 
Select <text> to <text> 
Select from <text> to <text> 
 
 
 
 
Enter Figures 
Start the next word with a capital.  Example: "Cap 

the Cap end" = The End   
Example "Cap business Cap 
department” = Business 
Department 

 
All Caps [word] Type the next word in all 

capitals.  Example: "All Caps 
please" = PLEASE 

 
No Caps [word] Type the next word in all 

lowercase.  Example: "No Caps 
jack" = jack 

 
Caps On Turn initial caps on. 

 
Caps Off Turn initial caps off. 

 
 
FOR: SAY: 
 
1 – 9 numeral [number]  (Numbers 

one through nine should be 
dictated with the word "numeral" 
to obtain figure format.) 

 
57 fifty-seven 

 
235 two hundred thirty-five 

 
4385 four thousand three hundred 

eighty-five (correct to 4,385) 
 

13,837 thirteen thousand eight hundred 
thirty-seven 

 
142,015 one hundred forty-two thousand 

fifteen 
 

April 22, 2004 April twenty-two [comma] two 
thousand four 

 
04/22/04 zero four slash twenty-two slash 

zero four 
 

9:30 a.m. nine colon thirty a m 
 

$65 sixty-five dollars 
 

$99.50 ninety-nine dollars and fifty 
cents 

 
½ one half 
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818-710-4244 eight one eight seven one zero 

four two four four 
 

 
Switching Between Open Applications 
 
SAY: TO: 
 
Switch to next  
window Switch to next application

  
 

Switch to previous 
 window Switch to previous application

  
 

Switch to [application] Switch to application 
you say  
 
 

Changing font STYLE as you dictate 
 
SAY THEN: 
 
Set font to Arial 
 Courier 
 Courier New 
 Garamond 
 Helvetica  
 Palatino 
 Times 
 Times New Roman 

 
 
Changing font SIZE as you dictate 
 
SAY THEN: 
 
 
Set size  Any number between 4 and 100 

 
 

 
 
Enter punctuation and special characters 

 

For: Say: For: Say: 

 

. period ; semicolon 
 
, comma - hyphen 
 
? question mark ! exclamation mark 
 
: colon ' apostrophe 
 
/ slash \ backslash 
 
" open quote " close quote 
 
( open parenthesis ) close parenthesis 
 
( open paren  ) close paren 
 
[ open bracket ] close bracket 
 
@ at sign - minus sign 
 

# number sign + plus sign 
 
$ dollar sign = equal sign 
 
% percent sign ... ellipsis 
 
^ caret ~ tilde 
 
& ampersand * asterisk 
 
:-) smiley face :-( frowny face 

 

 
 

Desktop Search Commands (these commands 

require use of either Google 

Desktop or Microsoft Vista 

Search.  Google desktop is 

available from 

http://desktop.google.com   

Need to wait for search engine 

to fully index your hard drive 

before desktop search with 

Google Desktop will work) 

 

SAY:   TO: 
Search computer for [keyword] Search engine 

displays all 
indexed items 
with the chosen 
keyword 

 
Search Mail for [keyword] Search engine 

displays all 
indexed email 
with the keyword 

 
Search Documents for [keyword] Search engine 

displays all 
indexed 
documents with 
the keyword 

 
Search web history for [keyword] Search engine 

displays search 
results 
containing all 
pages from your 
web history with 
the keyword 
  

 
 
Web Search Commands (in each case the “text” 

can be any word or phrase) 
 
Starting your browser 
 
SAY: TO: 

 
Start Internet Explorer Open Internet Explorer 
Start Mozilla Firefox  Open Mozilla Firefox 
Start Google Chrome Open Google Chrome 
 
Navigating in your browser 
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SAY: TO: 
 
Go to Address bar Move insertion point to address 

bar 
Click Go Go to the Web address in the 

Address bar 
Refresh page Refresh current page 
Reload page Refresh the current page 
 
Click <button>  Click a button on an HTML 

window 
Click <link text> Click link with corresponding 

name 
Stop loading Stop loading a web page 
Go back Load the previous page in the 

web history list 
Go Forward Load the next page in the web 

history list 
Go Home Load your home page 
Click favorites Activate the Favorites and RSS 

icon in IE9 and IE10 
Page Down Move the page down by a 

screen 
Page Up Move the page up by a screen 
Scroll down Move down to the bottom of the 

page 
Scroll up Move up the top of the page 
Line down Move the page down by a few 

lines 
Line up Move the page up by a few lines 
Next frame Go the next frame in a 

multiframe page 
Previous frame Go the previous frame in a 

multiframe page 
Go to Top Display the top of the current 

page 
Go to Bottom Display the bottom of the current 

page 
Start scrolling 
     Down Start automatic downward 

scrolling 
Start scrolling up Start automatic upward scrolling 
Stop Scrolling Stop automatic scrolling 
Scroll faster Increase rate of automatic 

scrolling 

Scroll slower Decrease rate of automatic 
scrolling 

 
 
SAY “Search” (site below) for “text” TO: 

 
web    Open 

default web browser and display 
search for specific text 

 
eBay    Opens 

eBay and searches for specified 
text   

Amazon.com    Opens 
Amazon.com and … 

About.com     
Answers.com   
Creative Commons   
Wikipedia 

 
Altavista    Opens 

specified search engine and 
initiates search for text term 

AOL Search  
Ask.com  
Google  
Microsoft live search 

 

Searching Medical Websites 
 
Search ICD9 drugs for <drug name> 
Search ICD9 procedures for <procedure name> 
Search ICD9 dictionary for <words> 
Search ICD9 coding for <codes> 
 
Search PubMed drugs for <drug name> 
Search PubMed for <any term> 
 
Search UptoDate for <any term> 
 
Search WebMD for <any term> 
Search WebMD drugs for <drug name> 
Search WebMD condition for <condition name> 
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Chapter 31:  Medical Commands for Downloading 
 

Over the years we have put together a number of medically 

oriented Dragon commands which we are happy to share.  In 

fact, Nuance liked our commands so much that they 

borrowed many of them and included them as built in 

commands in Dragon Medical 10 and onward.  Most of these 

commands were created for the author’s cardiology practice, 

so they may not be appropriate for your practice and needs, 

but if nothing else we hope they will generate ideas.  You are 

entirely free to share these commands among your colleagues. 

Available Command Sets for Downloading: 

While the links shown below are clickable on the electronic version of this publication, for those reading 

this on paper, you can find direct links to all of the command resources shown below from the following 

URL:  http://www.speechrecsolutions.com/commands.htm  

Utility Commands:  this group of commands assists in a variety of tasks and is oriented to improving 

general efficiency.   

Note Template Commands:  Nuance liked our command set so much that they included it in medical 

version from version 10 onward.  This is the unadulterated set, ready for your use or modification.  And 

you don’t have to say “Dragon” before initiating each of these. 

Physical Examination Commands:  This set of medical commands is oriented solely to documentation of 

the physical exam.  It includes some basic boilerplate male and female exams, and also a series of exam 

“snippets”.  We consider the use of exam snippets the perfect way to quickly and accurately document 

an exam. 

Differential Diagnosis Commands:  although oriented toward many of the diagnoses which come up in 

the author’s practice, but may be practical for you.  These are all text commands and are launched by 

saying “differential <disease condition>” 

Epic Commands:  this set of commands has been made available for use by customers of Epic System’s 

EMR.  Some are dated, some are geared for an Epic implementation at the author’s home institution, 

but most are highly helpful and, if nothing, else will give you lots of ideas for creating your own 

commands.  Many of these are step-by-step commands which can be easily edited to suit your needs. 

 

 

 

Key Point:  Gain access to our set of starter commands by visiting 

http://www.speechrecsolutions.com/commands.htm 
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Instructions for Downloading and Importing Commands 

XML versus .DAT Files:  Clicking or right-clicking on any of the links on our command downloading page 

(link above) will offer you the option of saving either the .DAT or .XML version of the command set.  The 

advantage of the XML version of each command is the ability to visualize the commands in a web 

browser or other application which can read or edit XML files. Unfortunately, the XML version of the 

command set cannot be imported directly into Dragon, so you should download or view the XML version 

only if you want to see the commands before importing into your user profile. 

XML Versus DAT format of Commands: 

 .XML .DAT 

Viewable in Text 
Editor 

Yes No 

Able to Import in 
Dragon 

No Yes 

 

 

Importing commands:  .DAT files must be uploaded or imported 

to Dragon one file at a time and are done so from the 

“Command Browser”, the place where all commands are stored. 

1.  Open the Command Browser (Tools > Command 

Browser) 

2. From the MyCommands menu, select Import 

3. Browse to the location of your saved command 

4. Select the command set and click Open 

5. On the following screen, determine the individuals 

commands to be imported (by checking or unchecking the associated box) and then click 

“Import” 

6. Repeat the above steps as needed for each command set 
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Note:  unfortunately you can only import one file at a time.  After navigating to the location of your 

command files, select the file you want to import and then click “Open”.  Once you have completed the 

import, sequentially import other command files as desired. 

 

 

 

 

 

 

 

 

Note:  By default, all of the individual commands in the set you are to import will be selected.  If there 

are any you don’t want to import, un-check the box to the left of these commands. 

 

Sharing Our Medical Commands 

We make these commands freely available for your use and to share with friends and colleagues as you 

please.  The only thing we ask is that you don’t publish them or sell them.  Feel free, though, to share 

links to the download locations and descriptions.  
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Chapter 32:  Dragon EMR Compatibility – Detailed List 

 
With most medical practices having transitioned to electronic documentation, many medical providers 

wonder about the compatibility of their electronic health record with speech recognition software. This 

table, taken directly from the Nuance website, is current as of April 29, 2014.  If you have questions 

about compatibility with a specific EMR, we suggest you contact the EMR vendor. 

Dragon Medical works with most windows-based EHRs such as Epic®, Cerner®, GE®, McKesson® and many more 
listed below which self-report compatibility to EHRscope.com. Note that EHRscope.com is not a Nuance-sponsored 
site, and therefore Nuance has not validated claims made by vendors regarding compatibility with Dragon Medical. 

 A.I.med EMR By Acrendo Software, Inc.  

 ABELMed EHR - EMR / PM By ABEL Medical Software 
Inc.  

 Abraxas EMR By Abraxas Medical Solutions  

 Accel™ By CliniWorks™, Inc.  

 AdvantaChart™ By AdvantaChart, Inc.  

 Agastha Medical Records (EMR) By Agastha, Inc.  

 AllMeds EMR System By AllMeds, Inc.  

 Amazing Charts By AmazingCharts.com, Inc.  

 ARIA™ Oncology Information System By Varian 
Medical Systems, Inc.  

 BETTERHEALTH record™ By BETTERHEALTH Global 
(USA), Inc.  

 Centricity® By GE Healthcare  

 ChartCare EMR By CHARTCARE, Inc.  

 ChartEvolve By The CIMS Group  

 ChartLogic EMR By ChartLogic, Inc.  

 ChartMaker® By STI Computer Services, Inc.  

 ChartWare® By Chartware, Inc.  

 Clinical Navigator By Systemedx, Inc.  

 CureMD PRS® By CureMD PRS®  

 CYRAMED™ By Mountain Medical Technologies, Inc.  

 DC Talk™ By JR Consulting  

 digiChart® By digiChart, Inc.  

 Doc-U-Chart for the Tablet PC® By Doc-U-Chart  

 DoctorAssistant By HealthHighway™.com, Inc.  

 Doctors Choice EMR™ & Nurses Choice EMR™ By 
EMRSystems  

 DocuMed® By DocuMed, Inc.  

 Dragon® Medical By Dragon® Medical  

 e-MDs Solution Series By e-MDs, Inc.  

 e-Medsys™ Electronic Health Record By PracticeOne, 
LLC  

 E-Record EMR By Exscribe, Inc.  

 eClinicalWorks By eClinicalWorks  

 EDIM By EDIMS, LLC  

 Electronic Patient Charts By American Medical 
Software  

 eMedRec By Holt Systems, Inc.  

 EmpowER System™ By ECDS (Emergency Care 
Documentation Systems)®  

 Medamation™ MD By Medamation, Inc.  

 MedAppz iSuite By MedAppz, LLC  

 Medflow EMR By Medflow, Inc.  

 Medi-EMR By Medi-EMR, LLC  

 Medical and Practice Management (MPM) By LSS Data Systems®  

 MedicalNotes.com By MedicalNotes.com  

 Medical Practice Solutions By Medical Voice Products  

 MedicsDocAssistant™ By Advanced Data Systems Corporation  

 Medios EHR By IOS Health Systems  

 Medscribbler™ By Scriptnetics, Inc.  

 MedTemps™ By Trigram Technology  

 MicroMD® EMR By Henry Schein® Medical Systems, Inc.  

 MindLinc from Duke University Behavioral Health Informatics By 
MindLinc: Duke University Behavioral Health Informatics  

 mMD.net EHR By Health Communication Systems, Inc.  

 NetPractice EHR By Noteworthy Medical Systems, Inc.  

 Nightingale On-Demand By Nightingale Informatix Corporation  

 OfficeEMR™ 2008 By iSALUS Healthcare™  

 OmniMD™ EMR By Integrated Systems Management, Inc.  

 OncoEMR By Altos Solutions  

 ORIGIN By Medaxis Corporation  

 Patient Chart Manager By Prime Clinical Systems, Inc.  

 PBOmd By PBO Corporation  

 PeakPractice™ By Eclipsys®  

 PerfectMed™ EHR By Imogen Systems  

 Phoenix Ortho By Phoenix Ortho, LLC  

 Physician Practice Documentation (PPD) By Healthland, Inc.  

 Power Chart By Exan Mercedes Software, Inc.  

 PowerSoftMD By Data Tec, Inc.  

 Practical Medical Record™ By Electronic Pediatrician, LLC  

 Practice 2009 By NexTech Systems, Inc.  

 PracticeOrders By PracticeSuite.com/Incite Systems, LLC  

 Practice Partner® By Practice Partner/McKesson Corporation  

 PracticeStudio.NET® By MicroFour, Inc.  

 Practice Today By Legacy Press  

 PRAXIS EMR V4.0 By Infor*Med, Inc.  

 PrimeSuite® 2008 By Greenway® Medical Technologies  

 PrognoCIS™ By BizMatics®, Inc.  

 ProgNote/MobileLink By ACS  
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 EMR4DOCTORS By EMR4DOCTORS  

 emr4MD By Mednet System  

 EMRWorks™ By MedStar Systems, LLC  

 EndoSoft® By Utech Products, Inc.  

 EpicCare Ambulatory EMR By Epic Systems Corp.  

 Epitomax® By PsyTech Solutions, Inc.  

 Evolution EMR™ By Portico Systems, Inc.  

 EyeDoc® EMR By Penn Medical Informatics Systems, 
Inc.  

 EZChart™ By AssistMed, Inc.  

 FreeMED By FreeMED Software Foundation  

 gCare™ By gMed, Inc.  

 GlaceEMR™ By Glenwood Systems, LLC  

 gloEMR By gloStream, Inc.  

 Harmony e/Notes EMR By HARMONY MedTec, Intl.  

 HealthPort EMR V9.0 By HealthPort™  

 Health Probe Professional By Health Probe  

 Horizon Ambulatory Care™ By McKesson  

 iAchieve EHR By ChartLogic, Inc.  

 iDocLocker By Sagittarius Software, Inc.  

 InSync By Intivia, Inc.  

 InteliDOX® By Businet  

 Intelligent Medical Software / IMS By SuiteMed, LLC  

 IO Practiceware By IO Practiceware  

 Janus Health By Janus Health, Inc.  

 Life Record™ EMR By Life Record, Inc.  

 MD-Journal By HemiData, Inc.  

 MD-Navigator Clinical® By Benchmark Systems™  

 MD Advantage™ By Compulink Business Systems, Inc.  

 MDAware® 2.2 By eMedicalFiles®, Inc.  

 MDLAND Electronic Health Record and Practice 
Management Systems 8.0 By MDLAND  

 MDSyncEMR By MDSyncEMR, LLC  

 MED3000 InteGreat EHR By MED3000, Inc.  

 Pronto By Clinical Insight Systems, Inc.  

 PsychNotesEMR By American Psychiatric Management Services, LLC  

 Pulse Patient Relationship Management (Pulse PRM) By Pulse Systems, 
Inc.  

 Quick Notes EMR By Quick Notes, Inc.  

 Raintree By Raintree Systems, Inc.  

 Rosch EMR-Allergy By Rosch Visionary Systems, Inc.  

 SamNotes2000 By ICS Software Ltd.  

 ScriptSure By Daw Systems, Inc.  

 SmartEMR By VipaHealth Solutions  

 SOAPware® By SOAPware, Inc.  

 STIX EMR By Integritas, Inc.  

 Team Chart Concept By Ulrich Medical Concepts, Inc.  

 TexTalk Medical By Alma Information Systems  

 The AMCIS Network By M.D. Web Solutions  

 The Chart! By DescriptMED, LLC  

 TheraManager™ By TheraManager™ Software, Inc.  

 Touch ED® By Touch Medix®, LLC  

 TransMed By TransMed Network  

 Turbo-Doc EMR By Turbo-Doc, Inc.  

 Unifi-Med™ By Unifi Technologies, Inc.  

 UroChart™ EMR By Intuitive Medical Software, LLC  

 Valant EMR By Valant Medical Solutions™, LLC  

 VersaSuite 7.5 By Universal Software Solutions, Inc.  

 Visionary™ DREAM EHR 7.1 By Visionary Medical Systems, Inc.  

 Waiting Room Solutions Practice Management System By Waiting Room 
Solutions  

 WebChartEHR By Experior Healthcare Systems  

 Webchart EMR and MIE™ Minimally Invasive™ EMR By MIE - Medical 
Informatics Engineering  

 Wellsoft EDIS By Wellsoft Corporation  

 workflowEHR™ By Workflow.com, LLC  

 WriteMD® By Medinformix®, LLC  

 WritePad™ EMR Systems By Addison Health Systems, Inc.  

 XLEMR By XLEMR 
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Chapter 33:  Compatible Applications 
 

Although Nuance has made great strides in making Dragon compatible with a wide breadth of word 

processing programs, at the end of the day it is important to realize that not every EMR and not every 

word processing program will work well with Dragon.  The following list of compatibility between 

Dragon NaturallySpeaking 12 and various applications comes directly from the Nuance website: 

Current List of Dragon Compatible Applications 

 Internet Explorer 7.x, 8.x, 9.x and 10.x: Full Text Control, Menu Tracking, Natural Language 

Commands, and ability to say links. 

 Windows Explorer: On Windows XP, Windows Vista, Windows 7 and Windows 8. 

 Microsoft Word (Office 2003, 2007, 2010 and 2013) [32-bit and 64-bit]: Full Text Control, Menu 

Tracking and Natural Language Commands. 

 DragonPad: Full Text Control, Menu Tracking and Natural Language Commands. 

 Microsoft Excel (Office 2003, 2007, 2010 and 2013) [32-bit and 64-bit]: Full Text Control, Menu 

Tracking, Natural Language Commands. 

 Microsoft Outlook (Office 2003, 2007, 2010 and 2013) [32-bit and 64-bit]: Full Text Control, Menu 

Tracking, Natural Language Commands. 

 Microsoft PowerPoint (Office 2003, 2007, 2010 and 2013): Menu Tracking and Natural English 

Language Commands. 

 Mozilla Firefox 18.x: Menu Tracking, Natural Language Commands, plus ability to say links. 

 Mozilla Thunderbird 17: Menu Tracking and Natural Language Commands (Professional and Legal 

only). 

 Compatibility is only available for an English installation of Thunderbird. 

 OpenOffice Writer 3.4 (Apache): Full Text Control, Menu Tracking and Natural Language 

Commands. 

 Windows Live Mail 2012: Menu Tracking and Natural Language Commands. 

 Lotus Notes 8.5.3: Menu Tracking and Natural Language Commands (Professional and Legal only). 

 Compatibility is only available for an English installation of Lotus Notes. 

 Windows NotePad & WordPad: Full Text Control, Menu Tracking and Natural Language 

Commands. 

 Corel WordPerfect X6: Full Text Control, Menu Tracking and English Natural Language Commands. 

 Compatibility is only available for an English or French installation of Corel 

WordPerfect. 
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Additional details on application support: 

 Full Text Control allows you to use voice to perform direct dictation, selection, correction and cursor 

movement within text. 

 Menu Tracking provides the ability to use voice to "click" an application's menus, buttons, dialogs 

boxes, etc. 

 Natural Language Commands let you state your intent within a specific application instead of following 

the menu-selection and mouse steps of the Windows interface. 

 

For an updated list of Dragon compatible software, please visit:  
http://nuance.custhelp.com/app/answers/detail/a_id/6919/~/information-on-applications-that-are-
compatible-with-dragon-naturallyspeaking-12  

 
Working with Non-Compatible Applications 

Please view our expanded section on working with Dragon in Non-standard Applications in PART One of 
this guide.  Two key reminders: 

1. Remember that you have a visual indication of 
compatibility by seeing the green arrow in the DragonBar 
(image to right).  

2. If your application happens to be one of the few with 
which Dragon is not compatible, you have the option of 
dictating into the “Dictation Box” and moving completed 
dictation into your preferred application either manually 
(copy and paste) or through any of a  number of 
automated methods allowed by the Dictation Box. 
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Chapter 34:  Dragon Medical 360 Direct 

Overview 

Dragon Direct is the newest speech 
recognition product coming from the Nuance 
Healthcare division and combines the 
simplicity of the cloud-based version of Dragon many of us are accustomed to using on our mobile 
devices, with the vocabulary and functionality needed by a medical provider. 

The basic concept of this technology is shown below.  A very small application on your computer or an 
institutional server takes in your voice and sends it securely to a Nuance cloud server that does the 
speech processing and sends the text back to your local device. 

 

Two Versions 

This product comes in two “flavors”, depending upon the needs of the user or institution: 

 Server installed or “Stand-alone” installation:  in this 
scenario the installation occurs centrally and is accessed by 
users indirectly through Citrix or another virtual 
methodology.  This arrangement is used if an electronic 
medical record is presented virtually to a user and in this 
scenario the application is placed directly on the Citrix 
server.  This is the best installation type for EMR’s 
implement via Citrix, since it allows full text control with 
the EMR and a note in progress, it also comes with some 
additional headaches in terms of installation and 
integration with microphones is a bit more difficult. 
 

 Local or “Click-once” installation:  this is for installations 
in which the application is installed directly on the user’s 
computer and the application is launched and used 
locally.  This works well only if the target text editing 
windows is on the local computer.  Although the 
appearance and functionality of this version are 

Click Once Installation 

Stand Alone Installation  
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essentially identical to the server based version of Dragon Direct, it is clearly simpler to use. 

General Features 

We have been extremely impressed with Dragon Direct and the almost hard to believe speed and 

accuracy without a minute of training.  Here’s a brief overview of its features: 

1. High level of accuracy and speed while using cloud-based speech recognition (honestly 
we find this even more accurate than the full version of Dragon Medical Practice Edition. 

2. Several medical vocabularies and one general (non-medical) vocabulary 
3. Minimal (almost negligible) deployment needs and costs 
4. Subscription based pricing 
5. Editing control functionality in most EMRs, including Epic, Cerner, Allscripts, Meditech; 

instant launching of Dictation Box when text editing not possible 
6. Set up as either “Click Once” or “Stand-alone” (see above) 
7. Other functionalities include use of step-by-step commands, vocabulary management, 

use of “AutoText” (text commands created on the fly), and Text Control Commands 
(ability to select, navigate, and correct by voice) 

System Requirements 

1. Operating system:  32-bit: Microsoft Windows XP, Microsoft Windows 7, Microsoft Windows 8 
and Microsoft Windows 8.1. Make sure that the latest service pack is always applied; 64-bit: 
Microsoft Windows 7, Microsoft Windows 8 and Microsoft Windows 8.1. Make sure that the 
latest service pack is always applied. 

2. Processor Speed:  Minimum: 1.7 GHz; Recommended: 2.8 GHz 
3. RAM:  Minimum: 512 MB; Recommended: 2 GB 
4. Compatible Text Editors:  n TX Text Control 12 to 16, .NET; Microsoft Word 2003, 2007, 2010; 

Microsoft Rich Text controls (including .NET Forms); Ter32 and Ter13 – Ter17; DM360 Direct 
Dictation Box 

5. Microphones:  Any microphone that can record audio data in 16 kHz, 16 bit mono format is 
supported. 

For more information on Dragon Medical 360 Direct, please visit our more in-depth user guide to this 
product.  Our full guide is located at:   
 
http://www.speechrecsolutions.com/assets/user_guides/DragonDirect_SRS_UserGuide.pdf   
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Chapter 35:  BestMatch V Technology 
 

Over the years, and under the ownership of various corporate entities and in the context of ever more 

powerful computers, Dragon has been gradually improving in both speed and accuracy.  The latest 

iteration of the underlying recognition technology is termed “BestMatch V” and we think it helpful for 

you to know just a little bit about how it works.   

As Nuance describes it:  “The BestMatch V speech model is known as a "triple-pass" model because this 

model performs two (2) simultaneous recognition passes, and if the recognition accuracy from the dual 

pass does not meet certain criteria, an additional third (single) recognition pass is made.  This "triple-

pass" action occurs each time a dictator speaks an utterance.  The BestMatch V speech model operates 

from RAM memory.” 

System Requirements 

BestMatch V has several computer-related requirements, including: 

 A processor with at least 2 cores 

 64 bit system 

 At least 4 GB of RAM (under certain circumstances it will work with less than 4 GB) 

Be aware that the BestMatch V technology is the most demanding in term of your system and when 

creating a new profile Dragon makes an assessment as to which speech model will be used based on 

your processor speed and available RAM.   

Confirming Speech Model 

Unfortunately a user can confirm or alter the speech model only at the time a new user profile is being 

created.  Early in the profile set-up process you will see a screen which asks you to “Confirm your 

choices”.  If you select the “Advanced” button, you will be presented with 

a screen in 

which you can 

see the setting 

Dragon has chosen (with your input) and 

have the option of changing these as shown 

in the image to the right.  In general we 

recommend that you accept the choices 

chose to simply-year-old man n by Nuance. 
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Chapter 36:  Sources of Additional Information 
 

For the individual who truly wants or needs to learn more about Dragon, we offer the following links to 

additional information.  Be sure to take a look at the Nuance “End User Workbook” pertaining to your 

version of Dragon.  If you have a specific question or problem, it’s best to submit a question to one of 

the on-line forums.  I hate to admit it, but I do it occasionally! 

Online forums 

 Speech Recognition Solutions On-line Forum: http://forums.speechrecsolutions.com/  

 KnowBrainer Forum:  http://www.knowbrainer.com/forums/forum/index.cfm  

 Nuance NaturallySpeaking for Windows Forum:  http://nuance-

community.custhelp.com/hives/be1ac29547/summary  

Sources of NaturallySpeaking Commands 

 Knowbrainer.com: It's not free, but it's the largest source of commands on-line and well worth 
the money 

 Scripting for NaturallySpeaking 11 - http://store.speechrecsolutions.com/scripting-for-
naturallyspeaking-11-p122.aspx - This excellent book on building commands by Larry Allen is a 
superb source of information on building commands, and by example includes a huge number of 
commands.  

 Kim's Speech Recognition Macros - 
http://www.scriven.com/RSI/RSIdata/KimsMacros/Kims_Macros.html  

 NaturallySpeaking QuickMacros  http://www.speak-it.com/quickmacros.htm 
 Creating Voice Commands - http://www.speechrecsolutions.com/assets/VoiceCmd.pdf  - This is 

an old document from Dragon Systems, the original developer of Dragon NaturallySpeaking. It 
has lots of useful information related to building legacy "DVC" commands. 

 USAFP Text Commands - http://www.nuance.com/for-healthcare/military-health-systems/mhs-
tips-and-tricks/mhs-commands/index.htm this is a set of text commands from the Uniformed 
Services Academy of Family Physicians and provided by Nuance. 

Disabilities Oriented Web-sites 

Assistive Technologies:  

 Ability Hub: Assistive Technology Solutions - http://www.abilityhub.com/index.htm - A limited 
source of microphones, but a great source of information.  

 Assistive Technology Solutions http://www.atsolutions.org/ - Interesting site which provides 
plans for do-it-yourself devices to assist persons with disabilities  

 Computer and Software Accessibility for the disabled - http://www.mapcon.com/computer-and-
software-accessibility-for-the-disabled - this is a wonderful overview of sources of information 
on both software and hardware options for those with disabilities, kindly organized by Lisa 
Richards.  



 

127 
Copyright 2015 Speech Recognition Solutions, LLC.  

www.SpeechRecSolutions.com 

 Quadomated - http://www.quadomated.com/ - An amazing site put together by a self-
professed "happy geeky quadriplegic engineer" with lots to share. 

General Accessibility Information 

 Web Accessibility Standards: Guidelines for Making the Internet More Accessible: 
(http://www.high-speed-internet-access-guide.com/articles/web-accessibility.html)This does 
not pertain to use of speech recognition software per se, but is a good source of information 
related to web accessibility  

RSI Prevention and Treatment 

 RSI Exercises - http://www.will-harris.com/yoga/rsi.html) A useful site with lots of information 
on preventing RSI  

 Mayo Clinic Prevention Tips -  http://www.mayoclinic.org/diseases-conditions/carpal-tunnel-
syndrome/basics/definition/con-20030332 

Microphone Information Resources 

 Wikipedia Review on Microphones 
http://en.wikipedia.org/wiki/Microphone#Electret_capacitor_microphones 

 Review article on Powering Electret Microphones  
http://www.epanorama.net/circuits/microphone_powering.html 

 Review of Computer Soundcard Wiring - http://www.epanorama.net/links/pc_sound.html 
 UCSC Review of Microphones - http://artsites.ucsc.edu/EMS/Music/equipment/equipment.html 
 Wikipedia review on Bluetooth - http://en.wikipedia.org/wiki/Bluetooth 

Nuance Resources 

Dragon Workbooks:  For a number of years Nuance has been putting together "End-User Workbooks". 
Designed for specific version of Dragon, each provides in depth information and tutorials on completing 
common functions with Dragon. Below are links to the workbooks for the last few versions of Dragon. 
These are large PDF documents which can be downloaded to your computer. 

Version Direct Link 

Dragon NaturallySpeaking 10 
End-User Workbook 

http://www.speechrecsolutions.com/assets/workbooks/DNS10_work
book.pdf 

Dragon NaturallySpeaking 11 
End-User Workbook 

http://www.speechrecsolutions.com/assets/workbooks/DNS11_End-
User_Workbook.doc 

Dragon NaturallySpeaking 12 
End-User Workbook 

http://www.speechrecsolutions.com/assets/workbooks/DNS12_work
book.pdf 

Dragon NaturallySpeaking 13 
End-User Workbook 

http://www.speechrecsolutions.com/assets/workbooks/dragon13_wo
rkbook.pdf 
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Dragon User Guides:  Although installed on your computer at the time you install Dragon, the User 
Guide for you version is buried fairly deeply on your hard drive. Nuance provides access to a variety of 
formal user guides at the following URL: 

http://support.nuance.com/usersguides/?UsersGuidesProduct=naturallyspeaking  
 
Administrator Guides 

The Dragon “Administrator Guide” is a useful guide intended for administrators that deploy and manage 
installations of Dragon NaturallySpeaking.  These are often great sources of information.  Since there 
does not appear to be a single source for these from Nuance, we have collected a bunch of these on our 
own site and list links to these guides below. 

 User Guide Administrator Guide 

Dragon 13 http://www.speechrecsolutions.
com/assets/user_guides/dns13_
userguide.pdf 

http://dragoncontent.nuance.com/supp
ort/13/DNS13_AdminGuide.pdf 

Dragon 12 http://www.speechrecsolutions.
com/assets/user_guides/DNS12
_userguide.pdf 

http://www.speechrecsolutions.com/as
sets/admin_guides/DNS12_adminguide.
pdf 

Dragon 11.5 http://www.speechrecsolutions.
com/assets/user_guides/DNS11.
5_userguide.pdf 

http://www.speechrecsolutions.com/as
sets/admin_guides/DNS11.5_adminguid
e.pdf 

Dragon 11 http://www.speechrecsolutions.
com/assets/user_guides/DNS11
_userguide.pdf 

http://www.speechrecsolutions.com/as
sets/admin_guides/DNS11_adminguide.
pdf 

Dragon 10.1 Not available http://www.speechrecsolutions.com/as
sets/admin_guides/DNS%2010.1_admin
guide.pdf 

Dragon 10 http://www.speechrecsolutions.
com/assets/user_guides/DNS10
_userguide.pdf 

http://www.speechrecsolutions.com/as
sets/admin_guides/DNS10_adminguide.
pdf 

DMPE Not available http://www.speechrecsolutions.com/as
sets/admin_guides/DMPE_adminguide.
pdf 

DMPE2 Not available http://www.speechrecsolutions.com/as
sets/admin_guides/DMPE2_adminguide
.pdf 

Medical Network 
Edition 

http://www.speechrecsolutions.
com/assets/user_guides/DMPE_
userguide.pdf 

http://www.speechrecsolutions.com/as
sets/admin_guides/DNE10.1_adminguid
e.pdf 

Dragon Medical 360: 
Direct 

(Quick Start Guide)  
http://www.nuance.com/ucmpr
od/groups/healthcare/@web-
enus/documents/collateral/nc_
034153.pdf 

http://dragonmedical360direct.nuance.
com/StandAlone/Production/Installatio
nGuide_EN.pdf 



 

129 
Copyright 2015 Speech Recognition Solutions, LLC.  

www.SpeechRecSolutions.com 

Acknowledgements 

 
Even though it’s just a simple user guide, creation of this publication was, nonetheless, time-consuming 

and required the assistance - both directly and indirectly - of many special folks in my life.   

Foremost, I need to thank my amazing wife, Karen, who has been kindly putting up with my passion for 

speech recognition technology for many years now.  Even though it has consumed far more of my 

evenings and weekends than she would have preferred, she has been incredibly patient.  I hope she can 

appreciate that without my use of speech recognition software at work I would probably be coming 

home an hour or two later every day.  To her I promise that someday I will retire not only from my “day 

job”, but also from Speech Recognition Solutions.  Then we will travel! 

My son-in-law, Tony Fiset, has been a constant source of enthusiasm and advice related to the business 

over most of the life of Speech Recognition Solutions.  In recent years he has shown an amazing ability 

to understand and provide support in technical aspects of the software, and has been hugely helpful in 

setting up and maintaining our ecommerce platform.  He provided very helpful input in the “hardware 

recommendations” section of this guide.  It was Tony, a year or two ago upon seeing a dramatically 

shorter and less thorough version of this guide directed to Dragon Medical 10, that encouraged me to 

turn this into the current guide.  He has been a valued business partner and friend.  Thank you, Tony! 

Finally, my “day job” secretary, Amanda Sanchez was hugely helpful in editing and proofing of this 

publication … on her own time.  She has the patience of a saint.  

Thanks to all of you! 

About the author 

 
Jon Wahrenberger is a board-certified internist and cardiologist practicing 

full-time clinical cardiology at Dartmouth-Hitchcock in Lebanon NH.  He is a 

long time user of Dragon in medical documentation.  In addition to his 

clinical responsibilities, Dr. Wahrenberger has been a long-time champion of 

speech recognition technology at Dartmouth-Hitchcock.  His interest in 

speech recognition software led to his creation of Speech Recognition 

Solutions in 2007.   

Dr. Wahrenberger can be contacted at jon@speechrecsolutions.com.  

 

 

 



 

130 
Copyright 2015 Speech Recognition Solutions, LLC.  

www.SpeechRecSolutions.com 

 

Index 

A 

About the author, 129 

Accessibility Information, 127 

accuracy, 5 

Accuracy, 7, 35 

Acknowledgements, 129 

Adding a New “Source”, 70 

Administrator Guides, 128 

Advanced Punctuation, 26 

Advanced Scripting Commands, 41, 45 

Andrea Pure Audio USB Adapter (MA version, 14 

Andrea Pure Audio USB Adapter (SA Version):, 14 

Assistive Technologies, 126 

Auto Transcribe Folder Agent, 97 

Automatic Playback on Correction, 19, 29 

B 

Basic Dictation, 20 

Basic Punctuation, 25 

Basic Use, 20 

BestMatch V, 8, 10 

BestMatch V Technology, 125 

Buddy 7G USB Adapter, 14 

Built in Commands, 25 

C 

Citrix, 10, 46, 50, 86, 92, 109, 123 

Clearing variable field delimiters, 39 

Command Sets for Downloading, 116 

Commands, 40 

Accept Defaults, 39 

Differential Diagnosis Commands, 116 

Downloading and Importing Commands, 117 

Epic Commands, 116 

Exporting Commands, 107 

Importing commands:, 117 

Kim's Speech Recognition Macros, 126 

Moving Commands, 107 

NaturallySpeaking QuickMacros, 126 

Note Template Commands, 116 

Physical Examination Commands, 116 

Scripting for NaturallySpeaking 11, 126 

Utility Commands, 116 

XML versus .DAT Files, 117 

Compatible Applications, 121 

Controlling Your Computer with Dragon, 52 

correction, 27 

Correction Window, 27 

Creating an Entirely New User Profile, 71 

Customizing SpeechMike Keys and Settings, 78 

D 

Dealing with lack of full compatibility, 50 

Device Control Center, 76 

Dictation Box, 50, 51 

Anchored Mode, 51, 110 

Basic Use, 109 

Caveats on Use, 111 

Hidden Mode, 110 

overview, 109 

transfer text command, 51 

Unanchored, 51 

Dictation style, 8, 35 

speaking in phrases, 8 

Dictation Style 

Enunciating, 8 

Digital Recorder with Dragon, 95 

Disabilities Oriented Web-sites, 126 

Drag and Drop Transcription, 97 

Dragon 

How it works, 7 

Dragon Compatibility, 50 

Dragon Direct, 6 

Dragon EMR Compatibility, 119 

Dragon Medical 360 │Direct, 10 

Dragon Medical 360 │Network Edition, 10 

Dragon Medical 360 Direct, 123 

Dragon Medical Practice Edition 2, 9 

Dragon Medical Practice Edition 3, 6 

Dragon Templates, 38 

Dragon User Guides, 128 

Dragon with your EMR, 47 

Dragon Workbooks, 127 

DragonPad, 50 



 

131 
Copyright 2015 Speech Recognition Solutions, LLC.  

www.SpeechRecSolutions.com 

E 

Electronic Health Record, 46 

Enable double-click to correct, 19 

F 

Fine-Tuning Your Installation, 17 

Font Size and Style, 21 

Forums 

KnowBrainer Forum, 126 

Nuance NaturallySpeaking for Windows Forum, 126 

Speech Recognition Solutions, 126 

G 

General Use of Dragon, 4 

H 

Hardware, 9, 35 

Hardware recommendations 

Aiming for the Stars, 9 

Nuance “minimum” hardware, 9 

Nuance “recommended”, 9 

Hardware Recommendations, 55 

High Noise Environment, 48 

Hot-Keys, 17 

I 

Importing and Transcribing Sound Files, 96 

Importing Commands, 108 

Installation, 16 

Installing Dragon by Direct Download, 94 

Installing Dragon from a USB Thumb Drive, 93 

Introduction, 4 

iPhone as a Portable Digital Recorder, 103 

iPhone as a Remote Microphone, 100 

iPhone with NaturallySpeaking, 100 

K 

Keystrokes, 43 

Knowbrainer, 126 

M 

Macro Recorder Commands, 41, 45 

Maintenance, 11 

Medical Commands, 116 

Microphone Management, 22 

Microphone Off, 43 

Microphone On, 43 

Microphone On/Off functionality, 17 

Microphone Set-up and Troubleshooting, 69 

Microphones 

Accuracy, 12 

Convenience, 12 

Efficiency, 12 

Hot-Key to Control the Microphone, 23 

Hygiene, 12 

Microphone Control Methods, 22 

Noise 

External noise rejection, 12 

Overview of Preferred Microphones, 12 

Personal factors, 12 

Why do microphones matter?, 12 

Microphones & USB Adapters, 12 

Microphones for Medical Providers, 56 

MyCommands Editor, 42 

N 

NaturallySpeaking 13, 6 

NaturallySpeaking QuickMacros, 45 

Navigation Aids, 38 

non-medical version of Dragon, 10 

Non-Standard Applications, 50 

Nuance “recommended” hardware, 9 

Nuance Resources, 127 

O 

Octopus USB Controller, 2, 11, 18, 23, 58, 59, 60, 67, 76, 

78, 88 

Octopus USB Controller (OUC):, 23 

Online forums, 126 

Open Application, 43 

Optimize Your Software, 36 

Overview of Built in Dragon Commands, 112 

P 

Philips Device Control software, 78 

Philips SpeechMike Premium, 58 

phonemes, 7 

PowerMic II, 2, 11, 13, 16, 18, 23, 24, 56, 59, 68, 86, 87, 

88, 89, 90, 91, 92 

Premium or Professional version of Dragon, 10 

Prerequisites, 9 

Press-to-talk functionality, 18 



 

132 
Copyright 2015 Speech Recognition Solutions, LLC.  

www.SpeechRecSolutions.com 

Programming a PowerMic II microphone, 18 

Proofreading, 53 

Punctuation, 25 

Purchasing 

Medical Practice Edition 1 versus 2, 10 

Where to buy Dragon, 11 

Which Product to Buy, 9 

Push to Talk, 90 

Q 

Quadomated, 127 

R 

Recommended Hardware, 9 

RSI Prevention and Treatment, 127 

S 

Scripting for NaturallySpeaking:, 45 

Selecting Text and Navigating, 20 

Send Keys, 43 

Sennheiser MB Pro 1 UC and Pro 2 UC, 65 

Sennheiser ME3, 62 

Setting up a New Microphone, 69 

SmarTypist, 54 

solid state drive, 55 

Sources of NaturallySpeaking Commands, 126 

Special Topics, 55 

speech masks, 49 

Speech Model, 125 

SpeechMike Premium, 24, 76 

SpeechMike Premium with a Mac, 85 

SpeechWare FlexyMike Dual Ear Cardioid (FMKDEC), 63 

SpeechWare FlexyMike Single Ear Cardioid, 64 

SpeechWare SpeechMatic MultiAdapter, 14 

SpeechWare TableMike, 59 

Speed, 7 

SSD, 55 

steno masks, 49 

Step-by-Step Commands, 41, 43 

Stop Listening, 43 

T 

Template Examples, 38 

Text and Graphics Commands, 41 

TravelMike, 62 

Troubleshooting a Microphone Not Working at All, 73 

Troubleshooting a Working Microphone with Loss of 

Accuracy, 72 

Type Text, 43 

U 

Undoing Dictation, 21 

USB Overdrive, 89 

USB Sound Adapters, 13 

overview, 14 

V 

vocabulary, 8 

Vocabulary 

Adding a new vocabulary, 32 

Changing your base vocabulary, 31 

Switching Vocabulary, 32 

Vocabulary and Words, 31 

Voice Control of the Microphone, 23 

VXI TalkPro VoxStar UC, 66 

W 

Wait, 43 

WordPad, 50 

Words 

Adding simple words, 33 

Adding Words, 32 

Exporting Words, 34 

Importing words in bulk, 33 

Written Form vs. Spoken Form, 33 



 

 
 

 

  



 

 
 

 

 


